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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be 
liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for 
Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 2011 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

Microsoft® is a U.S. registered trademark of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.
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Documentation Updates

This manual’s title page contains the following identifying information:

 Software version number, which indicates the software version

 Document release date, which changes each time the document is updated

 Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

h20230.www2.hp.com/selfsolve/manuals

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details.

Why version number 9.10?

HP APM for PPM is an integrated part of the HP BTO Operations version 9 portfolio. Using this version number 
aligns HP APM with other products that are releasing in the same time frame. Product releases within the HP BTO 
Operations version 9 portfolio will feature shared technology, common platforms, integrations, solutions, upgrade 
tools, and professional services offerings.
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Support

You can visit the HP Software Support Web site at:

hp.com/go/hpsoftwaresupport

HP Software Support Online provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

 Search for knowledge documents of interest

 Submit and track support cases and enhancement requests

 Download software patches

 Manage support contracts

 Look up HP support contacts

 Review information about available services

 Enter into discussions with other software customers

 Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to: 

h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to: 

h20229.www2.hp.com/passport-registration.html
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1 Getting Started with HP Application 
Portfolio Management
Introduction to HP Application Portfolio Management

HP Application Portfolio Management (HP APM) is a tool that you can use 
to assess your organization’s current application portfolio. Use HP APM as 
the first step towards application transformation as you use it to assess your 
current application portfolio and help you to determine which applications 
need to be modernized. 

Use HP APM to: 

 Document the size of your application portfolio and the applications that 
support your business processes.

 Compare and analyze application information such as health, effectiveness, 
ownership, cost of ownership, business value, and risk.

 Identify improvement opportunities and modernize your application 
portfolio by making strategic decisions about the future of each application 
in the portfolio, including whether the applications should be kept, 
changed, or retired.

HP APM is a module of HP Project and Portfolio Management Center  
(PPM Center). It adds functionality to the standard PPM Center interface.
11



There are three types of HP APM users: user, analyst, and administrator. 

 User. The most basic user of HP APM. Users perform tasks such as 
creating application entities, managing the applications they own, 
supplying information for applications when requested by the analyst, and 
responding to surveys when requested to do so by the analyst and other 
users (as a proxy). For more information about the HP APM user, see 
the HP Application Portfolio Management User’s Guide.

 Analyst. The most active user of HP APM. The analyst collects and 
analyzes data about the organization and its application portfolio. The 
analyst can import and export entity data, define portlets, and analyze 
applications using application sets, portlets, reports, graphing, and entity 
groupings. The analyst can typically perform all the duties of a user. For 
more information about the analyst’s role, see The Role of the HP APM 
Analyst.

 Administrator. The most advanced user of HP APM. The administrator 
has all the abilities of an analyst and user but is typically involved with 
supporting the analyst to achieve his goals. The administrator installs, sets 
up, and maintains HP APM, defines users, customizes fields and 
validations for entities, and can create customized entities, data sources, 
workflows, validations, report types, and security groups. For more 
information about the HP APM administrator, see the HP Application 
Portfolio Management Administrator’s Guide.

This guide is intended for HP APM analysts. It describes tasks that are 
performed by the analyst, and it provides instructions for performing the 
tasks—or it refers the reader to the PPM Center documents that provide the 
necessary information. The appendixes describe HP APM entities, and the 
PPM Dashboard pages, portlets, and reports that are typically provided for 
analysts. 

This guide describes the default interface for HP APM. Your HP APM administrator 
might have customized the fields and pages to meet your organization’s business 
needs and requirements. Customizations such as these are not documented in this 
guide.
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The Role of the HP APM Analyst

As an analyst, your goal is to collect and consolidate data about applications 
used by your organization and to turn it into information consumable by you 
and other users. You can view and edit all sections of entities that you create 
and entities for which you are the owner. You can also view information in the 
Header, Business Environment, Technical Environment, and Usage & Scale 
sections of application entities. If you are assigned additional roles or 
permissions within HP APM, you are able to perform additional tasks. 

The additional roles to which you could be assigned allow you to perform 
additional functions. Roles such as Business Owner, Technical Owner, and 
Respondent are assigned in the Contacts section of an application entity. Other 
roles are assigned in the Summary and Staffing sections of a workstream 
entity, and, when applicable, in the Summary section of other entities. Most 
roles allow HP APM users to perform additional functions such as viewing or 
editing data in sections of an entity that are not typically available to an  
HP APM analyst. 

For a list of roles that are assigned in an application entity and descriptions 
of the additional functions they provide, see Table A-2 on page 135. For 
descriptions of other roles that can be assigned to an analyst, see Appendix A, 
Entities, on page 129 and the HP Application Portfolio Management 
Administrator’s Guide.

An analyst may already be able to view or edit data in an entity if, for example, the 
analyst is the creator of the entity.
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HP APM Features and Components

HP APM features available for analysts include the following:

 HP APM-specific entities. See Chapter 2, Managing HP APM Entities, 
on page 21 and Appendix A, Entities, on page 129.

 HP APM reports. See Reports on page 100 and Appendix C, Reports, 
on page 217.

 The PPM Data Migrator for Microsoft Excel (for importing, exporting, 
and updating entity data and for exporting and updating validation values 
in HP APM). See Chapter 3, Using the PPM Data Migrator for Microsoft 
Excel, on page 29.

 Dynamic graphing (for viewing graphical relationships between 
applications and between processes). See Dynamic Graphing on page 100.

 Surveys (for collecting rating information from application users) and 
other options for requesting additional information. See Chapter 4, Surveys 
and Additional Application Data Collection, on page 85.

HP APM components available for analysts include the following:

 HP APM-specific pages that the analyst accesses from the following  
PPM Center menu bar options:

o Open > Application Portfolio. Used to access the options the analyst 
selects to create entities of all types, search for and open entities, access 
saved searches, analyze data from grouped entities and with dynamic 
graphing, view reports, and download the add-in for the PPM Data 
Migrator for Microsoft Excel.

o Create > Application. A shortcut to the page the analyst uses to create 
application entities.

o Create > Survey Request. A shortcut to the page the analyst uses to 
create survey registrations.
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o Create > Transformation Proposal. A shortcut to the page the analyst 
uses to create transformation proposal entities.

o Search > Entities. A shortcut to the page the analyst uses to search for 
and open HP APM entities of all types.

For more information, see Managing Entities on page 24; Chapter 3, Using 
the PPM Data Migrator for Microsoft Excel, on page 29; and Chapter 5, 
Application Analysis, on page 97.

 PPM Dashboard pages and portlets that contain information of value to an 
analyst. See PPM Dashboard and PPM Dashboard Pages on page 98, 
Portlets and Portlet Definitions on page 99, and Appendix B, PPM 
Dashboard Pages and Portlets, on page 187.

 The Browse Entities page—the preliminary page in the Request Browser 
from which you can group entities for data analysis. See Request Browser 
on page 122.

Guidelines for Building Your Application Portfolio

Your application portfolio consists of applications and their relationships to 
the business objectives and processes used by your organization.

Follow these guidelines to build an application portfolio:

1. Learn about the relationships in—and collect basic information about—
your organization, such as its business objectives and processes. This 
information assists you with understanding and determining the necessity 
and value of the applications in your application portfolio.

2. Ask the HP APM administrator to create the users who will serve as points 
of reference for entities you create. These users could be business owners, 
technical owners, IT contacts, budget and benefits managers, subject 
matter experts, reviewers, respondents, resources, and sponsors of an 
entity.
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3. Start building the application portfolio inventory, including related entities 
such as the location and process entities. 

4. If organization units and business objectives have not been provided for 
you, create them as necessary. You create business objectives and 
organization units in PPM Center.

5. Create workstreams to monitor the progress of your analysis.

6. Collect information about your applications, and then create application 
entities and add the entities to your application portfolio inventory.

Information you should collect about applications includes system 
information, names used, version, and contact information. It should also 
include details about the business environment, technical environment, 
budget and resources, service and support, and usage and scale. This 
information should include relationships with processes, organizations, and 
other applications. 

7. Determine the kind of data you want to analyze (business-related, 
technical, or general) and send out surveys to application owners and users 
to have them rate the applications.

8. Create application sets and use the HP-supplied portlets or create your 
own portlets to represent the data in a meaningful manner. Use dynamic 
graphing to graphically view application sets, applications, and process 
relationships and to develop application sets for analysis.

Before you can create and manage organization units and business objectives, 
the HP APM administrator must create a security group that allows you to do this 
and assign it to you. For more information, see the HP APM for PPM Release 
Notes. For instructions for creating and managing business objectives, see the  
HP Program Management User’s Guide. For instructions for creating and 
managing organization units, see the HP Resource Management User’s Guide.

You can import entity information into HP APM from a Microsoft Excel 
spreadsheet using the PPM Data Migrator for Microsoft Excel. For instructions, 
see Chapter 3, Using the PPM Data Migrator for Microsoft Excel, on page 29.
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9. Generate reports to analyze the completeness of data and, when you are 
satisfied with the amount of data you have collected, start your analysis. 
Use the portlets to analyze the most important qualities about each 
application or application set and share this data with other users.

10. Create an improvement transformation proposal based on your findings.

Guidelines for Using the PPM Center Documentation

This guide describes features and components of HP APM available to you as 
an HP APM analyst. It also provides instructions about how to perform tasks 
specific to HP APM. 

Note the following: 

 This guide documents the default user interface for HP APM. Your  
HP APM administrator might have customized the fields and pages to 
best suit your business needs and requirements. These customizations 
are not documented in this guide.

 Entities are a type of PPM Center request. They are unique to HP APM. 

 On some PPM Center and HP APM pages, you will see the HP APM 
entities divided into three categories: Entities, Activities, and Grouping. In 
this guide, the term entity applies to all types of HP APM entities, 
regardless of the categories in which they are located. For example, if the 
instructions tell you to select an entity from the Entities area of the Search 
Entities page, you might instead find the entity in the Activities or 
Grouping area.

Throughout this guide, you are referred to PPM Center documents for 
instructions or additional information because many HP APM tasks can also be 
performed from PPM Center menu bar options. Because of this, you might 
need to make minor adjustments to the instructions given in the PPM Center 
documents. 
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Be aware of the following: 

 Since an entity is a type of PPM Center request, in many cases you will 
need to use the instructions in the PPM Center documents for performing 
the necessary task for a PPM Center request. For example, to perform a 
basic entity search, you follow the instructions for performing a basic 
request search. These terms are usually interchangeable.

 When the instructions tell you to select an option from the Open menu on 
the menu bar, you might need to substitute Application Portfolio for the 
name of the submenu. For example, the instructions for running a saved 
search in the Getting Started guide tell you to select Open > Demand 

Management > Saved Searches > Manage Saved Searches. To run a 
saved search in HP APM, you must substitute Application Portfolio for 
Demand Management —this means you select Open > Application 

Portfolio > Saved Searches > Manage Saved Searches to run a saved 
search.

 When you are following the PPM Center instructions, an additional page 
might open. For example, when you create an application entity from the 
Open > Application Portfolio > Create Entities option, the Create New 
Entity page opens. This is an HP APM–specific page, so it is not 
mentioned in the PPM Center instructions. In this case, you should select 
Application from the Entities area and then continue following the 
instructions as written in the PPM Center document. If the Create New 
Request page opens, select Application from the Request Type drop-down 
list, and then continue following the instructions as written.

 You will not have access to all the menus and options described in the 
referenced PPM Center documents. Your view of PPM Center and  
HP APM is determined by the implementation of your PPM Center, your 
HP APM role, and the level of access to features and data you are given by 
the HP APM administrator. 
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Getting Help Online

You can easily access descriptions of many of the fields you see in HP APM 
portlets and Web pages. When a help icon is displayed on a portlet or Web 
page, click it to display descriptions of the fields in the area in which the icon is 
located. 

Related Documents

The following PPM Center documents referenced in this guide provide 
information related to tasks performed by an HP APM analyst:

 Creating Portlets and Modules

 Getting Started

 HP Application Portfolio Management Administrator’s Guide.

 HP Application Portfolio Management User’s Guide

 HP Demand Management User’s Guide

 HP Program Management User’s Guide

 HP Resource Management User’s Guide

 Reports Guide and Reference

For important information about this release of HP APM, see the HP APM for 
PPM Release Notes.

These documents are available from the HP Software Product Manuals Web 
site at h20230.www2.hp.com/selfsolve/manuals.
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2 Managing HP APM Entities
Entity Overview

In HP Application Portfolio Management (HP APM), entities are the means by 
which actions and processes are initiated and tracked. They are the building 
blocks of your application portfolio. Entities contain all of the information 
necessary to take a series of actions and move through a workflow. They are 
used to identify objects and designate the relationships and interactions within 
an organization. An HP APM entity is a type of HP Project and Portfolio 
Management Center (PPM Center) request. 

The following entities can be part of your application portfolio: 

 Application. A software application or program that implements a 
business process or function in your organization. An application entity 
can be made up of one or more distinct services.

 Application set. A user-defined grouping of application entities.

 Location. A distinct and unambiguous location of an application, server, or 
a grouping of locations.

 Process. A standard set of actions or operations performed by the business.

 Server. A physical or virtual machine.

 Survey registration. A query sent to users that requests data about 
applications to help with their analysis.
21



 Transformation proposal. A consolidation of information used to make a 
decision about a proposed project. 

 Workstream. A collection of resources working towards a common 
goal on a portion of the application or process portfolio.

Additionally, business objectives and organization units, created in  
PPM Center, can be part of your application portfolio. 

 Business objective. The result that the organization intends to achieve. For 
more information about business objectives, see the HP Program 
Management User’s Guide. 

 Organization unit. A business unit, department, or group within an 
organization. For more information about organization units, see the  
HP Resource Management User’s Guide.

For detailed descriptions of each of the HP APM entities, see Appendix A, 
Entities, on page 129. 
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Entity Relationships

Figure 2-1 shows the relationships that can exist between entities in an 
application portfolio. 

Figure 2-1. Entity Relationships
Managing HP APM Entities 23



Managing Entities

Because an HP APM entity is a type of PPM Center request, managing an 
entity is typically the same as managing a request. 

For instructions for viewing, processing, and managing entities, see the  
HP Demand Management User’s Guide. For additional information about 
entities, see the HP Application Portfolio Management User’s Guide. For 
guidelines for using the instructions in the PPM Center documentation for 
performing HP APM tasks, see Guidelines for Using the PPM Center 
Documentation on page 17.

Creating Entities

The first step in building your application portfolio is to create the entities that 
make up the portfolio. While it is possible to build your portfolio from just 
applications, designating relationships with organization units, processes, 
workstreams, locations, and servers provides you with the ability to conduct a 
more detailed and quantifiable analysis of an application or application set.

You can create a new entity from one of the following locations:

 The Open > Application Portfolio > Create Entities option on the menu bar

 The Create > <Application, Survey Request, or Transformation Proposal> 
option on the menu bar (a shortcut for creating three of the entity types)

 The References section on an entity detail page

 The Make a Copy button on an entity detail page

You can also create entities by importing them into HP APM with the PPM 
Data Migrator for Microsoft Excel (Data Migrator). For instructions, see 
Chapter 3, Using the PPM Data Migrator for Microsoft Excel, on page 29.

When you create an entity, the entity is automatically assigned a unique 
number and tracked from start to finish. This ensures completion and 
accountability for all steps within the entity’s workflow.
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For instructions for creating an entity, see the instructions for creating a 
request in the HP Demand Management User’s Guide. 

For descriptions of the fields in the HP APM entities, see Appendix A, 
Entities, on page 129 of this guide and the online help available from each 
section of the entity page. 

Opening Entities

You can open an entity from the result of a search, from a portlet, from an 
email notification, or from the search box. For more information, see 
Searching Entities and the HP Demand Management User’s Guide.

Searching Entities

There are several ways you can search for entities. You can perform a basic 
entity search or use the query builder to create a custom search query that uses 
comparison and logical operators. You can use the results of a search you 
perform with the Request Browser to create entity groups that you can use to 
display and track information. 

After you have performed a search, you can save it and run it again.

For instructions for searching entities and using the query builder, see the 
Getting Started guide and the HP Demand Management User’s Guide. For 
information about using a Request Browser search to create entity groups, see 
Request Browser on page 122 and the HP Demand Management User’s Guide.

You can also perform a simple search using the search box that is located in the 
upper-right corner of the PPM Center interface. Use the search box to quickly access 
an entity (by typing the entity—or request—number) or a menu item (by typing any 
part of the menu name to display a list of corresponding menu items).

You can also search for entities from the Search > Entities and Open > Application 
Portfolio > Search Entities options on the menu bar.
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Editing Entities

You can make changes to an entity if you created the entity or if you are 
assigned a role that allows you to do so. 

There are several ways you can update an entity. You can perform a basic edit, 
perform a quick edit to edit multiple entities at the same time, or perform a 
mass update to make the same edit to multiple entities at the same time. For 
instructions, see the HP Demand Management User’s Guide.

If two users edit the same entity at the same time and both click Save, HP APM 
attempts to save the changes made by both users. If a change cannot be saved, 
HP APM advises the user who made the change to make the change again, and 
then attempt to save it again. For examples that demonstrate how HP APM 
handles simultaneous users, see the HP Application Portfolio Management 
User’s Guide.

Monitoring Entities

Use the following HP APM features to monitor and locate entities that require 
attention:

 Searches. If you want to locate a specific entity or group of entities (based 
on filters you define), you can search for the entity. For information about 
searches, see Searching Entities on page 25 and the HP Demand 
Management User’s Guide.

 Reports. HP APM provides a predefined set of reports that allow you to 
view the current status of your data. For information about reports, see 
Reports on page 100, Appendix C, Reports, on page 217, and the Getting 
Started guide.

 Portlets. Portlets provide you with real-time views into your  
HP APM–based activities. They provide information such as a list of 
workstreams assigned to you or the health of applications by business 
owner. You can customize portlets to track and assess the data that is 
meaningful to you. For information about portlets, see Portlets and Portlet 
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Definitions on page 99, Appendix B, PPM Dashboard Pages and Portlets, 
on page 187, and the Creating Portlets and Modules guide.

 Notifications. Some workflow steps are configured to send email 
notifications upon activation. As an entity proceeds through its workflow 
steps, email notifications might be sent to notify you of pending actions. 
The notification might include a link that you can click to open the 
referenced entity. For more information, see the HP Demand Management 
User’s Guide.
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3 Using the PPM Data Migrator for Microsoft 
Excel
Data Migrator Overview

If you have large amounts of entity data to enter in HP Application Portfolio 
Management (HP APM), you can enter it using the PPM Data Migrator for 
Microsoft Excel (Data Migrator). The Data Migrator is an add-in for Microsoft 
Excel that HP provides with HP APM. HP also provides a spreadsheet 
template for the Data Migrator that you can download. 

You can use the Data Migrator to create new entities in HP APM, update entity 
data and validations in HP APM, and download entity data and validations 
from HP APM to a Microsoft Excel spreadsheet as described in the following 
topics:

 Before You Start

 Installing the Data Migrator

 Configuring the Connection to a PPM Server

 Creating an Import Spreadsheet

 Connecting to the PPM Server using the Data Migrator Wizard (for Entity-
Related Tasks)

 Creating, Updating, and Downloading Entity Data

 Cancelling a Download, Create, or Update Process

 Creating New Entities with the Migrate Option 

 Viewing the Detail Log and Fixing Logged Errors
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 Downloading and Updating Validation Values

 Connecting to the PPM Center Server using the Data Migrator Wizard 
(for Validation-Related Tasks)

 Viewing, Exporting, and Importing Mapping Relationships

 Reinstalling the Data Migrator 

Before You Start

Before you can use the Data Migrator, you must meet the following 
prerequisites:

 You must install the Data Migrator add-in and other components required 
for its use. See the HP APM for PPM Release Notes for the latest software 
requirements. For installation instructions, see Installing the Data 
Migrator on page 31.

 If you will be creating or updating entities or updating validations, you 
must prepare the spreadsheets that contain the data you want to import. 
You can add data to an entity-specific or validation-specific spreadsheet 
template that you download from the Data Migrator or use an existing 
spreadsheet. See Creating an Import Spreadsheet on page 34.

 If you will be creating new entities, all of the data the entities use must 
have already been created in HP Project and Portfolio Management Center 
(PPM Center). For example, all users listed as being budget managers in 
application entities must be created before the application entities can be 
created. 
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Installing the Data Migrator

You install the Data Migrator from PPM Center. If the required software for 
the Data Migrator is not already installed on the computer you are using, the 
software is installed automatically when you start the Data Migrator 
installation. For a list of the software requirements, see the client-side 
requirements in the HP APM for PPM Release Notes.

To install the Data Migrator:

1. Connect to PPM Center as an analyst or administrator. 

2. From the menu bar, select Open > Application Portfolio > Download Data 

Migrator Add-In. 

The installation begins.

3. Follow the prompts in the dialog boxes that open to complete the 
installation. 

4. If you are asked to reboot your computer, click Yes to restart it now.

The installation continues automatically after you restart your computer. 

Depending on the software that is installed, you might be asked to restart your 
computer during the installation process. 

If the Microsoft Office Customization Installer dialog box displays the message 
Publisher cannot be verified during the installation of the Data Migrator 
add-in, ignore the message and click Install. 
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Configuring the Connection to a PPM Server

Follow the instructions in this section to configure the connections to the  
PPM Servers on which you will use the Data Migrator to create new entities 
and to update and download entity and validation data. 

To configure the connection to a PPM Server:

1. Start Microsoft Excel.

2. On the Add-Ins tab, select Entities > Request or Entities > Validation Value 

from the PPM Data Migrator group. 

The Data Migrator wizard opens.

3. From the Select Server drop-down list, select [New Connection].

4. Click Connect to create a new connection.

The Logon to PPM Server dialog box opens. 

5. Complete the fields in the Logon to PPM Server dialog box.

Field Description

Server URL
Type the full URL you use to access the  
PPM Server. The URL must start with http:// or 
https://.

User Name Type your PPM Center logon name. 
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6. Click Logon.

You are connected to the PPM Server.

 If you chose to save the connection, the name you assigned to  
the PPM Server is displayed in the Select Server drop-down 
list.

 If you did not choose to save the connection, the name of the  
PPM Server is not displayed in the Select Server drop-down list. 
You will need to configure the PPM Server the next time you want to 
access it.

Password Type your PPM Center password. 

Save the Connection

Select this checkbox to save this information so 
you do not need to enter it again. 

If you do not save the connection, you will need 
to configure the PPM Server every time you want 
to access it.

Name
Type a name that describes the PPM Server 
you are configuring. This is the name that is 
displayed in the Select Server drop-down list.

Field Description

Up to ten of the most recent connections to the PPM Server are saved and 
appear in the Select Server drop-down list. After ten connections, the oldest 
connection is deleted when a new connection is made.



7. Do one of the following: 

 If you are creating entities or updating entity data and you have not 
prepared the spreadsheet, go to Creating an Import Spreadsheet.

 If you are creating entities or updating entity data and you have 
prepared the spreadsheet containing the entity data, go to Connecting 
to the PPM Server using the Data Migrator Wizard (for Entity-Related 
Tasks) on page 41. 

 If you are downloading entity data from HP APM, go to Connecting 
to the PPM Server using the Data Migrator Wizard (for Entity-Related 
Tasks) on page 41.

 If you are downloading or updating validation values, go to 
Downloading and Updating Validation Values on page 68.

Creating an Import Spreadsheet

You can use the Data Migrator to prepare a specially configured Microsoft 
Excel spreadsheet that you can use to create new entities or update entity data. 
Before importing new entities or updated entity data into HP APM with the 
Data Migrator, you must have prepared the special spreadsheet that contains 
the data you want to import. 

The easiest way to prepare the import spreadsheet is to paste or type the entity 
data into a Microsoft Excel spreadsheet template that you download using the 
Data Migrator. For instructions, see Creating an Import Spreadsheet from a 
Template.

Alternatively, you can use an existing Microsoft Excel spreadsheet or you can 
create a new spreadsheet. For instructions, see Creating Your Own 
Spreadsheet on page 40.
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Creating an Import Spreadsheet from a Template

When you download a spreadsheet template from the Data Migrator, the 
template includes all the necessary columns and rows for the type of entity you 
are creating. After you download the template, you manually type the entity 
data into the template or copy and paste the data into the template from another 
file. You then customize the template and import the data into HP APM with 
the Data Migrator. 

Figure 3-1 shows the first four columns and the five default rows included in 
the spreadsheet template for a workstream entity. 

Figure 3-1. Default rows and first four columns of 
the workstream entity template

Table 3-1 describes the default rows included in an entity template. You can 
provide or update entity values for fields in which rows 4 and 5 are colored 
blue. Values found in the columns in which rows 4 and 5 are colored gray are 
read-only. You can only provide values in the first column (where rows 4 and 5 
are colored red) when you are adding an entity or entities. This column is read-
only when you download and update entities.

Table 3-1. Description of default template rows (page 1 of 2)

Row Description

1
Type of entity. For example, Application, Location, and 
Workstream.

2
Sections of the entity in which the entity fields are located. For 
example, Summary, Identity, and Contacts.

3
Column headings (the entity field names). For example, Name, 
Version, and Business Owner.

4 Data types. For example, Text, Currency, and Numeric.
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5

Tokens used by the Data Migrator to map the columns in the 
template to the entity fields. For example, 
REQ.DESCRIPTION, REQ.REQUEST_ID, and 
REQ.STATUS_NAME.

6+

Empty rows into which you type or paste entity data. Typically, 
a row represents a single entity. Entities with one or more table 
components might span than one row. For example, the List of 
Applications & Respondents table in the Survey Registration 
entity is a table component, as shown in the following image.

The spreadsheet entry for this entity spans two rows, one row 
for each row in the List of Applications & Respondents table, 
as shown in the following images. The first image shows the 
segment of the spreadsheet with the first three columns for 
the entity. The second image shows the segment of the 
spreadsheet that includes the entries for each of the two rows 
in the List of Applications & Respondents table component. 

For more information about the List of Applications & 
Respondents table, see Survey Registration on page 168.

Table 3-1. Description of default template rows (page 2 of 2)

Row Description
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Creating the Spreadsheet Template

To create a spreadsheet template with the Data Migrator:

1. Start Microsoft Excel.

2. Open a blank spreadsheet.

3. On the Add-Ins tab, select Entities > Request from the PPM Data Migrator 
group.

4. From the Select Server drop-down list, select the name of the PPM Server 
to which you want to connect. If the drop-down list is empty, see 
Configuring the Connection to a PPM Server on page 32.

5. Click Connect.

The Select Entity Type drop-down list becomes available. 

6. From the Select Entity Type drop-down list, select the type of entity for 
which you want to create a template and click Next.

The Select an Action to Perform dialog box opens.

7. Click the Download Records icon.

The Download Options dialog box opens. 

8. In the Download Options dialog box, select or clear the checkboxes as 
necessary so only the fields you want to include in the template are 
selected. To select all of the fields, click Check All. To clear the checkboxes 
for all of the fields, click Uncheck All.
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9. If necessary, click Advanced Options to configure additional settings.

10. Click Next to create the template.

One of the following occurs: 

 If there are no existing entities of the type for which you are creating 
the template, a message tells you there are no requests to download. A 
template containing only the default rows described in Table 3-1 is 
created.

 If there are existing entities of the type for which you are creating the 
template, several status messages are displayed. The final message says 
Downloading Requests... Done! and shows the number of 
downloaded entities. A template containing the default rows described 
in Table 3-1 on page 35 is created. The template also contains one or 
more additional rows for each existing entity. 

11. Click Finish to close the Data Migrator wizard

12. If the template is populated with data for existing entities and you want to 
use this spreadsheet as a template, remove data from all the rows except 
rows 1–5.

13. Save the template.

14. Go to Preparing the Spreadsheet Template for Importing.

Typically, you do not need to configure the Advanced Options settings when you 
create a spreadsheet template. For instructions for configuring the Advanced 
Options settings, see step 12 on page 61.

If you click Cancel, only some of the data might be downloaded. For more 
information, see Cancelling a Download, Create, or Update Process on page 64.
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Preparing the Spreadsheet Template for Importing

After you create the template, you use it to prepare the spreadsheet that 
contains the entity data you want to import into HP APM with the Data 
Migrator. 

To prepare a downloaded spreadsheet for importing:

1. Start Microsoft Excel.

2. Open a spreadsheet template. (See Creating the Spreadsheet Template 
on page 37.)

3. If necessary, customize the entity field names in row 3. 

Do not make any changes to row 5. This row is used by the Data Migrator 
to map the spreadsheet columns to the fields in the entity.

4. Remove any columns you do not need.

Although the column containing the REQ.REQUEST_ID token is optional, 
consider leaving it in your spreadsheet. This column is populated by the 
Data Migrator with a unique request number for each entity it creates when 
you import new entities. Request numbers are required if you update the 
entity data later using the Data Migrator.

5. Copy and paste the entity data into the spreadsheet from another file or 
manually type it into the spreadsheet. 

The column containing the REQ.REQUEST_ID token must be left blank. 

Your spreadsheet must include a column that contains a unique identifier for each 
entity you are importing. You can enter the identifier in the Identifier column 
(column A) in the template or, when you configure the Data Migrator to import the 
data from the spreadsheet, you can designate a column with a different title as the 
column that contains the unique ID or name. For example, if all of your entities 
have unique names, you can designate the column that contains the entity names 
as the identifier column.
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6. Save the spreadsheet.

7. To create entities using this spreadsheet, go to Creating New Entities 
on page 44.

Creating Your Own Spreadsheet

You can create your own spreadsheet in Microsoft Excel or use an existing 
spreadsheet that you have modified to meet the Data Migrator requirements. 
Create the spreadsheet following these guidelines. The spreadsheet must 
contain: 

 Information about a single entity type. For example, if you want to import 
application, location, and workstream entities, you must create three 
spreadsheets, one for each entity type. 

 A row of column headings. Although this can be any row, it should be a 
row that contains a brief description or name for the type of information the 
column contains. You will map the column headings to entity fields later.

 Your spreadsheet must include a column that contains a unique identifier 
for each entity you are importing. When you configure the Data Migrator 
to import the data from the spreadsheet, you designate a column as the 
column that contains the unique ID or name for each entity. For example, if 
all of your entities have unique names, you can designate the column that 
contains the entity names as the identifier column.

 (Optional) When the Data Migrator creates an entity, it assigns the entity a 
unique PPM Center request number. If you include a column that contains 
only a column heading, the Data Migrator enters the request number in this 
column when the entity is created—this column must be blank except for 
the column heading. Make note of the name you give this column. You will 
map it later to the field identified in Table 3-2 on page 47. 

 (Optional) A row that contains tokens that correspond to each of the 
column headings. (Tokens are unique identifiers assigned by PPM Center 
to each of the fields in an HP APM entity.) If you include a row of  

Although the request number column is optional, consider including it in your 
spreadsheet. The request numbers that the Data Migrator adds to this column are 
required if you update the entities later using the Data Migrator. 
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PPM Center tokens in your spreadsheet, the Data Migrator automatically 
maps the spreadsheet columns that have tokens to the fields in the HP APM 
entity during the mapping process. If you create your spreadsheet using a 
template that you download from the Data Migrator, the token row is 
populated for you. (For instructions, see Creating an Import Spreadsheet 
from a Template on page 35.) 

Connecting to the PPM Server using the Data Migrator Wizard 
(for Entity-Related Tasks)

You select the options you use to create new entities, update existing entities, 
and download entity data from the Select an Action to Perform dialog box. 
This dialog box opens after you connect to the PPM Server using the Data 
Migrator wizard. 

To open the Data Migrator wizard, connect to the PPM Server, and access the 
Select an Action to Perform dialog box for entity-related tasks:

1. In Microsoft Excel, do one of the following: 

 If you are creating or updating entity data, open the spreadsheet 
containing the entity data. (For instructions for creating the 
spreadsheet, see Creating an Import Spreadsheet on page 34.) 

 If you are downloading data, open a blank spreadsheet or the 
spreadsheet you have prepared for the download. (For instructions, 
see Downloading Entity Data to a Spreadsheet on page 58.)

If the spreadsheet you are using to create entities contains entities that 
already have request numbers assigned to them, the entities with request 
numbers are skipped. (See Table 3-2 on page 47.) If the spreadsheet 
contains identifiers that match identifiers used for existing entities in the  
PPM Server, the entities are skipped.
Using the PPM Data Migrator for Microsoft Excel 41



2. On the Add-Ins tab, select Entities > Request from the PPM Data Migrator 
group. 

The Data Migrator wizard opens.

3. From the Select Server drop-down list, select the name of the PPM Server 
on which you want to create, update, or download entity data, and click 
Connect. If the list is empty, see Configuring the Connection to a PPM 
Server on page 32.

When you are connected to the PPM Server, the message Get request 
type list... Done is displayed at the bottom of the dialog box, and the 
Select Entity Type drop-down list becomes available. 

4. From the Select Entity Type drop-down list, select the type of entity you 
want to create, update, or download, and click Next.

The Select Server drop-down list contains the names of the last ten PPM Servers 
that you accessed and for which you saved the connection information. 

In this list, HP APM entity names start with APM.
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The Select an Action to Perform dialog box opens.

5. For instructions for performing the tasks you can perform from the options 
in this dialog box, see one of the following sections: 

 Creating New Entities (the Create Records option)

 Updating Entity Data on page 52 (the Update Existing Records option) 

 Downloading Entity Data to a Spreadsheet on page 58 (the Download 
Records option)

 Creating New Entities with the Migrate Option on page 65 (the Migrate 
Records option)

Users with additional access privileges also see the Migrate Records option. 
For information about using the Migrate Records option, see Creating New 
Entities with the Migrate Option on page 65.
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Creating, Updating, and Downloading Entity Data

You can create, update, and download entity data using the Data Migrator. 
This section contains the steps you need to follow to perform these tasks. 

Creating New Entities

To create new entities:

1. Access the Select an Action to Perform dialog box. For instructions, see 
Connecting to the PPM Server using the Data Migrator Wizard (for Entity-
Related Tasks) on page 41.

2. Click the Create Records icon to create entities of the type you selected 
when you connected to the PPM Server. 

The Map Attributes to Columns dialog box opens.

When you are creating entities, import the different entity types in the order of their 
dependencies. That is, if entity type A has a dependency on entity type B, import 
entity type B first. For example, server entities might have dependencies on location 
entities. Therefore, import location entities before importing server entities.

The recommended order for importing the different entity types is: location, server, 
process, application, application set, transformation proposal, workstream, and survey 
registration. 

You cannot use the Data Migrator to delete entity data you import into HP APM using 
the Data Migrator.

In this context, attributes are the entity fields.
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3. Do one of the following:

 If you are working with a spreadsheet that was created from a Data 
Migrator template, review the preconfigured entries in the Map 
Attributes to Columns dialog box. If you need to make changes, go to 
the next step. If the default settings are correct, go to step 10. 

 If you are working with a spreadsheet that you created, go to the next 
step. 

4. To the right of the Column Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column 
headings.

The identifier for the cell you clicked is entered in the Please select the row 

for field headers field in the Select a Row dialog box.

6. Click OK. 

The Select a Row dialog box closes, and the number of the selected row is 
displayed in the Column Header Row field in the Map Attributes to 
Columns dialog box. The headings from the row you selected—with the 
letter identifying the column they are in as the prefix—are added to the 
options available in the Unique record identifier drop-down list. The 
headings are also displayed in the Spreadsheet list. 

7. If the spreadsheet contains a row of tokens, do the following:

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon 
( ). 

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in the Please select the 

row for field tokens field in the Select a Row dialog box.
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d. Click OK. 

The Select a Row dialog box closes, and the number of the selected row 
is displayed in the (Optional) Token Row field. The Data Migrator 
automatically attempts to map the spreadsheet columns to the fields in 
the Entity Type list. Successfully mapped columns and fields are 
displayed in blue text. 

Figure 3-2 shows the Map Attributes to Columns dialog box after the 
token row is selected.

Figure 3-2. Map Attributes to Columns dialog box 
after the Token Row is selected

8. From the Unique record identifier drop-down list, select the heading of 
the column that contains a unique identifier for each entity listed in the 
spreadsheet. For example, select the column that contains a unique 
identification number or name for each entity.

9. Manually map any unmapped columns in the Spreadsheet list to the fields 
in the Entity Type list following the guidelines and instructions in this step. 
The list of fields is displayed in the same order—and in the same 
sections—as the fields appear in the entity. For descriptions of entity fields 
in the sections and order they appear, see Appendix A, Entities, 
on page 129. 
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Note the following: 

 The color of a column in the Spreadsheet list determines if it has been 
mapped. Mapped columns are displayed in blue text. Unmapped 
columns are displayed in gray text. 

 To see additional information about a field such as its data type and 
token, scroll to the right in the Entity Type list. If necessary, you can 
expand a column by dragging the column divider to the right. 

 Not all columns need to be mapped. Unmapped columns are ignored. 

 To view a mapped relationship, click a blue column heading or field to 
highlight its corresponding column or field.

 (Optional) If you created an empty column for the request number, you 
must map it to the field listed in Table 3-2 for the type of entity you are 
creating. 

A request number is the same as an entity number.

Table 3-2. Field, by entity type, to be mapped 
to the request number column (page 1 of 2)

Entity Type Field

Application Application No.

Application Set Set No.

Business Survey Survey No.

General Survey Survey No.

Location Location No.

Process Process No.

Server Server No.

Survey Registration Request No.
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To map the spreadsheet columns to entity fields:

a. Click a column in the Spreadsheet list, and then click its corresponding 
field in the Entity Type list.

b. Click Map.

The column name is added to the Column column in the Entity Type 
list and the mapped column and field are colored blue.

c. Repeat step a and step b until all the necessary columns are mapped.

10. Click Next.

The Create New Requests in PPM dialog box opens showing the mapped 
fields and their corresponding sections, tokens, and columns. The field 
containing the request number and fields designated as being read-only by 
gray column headings in the template spreadsheet and in Appendix A, 
Entities, on page 129 are not included in this list. 

11. Select or clear the checkboxes as necessary so only the fields for which 
you want to include values are selected. To clear all the selected 
checkboxes, click Uncheck All. To select the checkboxes for all the 
fields, click Check All. 

Technical Survey Survey No.

Transformation Proposal Proposal No.

Workstream Workstream No.

Table 3-2. Field, by entity type, to be mapped 
to the request number column (page 2 of 2)

Entity Type Field
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12. Click Advanced Options to configure additional settings. To cancel any 
changes you make to the Advanced Options dialog box, click Cancel. 

 On the General tab, configure the following settings:

o In the Coloring box, select the colors from the Highlight Success 

and Highlight Failed fields that the Data Migrator uses in the 
spreadsheet to show the status of the entities after the import is 
completed. 

o To change a color, click the Color button and select a new color. 

o To define custom colors, click Define Custom Colors in the 
Color dialog box. 

By default, entities that are created successfully are highlighted in 
light green and entities that were not created are highlighted in light 
red. 

o In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. 
When you configure this field, consider the performance objectives 
for your environment. Setting this field to a higher number could 
improve throughput but might also put more of a load on your  
PPM Server. The default value is 5. 

o In the Post Processing box, select the Reload all attributes from 

server checkbox to allow the Data Migrator to update fields in the 
original spreadsheet when the fields have a new value after the 
entities are created. 

Some of the field values in entities that are uploaded to the  
PPM Server could change because of rules that run on the  
PPM Server. When this occurs, the results of the rules are 
downloaded to the original spreadsheet if you selected the 
Reload all attributes from server checkbox. For example, 
an application entity that contains ratings is uploaded to the  
PPM Server. The PPM Server applies rules to the ratings and 

The Ignore attributes with empty values setting in the Pre-Processing 
box is ignored when you create entities.
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calculates a score. Because you selected the Reload all attributes 
from server checkbox, the scores are then downloaded to the 
spreadsheet. 

By default, the Reload all attributes from server checkbox is not 
selected.

 On the Data tab, define the delimiters for fields that can have more 
than one value. For example, if you have more than one person listed 
as a subject matter expert (SME) and have separated the users names 
with commas, you would select the checkbox for SMEs and enter a 
comma (,) in the Set Delimiter field. The default delimiter is a 
semicolon (;).

i. In the Set Delimiter field, type the delimiter. 

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the 
selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to 
define delimiters for additional fields. 

 On the Dependencies tab, specify one or more fields to be ignored 
during the first pass at creating entities. Do this when one or more 
fields in the entities you are creating require other entities or fields to 
be created before the fields can be populated successfully. When you 
select a field on this tab, it is ignored during the first pass. The entity is 
created but the value of this field is empty. After the first pass is 
complete, the Data Migrator automatically makes a second pass at 
populating the selected fields. 

The column mapped to the request number is always updated, regardless 
of if this checkbox is selected.
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To configure the Dependencies tab:

i. Select the Enable multi-pass to handle attribute dependencies 

between records checkbox to run two passes at importing the data. 

ii. Select the checkboxes for the fields that are to be left empty the first 
time the Data Migrator imports the spreadsheet. 

When you are finished, click OK to save your changes and close the 
Advanced Options dialog box.

13. Click Next.
.

The Data Migrator attempts to validate and create the selected entities. 
This could take several minutes. When the process is complete, a summary 
of the results of the import is displayed. 

14. Review the summary information. Towards the top of the dialog box, 
<N> of <N> is displayed (where <N> represents the number of entities). 
This indicates the number of entities—out of the total number of entities 
in the spreadsheet—that were processed (successfully or not). 

Statements such as the following could be included at the bottom of the 
dialog box. 

 <N> requests pass pre-validation. <N> entities were validated.

 <N> requests do not pass pre-validation. <N> entities 
contained errors and were not validated. You will need to fix these 
errors before attempting to create the entities again.

 <N> requests successfully created. <N> entities were created 
successfully.

If you specify dependencies on this tab and later cancel the create process 
while the entities are being created, the second pass might not complete 
successfully. For more information, see Cancelling a Download, Create, or 
Update Process on page 64. 

If you click Cancel, only some of the entities might be created. For more 
information, see Cancelling a Download, Create, or Update Process on page 64.
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 <N> requests failed to create. <N> entities were not created.

 <N> requests have been skipped. <N> entities were skipped 
because the entities with the same identifier already existed in the  
PPM Server. 

15. If the import was not successful, click View Log to view information about 
any errors that were reported. For instructions for saving the Detail Log 
and for using the information in the log file to fix the errors, see Viewing 
the Detail Log and Fixing Logged Errors on page 66. 

16. When all of the entities are created successfully, click Finish.

The Data Migrator closes.

17. Save the spreadsheet.

Updating Entity Data

If you need to update entity data, you can use the Data Migrator to import the 
updates into HP APM from a spreadsheet. 

You can prepare the spreadsheet with your updates in several ways:

 Modify the data in your original import spreadsheet.

 Prepare a new spreadsheet.

 Download a spreadsheet populated with information about the entities, 
and make changes to the entity data as necessary. (For instructions for 
downloading entity data, see Downloading Entity Data to a Spreadsheet 
on page 58.)

Regardless of which type of spreadsheet you use, the spreadsheet must have at 
the very minimum, a header row, a row for each entity you are updating, and 
two columns. One column must contain the request number assigned by the 
Data Migrator to each of the entities for which you are making a change, and 
the second column—and additional columns, if necessary—must contain the 
updated values. The spreadsheet can also contain columns with data that does 
not need to be updated. 
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To update entity data:

1. Access the Select an Action to Perform dialog box. For instructions, see 
Connecting to the PPM Server using the Data Migrator Wizard (for Entity-
Related Tasks) on page 41. 

2. Click the Update Existing Records icon to update entities of the type you 
selected when you connected to the PPM Server.

The Map Attributes to Columns dialog box opens.

3. Do one of the following:

 If you are working with a spreadsheet that was created from a Data 
Migrator template, review the preconfigured entries in this dialog box. 
If you need to make changes, go to the next step. If the default settings 
are correct, go to step 10 on page 55.

 If you are working with a spreadsheet that you created, go to step 4.

4. To the right of the Column Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column 
headings.

The identifier for the cell you clicked is entered in the Please select the row 

for field headers field in the Select a Row dialog box.

6. Click OK. 

The Select a Row dialog box closes, and the number of the selected row is 
displayed in the Column Header Row field. The headings from the row you 
selected—with the letter identifying the column they are in as the prefix—
are added to the options available in the Unique record identifier drop-
down list. The headings are also displayed in the Spreadsheet list. 
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7. If the spreadsheet contains a row of tokens, do the following: 

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon 
( ). 

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in the Please select the 

row for field tokens field in the Select a Row dialog box. 

d. Click OK. 

The Select a Row dialog box closes, and the number of the selected row 
is displayed in the (Optional) Token Row field. The Data Migrator uses 
the tokens in this row to attempt to map the fields in the Spreadsheet 
list to the fields in the Entity Type list. Successfully mapped columns 
and fields are displayed in blue text. 

8. From the Unique record identifier drop-down list, select the column that 
contains the request numbers that were assigned to the entities by the Data 
Migrator when they were created.

9. Manually map any unmapped columns in the Spreadsheet list to the fields 
in the Entity Type list. The list of fields is displayed in the same order—and 
in the same sections—as the fields appear in the entity. For descriptions of 
entity fields in the sections and order they appear, see Appendix A, 
Entities, on page 129.

Note the following: 

 You must map the column that contains the request number to the field 
listed in Table 3-2 on page 47 for the type of entity you are updating. 

 You are only required to map the columns in which the values have 
changed. 

For additional information about mapping columns to fields and 
instructions, see the notes and instructions in step 9 on page 46.
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10. Click Next.

The Update Requests in PPM dialog box opens showing the mapped fields 
and their corresponding sections, tokens, and columns. The field 
containing the request number and fields designated as being read-only by 
gray column headings in the template spreadsheet and in Appendix A, 
Entities, on page 129 are not included in this list. 

11. Select or clear the checkboxes as necessary so only the fields you want to 
update are selected. To clear the selected checkboxes, click Uncheck All. 
To select the checkboxes for all the fields, click Check All. By default, all 
fields are selected.

12. Click Advanced Options to configure additional settings. To cancel any 
changes you make to the Advanced Options dialog box, click Cancel. 

 On the General tab, configure the following settings:

o In the Coloring box, select the colors from the Highlight Success 

and Highlight Failed fields that the Data Migrator uses in the 
spreadsheet to show the status of the entities after the import is 
completed. 

o To change a color, click the Color button and select a new color. 

o To define custom colors, click Define Custom Colors in the 

Color dialog box. 

By default, entities that are updated successfully are highlighted in 
light green and entities that were not updated are highlighted in 
light red. 

o In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. 
When you configure this field, consider the performance objectives 
for your environment. Setting this field to a higher number could 
improve throughput but might also put more of a load on your  
PPM Server. The default value is 5. 

o In the Pre-Processing box, select the Ignore attributes with empty 

values checkbox to ignore fields in the spreadsheet that do not 
contain a value. For example, if a spreadsheet field is empty and the 
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corresponding field in the entity you are updating contains a value, 
the empty field in the spreadsheet is ignored and the value of the 
field in the entity remains unchanged. By default, this checkbox is 
not selected.

o In the Post Processing box, select the Reload all attributes from 

server checkbox to allow the update Data Migrator to update fields 
in the original spreadsheet when the fields have a new value after 
the entities are updated. 

Some of the field values in entities that are uploaded to the  
PPM Server could change because of rules that run on the  
PPM Server. When this occurs, the results of the rules are 
downloaded to the original spreadsheet if you selected the 
Reload all attributes from server checkbox. For example, updates 
to an application entity that contains ratings are uploaded to the 
PPM Server. The PPM Server applies rules to the ratings and 
calculates a score. Because you selected the Reload all attributes 

from server checkbox, the scores are then downloaded to the 
spreadsheet.

By default, this checkbox is not selected. 

 On the Data tab, define the delimiters for fields that have more than one 
value. The default delimiter is a semicolon (;).

i. In the Set Delimiter field, type the delimiter. 

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the 
selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to 
define delimiters for additional fields. 

The Dependencies tab is not used when updating entities.
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When you are finished, click OK to save your changes and close the dialog 
box.

13. Click Next.
.

The Data Migrator attempts to validate and update the selected entities. 
This could take several minutes. When the process is complete, the 
message Update Request... Done! and a summary of the results of the 
import are displayed. 

14. Review the summary information. Towards the top of the dialog box, 
<N> of <N> is displayed (where <N> represents the number of entities). 
This indicates the number of entities—out of the total number of entities in 
the spreadsheet—that were processed (successfully or not). 

Statements such as the following might also be displayed: 

 <N> requests pass pre-validation. <N> entities were validated.

 <N> requests do not pass pre-validation. <N> entities 
contained errors and were not validated. You will need to fix these 
errors before attempting to update the entities again.

 <N> requests successfully updated. <N> entities were updated 
successfully.

 <N> requests failed to update. <N> entities were not updated. 

15. If the update was not successful, click View Log to view information about 
any errors that were reported. For instructions for using the information in 
the log file to fix the errors, see Viewing the Detail Log and Fixing Logged 
Errors on page 66. 

16. When all of the entities are updated successfully, click Finish.

The Data Migrator closes.

17. Save the spreadsheet.

If you click Cancel, only some of the data might be updated. For more information, 
see Cancelling a Download, Create, or Update Process on page 64.
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Downloading Entity Data to a Spreadsheet

You can download entity data from HP APM to a Microsoft Excel spreadsheet. 
This data can be all data for all entities of a specific entity type or specific data 
such as data for only the types of entities, or specific entities or fields you 
want.

Note the following: 

 To download all data for all entities of a specific entity type, you can start 
with a blank spreadsheet. 

 To download data for specific fields or entities, you do one or more of the 
following:

o You can select the fields and entities for which you want to download 
data when you configure the entity type you are going to download 
(this option is described later in this section).

o You can prepare a spreadsheet that contains, at the minimum, a header 
row with the names of only the fields for which you want to download 
data. 

o You can prepare a spreadsheet from a template you created with the 
Data Migrator.

If the spreadsheet you use for the download already contains data, some or all of the 
data might be overwritten during the download process. The data that might be 
overwritten is located beneath the header or token row (whichever row is last). Any 
data in the rows or columns that are needed to hold the downloaded data is 
overwritten with new entity data. If the spreadsheet contains data in more rows or 
columns than are needed for new data, those rows or columns are not overwritten. 
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To download entity data:

1. Access the Select an Action to Perform dialog box. For instructions, see 
Connecting to the PPM Server using the Data Migrator Wizard (for Entity-
Related Tasks) on page 41. 

2. Click the Download Records icon to download entity data of the type you 
selected when you connected to the PPM Server.

One of the following occurs:

 If the spreadsheet is blank, the Download Options dialog box opens. 
Go to step 11 on page 61. 

 If the spreadsheet is not blank, the Map Attributes to Columns dialog 
box opens. Go to the next step.

3. Do one of the following:

 If you are working with a spreadsheet that was created from a Data 
Migrator template, review the preconfigured entries in this dialog box. 
If you need to make changes, go to the next step. If the default settings 
are correct, go to step 10.

 If you are working with a spreadsheet that you created, go to step 4.

4. To the right of the Column Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column 
headings.

The identifier for the cell you clicked is entered in the Please select the row 

for field headers field in the Select a Row dialog box.

6. Click OK. 

The Select a Row dialog box closes, and the number of the selected row is 
displayed in the Column Header Row field. The headings from the row you 
selected—with the letter identifying the column they are in as the prefix—
are added to the options available in the Unique record identifier drop-
down list. The headings are also displayed in the Spreadsheet list. 
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7. If the spreadsheet contains a row of tokens, do the following:

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon 
( ). 

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in the Please select the 

row for field tokens field in the Select a Row dialog box. 

d. Click OK. 

The Select a Row dialog box closes, and the number of the selected row 
is displayed in the (Optional) Token Row field. The Data Migrator 
automatically attempts to map the spreadsheet columns to the fields in 
the Entity Type list. Successfully mapped columns and fields are 
displayed in blue text. 

If you do not want to download data for all of the fields, select the 
checkboxes for each field you do not want to include and click Unmap.

8. From the Unique record identifier drop-down list, select the column that 
contains the request numbers that were assigned to the entities by the Data 
Migrator when they were created.

9. Manually map any unmapped columns to fields for which you want to 
download data. Map the columns in the Spreadsheet list to the fields in the 
Entity Type list. The list of fields is displayed in the same order—and in the 
same sections—as the fields appear in the entity. For descriptions of entity 
fields in the sections and order they appear, see Appendix A, Entities, 
on page 129. 

For additional information about mapping columns to fields and 
instructions, see the notes and instructions in step 9 on page 46.

You are only required to map the columns for the fields you want to download. 
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10. Click Next. 

The Download Options dialog box opens. 

11. In the Download Options dialog box, select or clear the checkboxes as 
necessary so only the fields for which you want to download data are 
selected. The Download Options dialog box shows the mapped fields and 
their corresponding sections, columns, headers, and data types. The field 
containing the request number and fields designated as being read-only by 
gray column headings in the template spreadsheet and in Appendix A, 
Entities, on page 129 are not included in this list. 

To clear all of the selected checkboxes, click Uncheck All. To select all the 
checkboxes, click Check All. 

12. Click Advanced Options to configure download settings. To cancel any 
changes you make to the Advanced Options dialog box, click Cancel. 

 On the General tab, configure the following settings:

o In the Highlight Success field in the Coloring box, select the color 
that the Data Migrator uses in the spreadsheet to show the entities 
that were downloaded successfully. 

o To change the color, click the Color button and select a new 
color. 

o To define custom colors, click Define Custom Colors in the 
Color dialog box. 

By default, entities that downloaded successfully are not 
highlighted. 

o In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. 
When you configure this field, consider the performance objectives 
for your environment. Setting this field to a higher number could 
improve throughput but might also put more of a load on your  
PPM Server. The default value is 5. 
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 On the Data tab, define the delimiters for fields that have more than one 
value. The default delimiter is a semicolon (;).

i. In the Set Delimiter field, type the delimiter. 

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the 
selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to 
define delimiters for additional fields. 

 On the Filters tab, configure the filters that determine the entities to be 
downloaded.

i. If you want to limit the number of entities that are downloaded, 
select the Enable filtering of records to be downloaded checkbox. 

ii. To limit the entities that are downloaded to those containing a 
specific word in their description, type the word by which the 
entities are to be filtered in the <Name> contains field. 

iii. To display a list from which you can select the entities to be 
downloaded, select the Manually pick requests to download 

checkbox. This is a filtered list if you entered a word in the <Name> 

contains field.

When you are finished configuring the advanced options, click OK to save 
your changes and close the dialog box.
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13. Click Next.

 If you selected the Manually pick requests to download checkbox on the 
Filters tab, the Select Records dialog box opens. 

i. Select or clear the checkboxes as necessary so only the entities you 
want to download are selected. To clear all the selected 
checkboxes, click Uncheck All. To select all the checkboxes, click 
Check All.

ii. Click Next. 

The Data Migrator downloads the selected entities and fields.

 If you did not select the Manually pick requests to download checkbox, 
the Data Migrator immediately downloads the selected entities and 
fields. 

The download could take several minutes. When the process is complete, 
the message <N> of <N> is displayed (where <N> represents the number of 
entities). This indicates the number of entities—out of the total number of 
entities that you selected for downloading—that were downloaded. 

14. Click Finish.

The Data Migrator closes.

15. Save the spreadsheet.

If you click Cancel, only some of the data might be downloaded. For more 
information, see Cancelling a Download, Create, or Update Process on page 64.
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Cancelling a Download, Create, or Update Process

If you click the Cancel button to stop a download, create, or update process, the 
Data Migrator continues to run as it completes any active threads before 
aborting the process. What you need to do next is determined by the process 
the Data Migrator was performing:

 Downloading entities or validations. View the spreadsheet to see which 
entities or validations (if any) were downloaded. If you want to download 
all entities or validations, repeat the download.

 Creating entities. Do one of the following:

o If you did not specify dependencies on the Dependencies tab, repeat the 
steps to create the entities again. Entities that were created successfully 
before the process was stopped are ignored when you repeat the create 
process. 

o If you specified dependencies on the Dependencies tab, do one of the 
following:

 If the status message says Create Request... Abort!, repeat the 
steps to create the entities again. 

 If the status message says Create Request (2nd Pass)... 
Abort!, view the Detail Log to learn if the second pass completed 
successfully for all entities. If it did not, follow the instructions to 
update the entities in Updating Entity Data on page 52 to complete 
the processing of the dependencies. 

 Updating entities or validation values. If the status message says Update 
Request... Abort!, click View Log to view the Detail Log file to learn 
the status of the update. If any of the entities do not show they were 
updated successfully or if the details cell is empty for any entities, repeat 
the update process. For information about the Detail Log file, see Viewing 
the Detail Log and Fixing Logged Errors on page 66.

The spreadsheet shows the request number assigned by the Data Migrator in 
the request number column for entities that were created successfully.
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Creating New Entities with the Migrate Option

Users whose configuration includes the Sys Admin: Migrate PPM Objects 
access grant see an additional option in the Select an Action to Perform 
dialog box—the option to Migrate Records. This option is typically used by 
an HP APM administrator with multiple PPM Center instances (for example, 
a development, test, and production system), who wants to migrate HP APM 
entity data from one instance to another without losing original information.

The Created By (token REQ.CREATED_BY) and Created On (token 
REQ.CREATION_DATE) fields are normally read-only and populated 
automatically by HP APM. When the Migrate option is available to you, you 
are able to provide data for these fields. This option is useful when you want 
your data to include original information about who created the entity and 
when it was created. 

To create entities that include original data in the Created By and Created On 
fields:

1. Prepare a spreadsheet that includes the values you want to appear in the 
Created By and Created On fields. For instructions for creating a 
spreadsheet, see Creating an Import Spreadsheet on page 34.

2. Access the Select an Action to Perform dialog box following the 
instructions for creating entities in Connecting to the PPM Server using the 
Data Migrator Wizard (for Entity-Related Tasks) on page 41.

3. Follow the instructions in Creating New Entities on page 44 to create new 
entities with the exception that, in step 2, click the Migrate Records icon 
instead of Create Records.

If you do not provide values for these fields, they are populated with the default 
values.
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Viewing the Detail Log and Fixing Logged Errors

If all the entities were not created, updated, or downloaded successfully, see 
the Detail Log for information about the errors that occurred and suggestions 
for correcting them. 

To view the Detail Log and fix any errors it includes:

1. On the page that shows the upload summary, click View Log. 

The Detail Log opens. The summary information from the previous page is 
copied to the top of the log. Messages are identified by the row in the 
spreadsheet to which they apply. The icons used in the log are described in 
Table 3-3. 

2. You can save the summary information and log messages to the 
spreadsheet. Before you do this, review the following notes, and then click 
Write Log Into Worksheet (last column).

Note the following before saving the error messages:

 When you click Write Log Into Worksheet (last column), the log 
messages are added to the first empty column at the end of the 
spreadsheet and highlighted in yellow.

 You must save the spreadsheet containing the log messages if you want 
to be able to refer to them again. When you close the Detail Log page, 
the information is no longer available. 

Table 3-3. Descriptions of icons used in the Detail Log

Icon Description

The action failed.

The entity or validation was created or updated 
successfully.

The record was skipped during processing. This is 
informational only.

No icon
The action was not processed. For example, the action 
was cancelled. 
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 If the Detail Log page shows that entities that had errors during an 
earlier import were now processed successfully, any error messages 
about these entities that you saved previously to the spreadsheet are 
deleted if you again click Write Log Into Worksheet (last column). 

3. To attempt to fix a listed error, click a cell in the row with the error on the 
Detail Log page, and then click Fix it.

The Log Details dialog box opens.

4. Click a cell in the spreadsheet to display information in the Log Details 
dialog box about the error or errors the row in which the cell is located 
contains. 

5. Modify the spreadsheet to fix the error, save the spreadsheet, and click 

Retry in the Log Details dialog box. If the Retry button is not available, 
click another cell within the row that you made the change to enable it.

The Data Migrator attempts to again process the entity data, and one of the 
following occurs: 

 If the error was fixed, the message in the Log Details dialog box shows 
the retry was successful. The highlighting in the spreadsheet changes 
from yellow to green, although the log message in the spreadsheet is 
still highlighted in yellow and still shows the error. 

 If the error was not fixed, the error description remains in the Log 
Details dialog box. Do one of the following:

o Try again to fix the error.

o Attempt to fix a different error.

o Go to the next step.

Selected cells in the Detail Log are highlighted in blue.

You must retry the fix to each row individually. For example, if there are errors in 
four rows, click in the first row in which you fixed an error and click Retry. Repeat 
for each of the remaining rows that had errors you fixed. 
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6. To return to the Detail Log to review the list of outstanding errors, confirm 
that all errors have been fixed, or exit the Data Migrator wizard, click 
Cancel on the Log Details page.

The Detail Log reopens.

7. Do one or more of the following:

 Review the list of outstanding errors and continue to attempt to fix 
them.

 Click Write Log Into Worksheet (last column) to update the log entries 
in the spreadsheet.

 Click Finish to exit the Data Migrator wizard. 

8. Save the spreadsheet if you want to save the changes. 

Downloading and Updating Validation Values

When a user is providing information for an entity, many of the fields the user 
must complete offer a selection of values from which the user must choose. 
These values are validation values.

You can use the Data Migrator to download and update the validation values 
used by HP APM entities. 

For more information about validations, see the Commands, Tokens, and Validations 
Guide and Reference guide.
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To download and update validation values, you do the following:

1. Open the Data Migrator wizard and connect to the PPM Server. For 
instructions, see Connecting to the PPM Center Server using the Data 
Migrator Wizard (for Validation-Related Tasks) on page 69.

2. Download all the validation values, a selection of validation values, or only 
the validation values you need to update. For instructions, see 
Downloading Validation Values on page 71.

3. If necessary, use the Data Migrator to update the downloaded validation 
values. For instructions, see Updating Validation Values on page 73.

Connecting to the PPM Center Server using the Data Migrator 
Wizard (for Validation-Related Tasks)

You select the options you use to download and update validation values from 
the Select an Action to Perform dialog box that opens after you have connected 
to the PPM Server using the Data Migrator wizard.

To open the Data Migrator wizard, connect to the PPM Server, and access the 
Select an Action to Perform dialog box for validation-related tasks:

1. In Microsoft Excel, do one of the following: 

 If you are downloading validation values, open a blank spreadsheet or 
create your own spreadsheet. To do this, you follow the instructions for 
creating a spreadsheet for downloading entities in Creating an Import 
Spreadsheet on page 34 with the following differences: 

o The spreadsheet template for validations has only one default row, 
the row of column headings.

o Instead of selecting Request from the Entities menu, you select 
Validation Value (see step 2).

o Only a subset of the Advanced Options fields are available for 
validation values.
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 If you are updating validation values, open the spreadsheet containing 
the data you are updating. (For information about this spreadsheet, see 
Updating Validation Values on page 73.)

2. On the Add-Ins tab, select Entities > Validation Value from the PPM Data 

Migrator group. 

The Data Migrator wizard opens.

3. From the Select Server drop-down list, select the name of the PPM Server 
that contains the validation data you want to download or update. If the list 
is empty, see Configuring the Connection to a PPM Server on page 32.

4. Click Connect.

5. When the PPM Server is connected, the message Connected is displayed 
at the bottom of the dialog box, and the Next button becomes available. 

The Select Server drop-down list contains the names of the last ten PPM Servers 
that you accessed and for which you saved the connection information. 
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6. Click Next.

The Select an Action to Perform dialog box opens. 

7. For instructions for performing the tasks you can perform from the options 
in this dialog box, see one of the following sections:

 Downloading Validation Values (the Download Records option)

 Updating Validation Values on page 73 (the Update Records option)

Downloading Validation Values

If you want a record of the validation values used by HP APM or if you want to 
create a spreadsheet of validation values that you can update and import with 
the Data Migrator, you need to download the validations and their values. 

If your PPM Center instance supports multiple languages, the validation values you 
download will include a pair of Meaning and Description columns for each language 
supported by your system. For example, columns for a PPM Center instance that 
supports English and Spanish will include columns titled Meaning (English), 
Description (English), Meaning (Spanish), and Description (Spanish). All other 
columns are language independent. 
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To download validation values:

1. Connect to the PPM Server from the Data Migrator wizard. For 
instructions, see Connecting to the PPM Center Server using the Data 
Migrator Wizard (for Validation-Related Tasks) on page 69.

The Select an Action to Perform dialog box opens. 

2. In the Select an Action to Perform dialog box, select Download Records.

The Download Options dialog box opens. 

3. In the Download Options dialog box, click Advanced Options to configure 
the download settings. To cancel any changes you make to the Advanced 
Options dialog box, click Cancel. 

 In the Highlight Success field in the Coloring box, select the color that 
the Data Migrator uses in the spreadsheet to highlight the validations 
that were downloaded successfully. 

o To change the color, click the Color button and select a new color. 

o To define custom colors, click Define Custom Colors in the Color 

dialog box. 

By default, validations that downloaded successfully are not 
highlighted. 

 In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. When 
you configure this field, consider the performance objectives for your 
environment. Setting this field to a higher number could improve 
throughput but might also put more of a load on your PPM Server. 
The default value is 5. 

 In the Data Filtering box, you can limit the validations that are 
displayed in the Download Options dialog box. To do so, type the word 
by which the validations are to be filtered in the Show validations when 

name contains field. For example, type APM to display only the 
validations that contain APM in their name.

When you are finished configuring the advanced options, click OK to save 
your changes and close the dialog box.
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4. In the Download Options dialog box, select or clear the checkboxes as 
necessary so only the validations you want to download are selected. The 
Download Options dialog box lists all the validations configured for your 
implementation of HP APM or a filtered list of validations, if you 
configured the Data Filtering setting in the previous step.

To sort the list, click the heading of the column you want to sort by. To 
clear all the selected checkboxes, click Uncheck All. To select all the 
checkboxes, click Check All. 

5. Click Next.

The Data Migrator downloads the selected validations and their values. 
This could take several minutes. When the process is complete, the 
message <N> of <N> is displayed (where <N> represents the number of 
validations). This indicates the number of validations—out of the total 
number of validations that you selected for download—that were 
downloaded. 

6. Click Finish.

The Data Migrator closes.

7. Save the spreadsheet.

Updating Validation Values

If you need to update validation values, you start by making your changes to a 
spreadsheet of validation values that you download using the Data Migrator, 
and then you import the updates into HP APM with the Data Migrator. You 
can use the Data Migrator to update changes to validation values that include 
the following: 

 Changing the values in a validation

 Changing the sequence of values within a validation

If you click Cancel, only some of the data might be downloaded. For more 
information, see Cancelling a Download, Create, or Update Process on page 64.
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 Adding values to a validation

 Disabling and enabling values

For instructions for adding validations to HP APM, see the Commands, 
Tokens, and Validations Guide and Reference guide.

To update validation values:

1. Download the validations containing the values you want to update. For 
instructions for downloading validation values, see Downloading 
Validation Values on page 71.

2. Make the necessary changes to the spreadsheet, save it, and leave it open.

3. Access the Select an Action to Perform dialog box. For instructions, see 
Connecting to the PPM Center Server using the Data Migrator Wizard 
(for Validation-Related Tasks) on page 69. 

4. Click the Update Records icon to update validation values.

The Map Attributes to Columns dialog box opens.

5. Review the preconfigured entries in this dialog box. If you need to make 
changes, go to the next step. If the default settings are correct, go to 
step 12. 

6. To the right of the Column Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

7. In the spreadsheet, click a cell in the row that contains the column 
headings.

The identifier for the cell you clicked is entered in the Please select the row 

for field headers field in the Select a Row dialog box. 

When making changes to validation values, do not change the values in the Validation 
ID and Validation Name fields. These values are used by the Data Migrator to identify 
the validation.
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8. Click OK. 

The Select a Row dialog box closes, and the number of the selected row is 
displayed in the Column Header Row field. The headings from the row you 
selected—with the letter identifying the column they are in as the prefix—
are added to the options available in the Validation ID list. The headings 
are also displayed in the Validation Name list and the Attribute Mapping 
Spreadsheet list. 

9. From the Validation ID list, select the column that contains the IDs that 
were assigned to the validations by PPM Center when they were created. 

10. From the Validation Name list, select the column that contains the names of 
the validations. 

11. Manually map any unmapped columns in the Attribute Mapping 

Spreadsheet list to the attributes in the User Data list. 

You are only required to map the columns in which the values have 
changed.

For additional information about mapping columns to attributes, see step 9 
on page 46. 

12. Click Next.

The Upload Options dialog box opens showing the first row number of 
each validation in the spreadsheet, the validation name, validation ID, and 
whether or not the validation is valid. 

13. Select or clear the checkboxes as necessary so only the validations that you 
want to update are selected. To clear the selected checkboxes, click 
Uncheck All. To select the checkboxes for all the fields, click Check All. 
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14. Click Advanced Options to configure additional settings. To cancel any 
changes you make to the Advanced Options dialog box, click Cancel. 

 In the Coloring box, select the colors from the Highlight Success and 
Highlight Failed fields that the Data Migrator uses in the spreadsheet to 
show the status of the entities after the update is completed. 

o To change a color, click the Color button and select a new color. 

o To define custom colors, click Define Custom Colors in the Color 
dialog box. 

By default, validations that are updated successfully are highlighted in 
light green and validations that were not updated are highlighted in 
light red. 

 In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. When 
you configure this field, consider the performance objectives for your 
environment. Setting this field to a higher number could improve 
throughput but might also put more of a load on your PPM Server. The 
default value is 5. 

When you are finished, click OK to save your changes and close the dialog 
box.

15. Click Next.

The Data Migrator attempts to validate and update the selected validations. 
This could take several minutes. When the process is complete, the 
message Update Validations... Done! and a summary of the results of 
the update are displayed. 

The settings in the Data Handling box are ignored when you update validations.

If you click Cancel, only some of the data might be updated. For more information, 
see Cancelling a Download, Create, or Update Process on page 64.
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16. Review the summary information. Towards the top of the dialog box, 
<N> of <N> is displayed (where <N> represents the number of 
validations). This indicates the number of validations—out of the total 
number of validations you selected for updating—that were processed 
(successfully or not). 

Statements such as the following might also be displayed: 

 <N> records successfully updated. <N> validations were updated 
successfully.

 <N> records failed to update. <N> validations were not updated. 

 <N> records pass pre-validation. <N> validations were 
validated.

 <N> records do not pass pre-validation. <N> validations 
contained errors and were not validated. 

17. If the update was not successful, click View Log to view information about 
any errors that were reported. For instructions for using the information in 
the log file to fix the errors, see Viewing the Detail Log and Fixing Logged 
Errors on page 66. 

18. When all of the validations are updated successfully, click Finish.

The Data Migrator closes.

19. Save the spreadsheet.
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Viewing, Exporting, and Importing Mapping Relationships

You can use the Data Migrator mapping tools to import column-to-field or 
attribute mapping relationships from one spreadsheet to another and to view 
the mapping in a spreadsheet in XML code.

Viewing Mapping Relationships

You can view the column-to-field or attribute mapping relationships 
configured for spreadsheets that you downloaded using Data Migrator and 
spreadsheets you used to create or update entity data or update validation 
values. The mapping relationships are displayed in XML format. 

To view the mapping relationships in a spreadsheet:

1. Start Microsoft Excel.

2. Open the spreadsheet for which you want to view the mapping 
relationships.

3. On the Add-Ins tab, select Tools > View Mapping from the PPM Data 

Migrator group.

A window opens showing the XML. 

Figure 3-3 shows the first page of XML for the mapping of a spreadsheet 
created for application entities. 

To save or print the XML, use the Export Mapping option to create an XML file. (See 
Exporting and Importing Mapping Relationships.) 
78 Chapter 3



Figure 3-3. Example: First page of XML 
for spreadsheet mapping

Exporting and Importing Mapping Relationships 

You can reuse column-to-field or attribute mapping relationships from 
spreadsheets that you downloaded using Data Migrator or spreadsheets that 
you used to create or update entity data or to update validation values. You do 
this by exporting the mapping relationships from a “used” spreadsheet—a 
spreadsheet in which the mapping relationships were already configured—into 
a new spreadsheet. 
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To export mapping relationships and import them into a new spreadsheet:

1. Start Microsoft Excel.

2. Export the mapping file:

a. Open the spreadsheet that contains the mappings you want to export. 

b. On the Add-Ins tab, select Tools > Export Mapping from the PPM Data 

Migrator group.

The Save current setting to file dialog box opens.

c. Configure the settings in the Save current setting to file dialog box: 

i. Browse to the folder in which you want to save the exported data 
file.

ii. In the File name field, enter a name for the file into which the data is 
to be exported. 

iii. Make note of the folder and file name. 

iv. Click Save.

3. Create the new spreadsheet:

a. In Microsoft Excel, open a new spreadsheet. 

b. From the original spreadsheet, copy the rows that contain the column 
headings (for entities and validation values) and tokens (for entities 
only)—and any other rows you want to reuse—and paste them into the 
new spreadsheet.

c. Save the new spreadsheet. 
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4. With the new spreadsheet still open, import the exported mappings:

a. On the Add-Ins tab, select Tools > Import Mapping from the PPM Data 

Migrator group.

b. Click Yes to acknowledge the message that is displayed.

c. In the Load setting from file dialog box, locate and select the file 
containing the exported data.

d. Click Open.

A message confirming that the mapping information was loaded 
successfully is displayed.

e. Click OK.

f. Save the new spreadsheet.

5. To see the imported mappings, view the mappings following the 
instructions in Viewing Mapping Relationships on page 78.
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Reinstalling the Data Migrator

If you attempt to install the Data Migrator and the installation fails or if you 
need to reinstall the Data Migrator, follow the steps in the following sections 
sequentially:

1. Uninstalling the Data Migrator

2. Reinstalling the Data Migrator

3. Clearing the Cache

Uninstalling the Data Migrator

To remove the current installation of the Data Migrator, use the remove 
programs option in the Control Panel to uninstall PPMDataMigrator.

Reinstalling the Data Migrator

After uninstalling the Data Migrator, follow the instructions in Installing the 
Data Migrator on page 31 to reinstall it. 

 If the installation is successful, return to earlier sections of this chapter to 
perform any necessary tasks. 

 If the installation fails, go to Clearing the Cache.

If you are installing a new version of the Data Migrator, follow the instructions in 
Installing the Data Migrator on page 31. You do not need to uninstall it first.
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Clearing the Cache

To clear the cache and reinstall the Data Migrator:

1. Launch the command window (cmd.exe).

2. Change the directory in the command prompt to one of the following 
directories. 

 C:\Program Files\Microsoft SDKs\Windows\v7.0A\bin

 C:\Program Files\Microsoft SDKs\Windows\v6.0A\bin

 C:\Program Files\Microsoft Visual Studio 8\SDK\v2.0\bin

If you do not have any of these directories on your computer, download 
and install the .NET Framework Software Development Kit (SDK) from 
the Microsoft Download Center at http://www.microsoft.com/download/. 

3. At the command prompt for the bin directory noted in step 2, type the 
following command to clear the cache:

mage -cc

A message telling you the cache was cleared is displayed.

4. Reinstall the Data Migrator following the instructions in Installing the 
Data Migrator on page 31. 

The SDK-related directory you have on your computer depends on your 
computer’s configuration. The version of the SDK software might vary from the 
version noted here.
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4 Surveys and Additional Application 
Data Collection
Overview of Surveys and Application Data Collection

After you have collected and entered your application information, you might 
need to conduct a survey for the application and collect ratings from its users—
or collect additional information about the application itself. 

Conducting Surveys

You can use surveys to collect ratings data about an application from one or 
more users. Rather than entering arbitrary data, you can send a survey to an 
application’s users and base the application ratings on the survey responses.

Complete the following tasks to collect and enter ratings data for an 
application:

1. Generate the survey registration and send invitations to its respondents.

2. Monitor the individual survey responses.

3. View the Survey Results report to evaluate the cumulative survey 
responses.

4. Enter the results of the survey into the application entity.
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Generating a Survey

Before you send out surveys, you create the survey registration entity and 
select the type of ratings for which you want to collect data. You then send the 
survey to the designated respondents.

To create the survey registration:

1. From the menu bar, select Open > Application Portfolio > Create Entities.

2. In the Activities section, click Survey Registration. 

The Create New APM - Survey Registration page opens.

3. In the Summary section, type a name for the survey in the Survey Name 
field.

4. In the Details section, type or select the type of survey that you want to 
send from the Survey Template list. The survey template determines the 
type of ratings data that is collected. 

 Business Survey. Business-related ratings for the application, data, 
vendor, value, and risk.

 General Survey (Full). Application-related ratings for the application, 
data, vendor, value, and risk.

 Technical Survey. Technical-related ratings for the application, data, 
vendor, and risk.

Each invitation sent from a survey registration is a survey with its own request 
number.

Make note of the name you assigned to the survey registration. You will need it 
later.

To view the specific fields for which data can be collected, select a survey 
template and click (click here) in the View Preview field. For descriptions of the 
fields in the templates, see Application on page 130 for the descriptions of the 
application entity fields.
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5. In the List of Applications & Respondents table, click Edit.

The label on the Edit button changes to View and additional buttons are 
displayed. 

6. Add the applications to be surveyed and the users you want to designate as 
respondents. Refer to the following instructions and Table 4-1 for more 
information.

Table 4-1. Table icons

a. Click the Add Row icon ( ).

A row with empty Application Name and Respondents cells is added to 
the table.

b. In the empty cell in the Application Name column, type or select the 
name of the application for which you are conducting the survey.

Button or Icon Description

Click to view the completed table.

Click to export the table to a Microsoft Excel 
spreadsheet.

Click to add a row to the table.

Click to delete the selected rows.

Click to copy the selected rows.

Click to paste the copied rows beneath the selected 
row.

Click to move the selected row up.

Click to move the selected row down.

To select a row, click a cell within the row. To select multiple rows, press and hold 
the Shift key as you click in additional cells. 

As you add each application, make note of the application’s ID number. You 
will need this information later.
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c. In the empty cell in the Respondents column, type or select the name of 
one or more survey respondents (people you want to complete the 
survey).

d. Repeat step a through step c as necessary.

7. To save the survey registration, click Submit.

The Request Creation Confirmed page opens, and the request number 
assigned to the survey registration is displayed in the Request # field.

To send the survey invitation to the respondents:

1. In the Request # field on the Request Creation Confirmed page, click the 
request number assigned to the survey that you just created. 

The APM - Survey Registration - <Request_Number> page opens.

2. In the Available Actions section, click Send Surveys.

An email is sent to each of the respondents inviting them to participate in 
the survey.

Monitoring Individual Survey Responses

After you send the invitations to the survey respondents, you can view the 
status of the survey registration and the completion percentage by respondent. 

1. Open the survey registration entity. 

In the References > Requests section, each respondent from whom a 
response was requested is listed as a separate survey by the survey request 
number. The list also includes the name of the survey respondent, the 
description of the survey registration and its request number, the type of 
survey, the status of the survey, the percentage of the survey that has been 

Make note of the request number assigned to the survey registration. You will 
need it later.

By default, every three days an email is resent to remind the survey respondents 
to complete the survey. If a Target Completion Date is set for the survey, the 
reminder is sent every three days until that date is met.
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completed, the relationship of the survey request to the survey registration, 
and details of the relationship. 

2. From the list of surveys, you can do the following:

 Click a request number to display a survey. If the respondent has saved 
answers to any of the questions, you can view the responses. While you 
can view a summary of rating responses in the Survey Results report 
(see Viewing the Survey Results Report), you can only see the 
comments when you view each survey individually. 

 Change the relationship between a survey and the survey registration to 
which it is related. 

Viewing the Survey Results Report

To monitor the overall response rate to the survey and to view a summary of 
the current responses, generate the Survey Results report:

1. From the menu bar, select Open > Application Portfolio > Reports > Survey 

Results. 

The Submit Report: APM Survey Results Report dialog opens.

2. In the Survey Request field, type or select the name of the survey 
registration entity for which you want to view current responses. For 
information about the other report parameters you can configure, see 
Table C-3 on page 224. 

3. In the Scheduling and Output Options section, select Run Report 

Immediately.

4. Click Submit.

The Survey Results report is generated and opens.

5. Analyze the results of the report to determine if the number of responses is 
satisfactory or if you need to wait for more responses.

6. For more information about the Survey Results report, see Survey Results 
Report on page 224.
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Entering Survey Response Data into the Application Entity

If you are satisfied with the response rate to the survey (based on individual 
survey completion percentages or on the results shown in the Survey Results 
report), enter comments and notes from each survey into the Notes section of 
the application entity and enter the ratings data into the Ratings section of the 
application entity.

Collecting and Entering Comments and Notes

To collect and enter comments and notes:

1. Open an application entity for which you generated the survey.

a. From the menu bar, select Open > Application Portfolio > Search 

Entities. 

The Search Entities page opens.

b. In the Entities area, click Application.

The Search: APM - Application page opens.

c. Enter the application entity’s request number and click Go, or enter 
other filter criteria and click Search.

d. On the Request Search Results page, click the number assigned to the 
application entity to open it.

2. Open the survey registration from which you sent the surveys in one of the 
following ways: 

 Open the survey registration from a portlet:

i. From the menu bar, display the following path: Dashboard > 

Shared > APM Analyst > Front Page.

ii. In the path, right click Front Page and select Open in New Window 
from the menu that is displayed.

iii. In the My Survey Requests portlet, click the name of the survey 
registration entity.
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 Open the survey registration from the Search Entities page:

i. From the menu bar, display the following path: Open > Application 

Portfolio > Search Entities.

ii. In the path, right click Search Entities and select Open in New 

Window from the menu that is displayed.

iii. In the Activities area, click Survey Registration.

iv. In the View Details for Request # field, enter the request number for 
the survey registration and click Go.

The APM - Survey Registration - <Request_Number> page opens.

3. In the References > Requests section, click the request number of a survey. 

The survey opens in a new window.

4. Open the Comments section (located towards the bottom of the Details 
section) and the Notes section.

5. Copy any comments and notes from the survey to the Notes section of the 
application.

6. Repeat step 3 through step 5 for each survey.

7. In the application entity, click Save.

Collecting and Entering Ratings Data

To collect and enter ratings data:

1. Open the Survey Results report for the application for which you want to 
collect ratings data. For instructions, see Viewing the Survey Results Report 
on page 89. 

2. From the Survey Results report, determine how you want to calculate the 
aggregated values for each rating field. For example, you could average the 
values for each field or use the median value of each field.

Instead of copying the comments and notes directly into the application entity, 
you can copy the comments and notes from one or all surveys to a file and 
attach the file as a reference to the application.
Surveys and Additional Application Data Collection 91



3. Open the application entity for which you generated the Survey Results 
report. For instructions for opening an application entity, see step 1 in 
Collecting and Entering Comments and Notes on page 90.

4. In the application entity, open the Details > Rating section.

5. Enter the calculated values from step 2.

6. Click Save.

Requesting Additional Application Information

If you need to collect additional information about an application, you can send 
a request to a different user (called a respondent) to enter the information. You 
might want to do this if, for example, the owner of the application went on 
vacation before responding to the survey invitation or the owner needed more 
time for investigation.

The following sections describe the tasks you perform to identify the 
applications that need more data and to send a request for the data:

 Identifying the Applications that Require Additional Information 

 Sending a Request for More Information
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Identifying the Applications that Require Additional Information

If you already know the applications for which you want to collect additional 
information, you can skip this task.

To identify the applications that require additional information, you create an 
application set that contains the applications you want to investigate, and then 
run two reports on those applications.

1. Identify the applications to include in the application set:

a. From the menu bar, select Open > Application Portfolio > Search 

Entities. 

b. In the Entities area, click Application. 

The Search: APM - Application page opens.

c. Enter the filter criteria. For example, in the Contacts section, type or 
select the name of a user from the Technical Owner list to find all 
applications for which the user has technical authority.

d. Click Search.

The Request Search Results page opens.

e. Make note of the names (title) and numbers of the applications that 
matched the filter criteria or export the results to a Microsoft Excel 
spreadsheet.

2. Create an application set that contains an application or group of 
applications you are investigating. You will use this application set later to 
view a report that shows how complete the data entry is for the set of 
applications. For example, you may want to view data entry for the 
applications owned by a specific technical owner.

a. From the menu bar, select Open > Application Portfolio > Create 

Entities. 

The Create New Entity page opens.
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b. In the Grouping area, click Application Set.

The Create New APM - Application Set page opens.

c. In the Set Name field, type a name for the application set.

d. Open the List of Applications section and click Edit.

The label on the Edit button changes to View and additional buttons are 
displayed. 

e. Add the applications to the application set. For more information, refer 
to the following steps and Table 4-1 on page 87 for descriptions of the 
icons.

i. Click the Add Row icon ( ).

A row with an empty cell in the Name column is added to the table.

ii. In the empty cell, type or select the name of an application you 
want to add to the application set.

f. Repeat step i and step ii as necessary.

g. Click Submit to save the application set.

3. Run the Entity Coverage Summary report for the application set you 
created in step 2. The Entity Coverage Summary report shows a summary 
of attributes and how complete the data entry is for the select applications 
or application set.

a. From the menu bar, select Open > Application Portfolio > Reports > 

Coverage Summary.

The Submit Report: APM Entity Coverage Summary Report page 
opens.

b. From the Entity Type drop-down list, select Application.

c. From the Application Set list, type or select the application set you 
created in step 2. 

d. Set report parameters as necessary. For information about the report 
parameters, see Table C-1 on page 218.
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e. In the Scheduling and Output Options section, select Run Report 

Immediately.

f. Click Submit.

The Entity Coverage Summary report is generated and opens.

4. Analyze the results in the Entity Coverage Summary report to determine if 
the set of applications it covers require additional data. For example, view 
the Coverage % column for each attribute and determine if the amount of 
data entered is satisfactory. If the Coverage % is too low, run the Entity 
Detail report to determine which applications are missing data.

5. Run the Entity Detail report on the applications in the application set (using 
the application numbers you noted in step 1). The Entity Detail report 
shows selected information about one or more applications.

a. From the menu bar, select Open > Application Portfolio > Reports > 

Entity Detail. 

The Submit Report: APM Entity Detail Report dialog opens.

b. In the Entity Request Type list, type or select Application.

c. In the Entity Numbers list, type or select the application numbers you 
noted in step 1.

d. In the Scheduling and Output Options section, select Run Report 

Immediately.

e. Click Submit.

The Entity Detail report is generated.

6. Analyze the results in the Entity Detail report to determine the applications 
that are missing data.

You might also want to select No for the Hide Prompts for Empty Fields 
option so you can visually verify in the report that an attribute contains no 
data. See Table C-1 on page 218 for more information about the other report 
parameters.
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Sending a Request for More Information

After determining the applications for which additional data is necessary, send 
a request for more information:

1. Open the application for which additional data is needed. For instructions 
for opening an application entity, see step 1 in Collecting and Entering 
Comments and Notes on page 90.

2. In the Available Actions section, click Need More Info. 

The APM - Application <Request_Number>: Need More Info page opens.

3. From the Respondent list, select or type the name of the user from whom 
you want to collect additional data about the application. 

4. In the Respondent Note field, type a message to be included in the email 
that is automatically sent to the respondent. For example, you may want to 
specify the fields in the application entity that you need filled.

5. Click Continue Workflow Action.

The application entity opens, and an email that requests more information 
about the application is sent to the respondent.

6. For each application that requires additional information, repeat step 1 
through step 5.

By assigning a user as a respondent, you are giving that user the ability to view 
and edit all sections of the application.
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5 Application Analysis
Application Analysis Overview

After data has been collected and entered for applications and other entities in 
your application portfolio, you can analyze and assess your application 
portfolio using the following tools: 

 Application Sets. Group applications for comparative analysis in portlets, 
reports, dynamic graphing, and the Request Browser. 

 PPM Dashboard and PPM Dashboard Pages. Group and display portlets 
for a real-time view of important information about your application 
portfolio.

 Portlets and Portlet Definitions. Display and define standard and 
customizable real-time views of your application portfolio data.

 Reports. Display status and statistics based on your application portfolio 
data.

 Dynamic Graphing. Displays graphical relationships between applications 
and between processes.

 Request Browser. Hierarchically group and displays information for a 
real-time view of selected entity information.
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Application Sets

When you want to compare a specific set of applications, you can first 
configure an application set containing the necessary applications. You can use 
application sets in workstream entities, the Entity Coverage report, the Request 
Browser, dynamic graphing, and in the following portlets: Application Health 
Breakdown, Application Portfolio Size, Application Value Assessment, List of 
Applications (Analyst), and TCO Summary. For more information about 
application sets, see Application Set on page 159.

PPM Dashboard and PPM Dashboard Pages

The PPM Dashboard provides the core of the standard user interface. 
It is a real-time Web page view into your application portfolio. With the  
PPM Dashboard, teams always know their current status. Managers gain  
real-time insight into progress with and problems in the applications they 
manage. Executives can view transformation proposals from an IT value 
perspective at a high level, which helps to ensure alignment with the 
organization’s overall strategic direction. The PPM Dashboard pages that 
provide you with accurate, up-to-the-minute, status information about your 
applications and deliverables are displayed on the PPM Dashboard. 

Two types of PPM Dashboard pages are available for the analyst in  
HP Application Portfolio Management (HP APM): shared and private. 

 Shared PPM Dashboard pages are preconfigured PPM Dashboard pages 
provided by HP APM or configured by the HP APM administrator. They 
cannot be edited. Shared PPM Dashboard pages contain entity-related 
portlets.

 Private PPM Dashboard pages are created and configured by you. You can 
add portlets to a private page, move the private page up or down in the list 
of pages, and delete it. You can also configure the information displayed in 
the portlets that you add to private pages.

Shared PPM Dashboard pages are also known as HP-supplied PPM Dashboard 
pages.
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Private PPM Dashboard pages provide a way to organize application data. 
You can choose to devote one PPM Dashboard page to transformation 
proposal information and designate another as reserved for application 
owners. How you organize the data is entirely up to you.

For descriptions of the PPM Dashboard and PPM Dashboard pages provided 
for an analyst, see Appendix B, PPM Dashboard Pages and Portlets, 
on page 187.

For information about creating and maintaining PPM Dashboard pages, see the 
Creating Portlets and Modules guide. For information about personalizing the 
PPM Dashboard, see the Getting Started guide.

Portlets and Portlet Definitions

Portlets reside on PPM Dashboard pages.They display real-time information 
relevant to your application portfolio. You can drill down on the data displayed 
in many of the portlets to view additional details. Two types of portlets are 
available for the analyst in HP APM: shared and configurable. 

 Shared portlets are preconfigured portlets provided by HP APM or 
configured by the HP APM administrator. You can edit them only if you 
copy them to a private PPM Dashboard page. Shared portlets contain 
entity-related information for use by the analyst.

 Configurable portlets are the portlets that you can add to a private  
PPM Dashboard page and personalize. These portlets are highly 
configurable, enabling you to filter through all the data in the system to 
display the information you need. HP provides several portlets that you 
can configure. You can create additional personalized or configured 
portlets. 

For descriptions of the shared and configurable portlets provided for an 
analyst, see the online help and Appendix B, PPM Dashboard Pages and 
Portlets, on page 187. 
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For information about personalizing portlets, see the Getting Started guide. For 
information about creating and maintaining portlet definitions, see the 
Creating Portlets and Modules guide.

Reports

HP APM provides several predefined reports that allow you to view the current 
status of your application portfolio data in a Web browser. After you select a 
report to view, you can set filters that determine the data that is to be included 
in the report. 

For a list of the HP APM reports and their descriptions, see Appendix C, 
Reports, on page 217. 

For instructions for running and managing reports, see the Reports Guide and 
Reference. 

Dynamic Graphing

Dynamic graphing provides the ability to view graphical relationships between 
applications and between processes. Dynamic graphing also allows you to 
transform a graph of processes into a graph of applications that support the 
processes and to create an application set from a group of displayed 
applications. 

Installing Dynamic Graphing

The first time you start dynamic graphing, you are prompted to install the 
Microsoft Silverlight add-on for Microsoft Internet Explorer or the Silverlight 
Plug-In for Mozilla Firefox. Follow the prompts in the dialog boxes that are 
displayed to complete the installation. 

View the HP APM reports from the Open > Application Portfolio > Reports menu.
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Starting Dynamic Graphing

The way you start dynamic graphing depends on the entity relationships you 
want to view.

Do one of the following to start dynamic graphing:

 To view the graphical relationships between the applications in an 
application set or between related processes:

a. From the menu bar, select Open > Application Portfolio > Analyze > 

Dynamic Graphing.

The dynamic graphing page opens.

b. Do one of the following:

 To view the relationships between the applications in an application 
set, see Viewing Application Relationships on page 102.

 To view the relationships between related processes, see Viewing 
Process Relationships on page 107.

 To use dynamic graphing to perform additional procedures, see the 
procedures described in other Dynamic Graphing sections. 

 To start dynamic graphing so you can view graphical relationships between 
the entities you select from the results of a search or between the entities 
you select from an entity group:

a. Do one of the following:

 Search for all application or process entities or only the specific 
application or process entities you want to view. For information 
about searching for entities, see Searching Entities on page 25. 

 Create a group of application or process entities. For information 
about using the Request Browser to create an entity group, see 
Request Browser on page 122. 
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b. From the results displayed on the Request Search Results page or in 
the Request Browse Results section on the Browse <Entity_Type> 
Requests page, select one or more entities of a specific type 
(application or process).

The Dynamic Graphing button is enabled.

c. Click Dynamic Graphing. 

The dynamic graphing page opens and the selected entities are 
displayed.

Viewing Application Relationships

Use dynamic graphing to view application relationships. You can view the 
following relationships: 

 The applications in an application set.

 The number of processes an application supports.

 The dependencies between applications.

 The dependencies an application set has between all applications, including 
applications not included in the application set.

 A combination of the number of processes supported and application 
dependencies (either for the applications in an application set or for all 
applications). 

If you select entities of more than one type, all entities are ignored unless one 
of the entity types is application—then only the application entities are 
displayed. If you select entities of a type other than application or process, 
nothing is displayed. 

To quickly zoom in and out of a displayed graph, use the scroll wheel on the mouse. 

To reposition the graph, drag the cursor on the graph and move it to the desired 
position.
102 Chapter 5



Opening an Application Set

To open an application set in dynamic graphing and view the applications it 
contains:

1. Start dynamic graphing. For instructions, see Starting Dynamic Graphing 
on page 101.

2. Click the Open icon ( ).

3. Click Open Application Set.

The application set selection menu displays the eight most recently created 
application sets. If the application set you want to open is not displayed, 
select More to view additional applications sets. 

4. Select an application set and click OK.

Applications are represented by blue rounded rectangles in the graph.

Figure 5-1. View of applications in an application set

The application set must be created before it can be opened in dynamic graphing.
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Viewing the Number of Processes an Application Supports

To view the number of processes supported by an application:

1. Open an application set or one or more applications in dynamic graphing. 
For instructions, see Starting Dynamic Graphing on page 101.

2. Click the Graph Options icon ( ).

3. Select Load Supported Processes.

The size of the rounded rectangles change proportionally, based on the number 
of processes supported. The number of processes supported is displayed in the 
lower right corner of the rounded rectangle.

Figure 5-2. View of an application set with dependent processes

Viewing Application Dependencies

You can view application dependencies between the displayed applications or 
you can view all directly related application dependencies of an application set 
(this includes dependencies to applications that are not part of the application 
set). 
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Viewing Dependencies Between Applications

To view application dependencies between applications:

1. Open an application set or more than one application in dynamic graphing. 
For instructions, see Starting Dynamic Graphing on page 101.

2. Click the Graph Options icon ( ).

3. Select Show Upstream/Downstream.

Figure 5-3. Hierarchical view of an application set with upstream/
downstream dependencies

Viewing Dependencies Between Directly Related Applications

You can view dependencies that applications have between directly related 
applications in the application portfolio. For example, if an application set 
contains application A, application A depends on application B, and 
application B depends on application C, showing the direct dependencies of 
the application set displays application A and B; application C is not directly 
related to application A.
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To view dependencies that applications have between directly related 
applications in the application portfolio:

1. Open an application set or more than one application. For instructions, see 
Starting Dynamic Graphing on page 101.

2. Click the Graph Options icon ( ).

3. Select Show Direct Dependencies.

The original applications are represented by blue rounded rectangles. 
Applications that have a direct dependency on one or more of the original 
applications—and were not part of the applications that were displayed 
originally—are represented by teal green rectangles.

In dynamic graphing, all applications displayed are considered part of an application 
set. If you open an application set and view its direct application dependencies, all 
applications displayed in the graph are considered part of the application set. If you 
then save your application set, all applications, including the direct dependent 
applications, are saved to the application set. 

For example, in Figure 5-4, applications that are both blue (original applications in the 
application set) and teal green (applications that have a direct dependency on the 
original applications in the application set) are considered part of the application set 
and, when saved, are saved as part of the application set. When this saved 
application set is re-opened, all applications are represented by blue rounded 
rectangles. 

For instructions for saving an application set in dynamic graphing, see Saving 
Displayed Applications in an Application Set on page 121.
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Figure 5-4. Hierarchical view of an application set 
with direct dependencies

Viewing Process Relationships

Use dynamic graphing to view process relationships. You can view the 
following relationships: 

 The selected process and its child processes, if any.

 The number of applications supporting the process.

 The applications that support the process.

Opening a Process

To open a process and view its child processes: 

1. Start dynamic graphing. For instructions, see Starting Dynamic Graphing 
on page 101.

2. Click the Open icon ( ).
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3. Select Open Process Tree. 

The process selection menu displays the eight most recently created  
top-level processes (processes with no parent). If the process you want 
to open is not displayed, select More to view additional processes. 

4. Select the process from the process hierarchy or type the name of the 
process in the Process field and click OK.

Processes are represented by bright green rounded rectangles in the graph.

Figure 5-5. Hierarchical view of process tree

Viewing the Number of Applications that Support a Process

To view the number of applications supporting a process:

1. Open a process.

2. Click the Graph Options icon ( ).

3. Select Load Related Applications.

The size of the rounded rectangles change proportionally, based on the number 
of applications that support the process. The number of applications supporting 
the process is displayed in the lower right corner of the rounded rectangle.

If no processes have been created, the Open Process Tree menu item is not 
selectable.
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Figure 5-6. Hierarchical view of process tree 
with application dependencies

Viewing the Applications that Support a Process

You can transform the process graph into a graph showing the applications that 
support the process and its child processes:

1. Open a process.

2. Click the Graph Options icon ( ).

3. Select Load Related Applications. (You must load related applications 
before you can transform it into an application graph).

4. Click the Graph Options icon ( ).

5. Select Transform to Application Graph.

All applications that support the processes are represented by rounded 
rectangles. Use the graph options to view the number of processes each 
application supports and to show the dependencies between applications. You 
can also save this set of applications as an application set. (For instructions, see 
Saving Displayed Applications in an Application Set on page 121.)
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Viewing Application and Process Details

You can view detailed information about an application or process shown in 
the graph. Click on the application or process and the information is displayed 
in the Details table. The information is structured by sections and fields based 
on the entity type (application or process). For example, Figure 5-7 shows the 
Identity section for an application entity and some of its fields.

Figure 5-7. Details table

If you have loaded the supported processes of the displayed applications, an 
additional table is displayed in the Details table. The second table displays a 
list of the dependent processes (processes that are supported by the 
applications in the application set).
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If you have loaded the related applications of a process, a Virtual Attributes 
section and an additional table are added to the original table displayed in the 
Details table. 

 The Virtual Attributes section contains the Supporting Applications virtual 
attribute, which contains a list of the dependent applications. You can filter 
the graph using this virtual attribute. 

 The additional table lists the dependent applications (applications that 
support the process). 

Filtering Applications and Processes

You can filter the graph to highlight only those applications or processes that 
meet a certain criteria:

1. In dynamic graphing, open an application set or one or more applications 
or processes. For instructions, see Starting Dynamic Graphing 
on page 101.

2. Transform the graph as desired. For instructions, see Viewing the 
Applications that Support a Process on page 109.

3. Click the Filter Graph icon ( ). 

The Filters table opens.

4. Select the attribute on which to filter and type the value in the Criteria 
column. You can use wildcards or operators. For descriptions and 
examples of the wildcards and operators you can use, see Table 5-1. Filter 
criteria are not case-sensitive.

5. Click Apply.

Applications or processes that do not meet the filter criteria are changed to 
gray rounded rectangles in the graph. 

For attributes (fields) that have selectable “yes” or “no” values when creating the 
entity (such as the Compliant field of a process entity, the Under Maintenance 
field of an application entity, or the Disaster Recovery Plan in Place field of an 
application entity), the filter criteria value is either “y” or “n” (not “yes” or “no”).
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You might need to move the graph or zoom out to view the entire graph.

Table 5-1. Wildcard/Operator descriptions and examples

Data 
Type

Wildcard/
Operator Description/Examples

Text

*

(Asterisk) Matches zero or more characters.

m*
Match values that starts with “m” or “M” such as “Michael” 
and “Michele”

*e
Match values that ends with “e” or “E” such as “Michele” or 
“Frederiche”

?

(Question Mark) Matches any one character.

?ich Match four-letter values that end with “ich” such as “Rich”

?ich*
Match values that have “ich” as their second, third, and 
fourth letters such as “Michelle” and “Rich” (“Frederiche” 
would NOT match)

=

(Equals Sign) Explicit match.

=m*
Match values that starts with “m” or “M” such as “Michael” 
and “Michele”

,

(Comma) Acts as the OR boolean operator.

m*, *e
Match values that starts with “m” or “M” and ends with “e” or 
“E” such as “Michael” or “Michele” or “Frederiche”

““

(Quotation Marks) Match all characters inside the quotation marks 
literally and exactly. Wildcards or operators inside of the quotation 
marks are not interpreted as wildcards or operators.

“rich”
Exactly match the value of “rich” (not case-sensitive) such 
as “Rich (“Frederiche” would NOT match)

“*ich*”
Exactly match the value of “*ich”” (not case-sensitive) such 
as “*IcH*” (“Michele” and “Rich” and “Frederiche” would 
NOT match)
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Number

>
(Greater Than) Match all values greater than the given value.

>25 Match values that are greater than 25 such as “26” or ““27”

>=

(Greater Than or Equal) Match all values that are greater than or 
equal to the given value.

>=25
Match values that are greater than or equal to 25 such as 
“25” or “26” or “27”

<
(Less Than) Match all values less than the given value.

<25 Match all values that are less than 25 such as “24” or “23”

<=

(Less Than or Equal) Match all values less than or equal to the given 
value.

<=25
Match all values that are less than or equal to 25 such as 
“25” or “24” or “23”

=
(Equals Sign) Explicit match.

=25 Match the value of 25

,
(Comma) Acts as the OR boolean operator.

24, 25 Match values of “24” or “25”

-
(Dash) Match any value in the given range of numbers.

23-25 Match values of “23” or “24” or “25”

Table 5-1. Wildcard/Operator descriptions and examples

Data 
Type

Wildcard/
Operator Description/Examples
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Figure 5-8 shows an application set that shows upstream/downstream 
relationships, direct dependencies, and dependent processes.

Figure 5-8. Hierarchical view of an application set

Figure 5-9 shows the same application set in Figure 5-8 after a filter was 
applied to highlight all applications with a Title that starts with “sharepoint.”

Figure 5-9. Hierarchical view of a filtered application set
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Changing the Dynamic Graphing Display of Applications

The graph of applications can be varied by changing the color or size of the 
nodes using the graph’s visual options. The color or size of the nodes 
represents the quantity or value of a selected application attribute. 

Color-coding displays up to four colors, with up to three colors based on 
specified percentiles: 

 Red. The application falls into the high percentile range.

 Orange. The application falls into the middle or medium percentile range.

 Light Blue. The application falls into the low percentile range.

 Gray. The application does not have a quantity or value specified for the 
selected attribute.

Color percentiles are used with color-coding to specify the range of quantities 
or values a color represents.

Table 5-2 shows an example of percentile values for application scores. The 
highest attribute value is the highest application score of all applications in the 
graph (each row represents a separate graph) and the high percentile is set 
to 80% and the low percentile is set to 20%.

Percentiles are based on the highest configured value or quantity of the selected 
attribute (in the Color Nodes By field) for the applications in the graph. For example, 
an application score can range from 0 (zero) to 5. However, if the highest application 
score of all applications in the graph is 4, the percentiles are based on the value of 4 
(not 5).

Table 5-2. Examples of Percentiles Based on Highest Attribute Value

Highest 
Attribute 
Value

 Values for Percentile Ranges of 80% and 20%

100% >= Red >= 80% 80% > Orange >= 20% 20% > Light Blue

5 5 >= Red >= 4 4 > Orange >= 1 1 > Light Blue

4 4 >= Red >= 3.2 3.2 > Orange >= .8 .8 > Light Blue

3.5 3.5 >= Red >= 2.8 2.8 > Orange >= .7 .7 > Light Blue
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Sizing displays nodes of different sizes based on the quantity or value. The 
larger the node, the larger the quantity or value.

The examples in this section show how to color-code the nodes by application 
score and size the nodes by the number of processes supported by an 
application (the larger the node, the more processes that are supported)

Figure 5-10 shows an application set with upstream and downstream 
relationships. No visual options have been set.

Figure 5-10. Hierarchical view of application set

Color-coding Nodes by Application Score Values

To color-code the nodes by application score values, 

1. Click the Graph Options icon ( ).

2. Select Visual Options.

3. From the Color Nodes By drop-down list, select Score: Application Score 

(Value).

4. Adjust the Color Percentiles by typing in the percentile ranges or using the 
slidebars. If you want to represent only high and low quantities or values, 
set percentile ranges to successive numbers (such as 51 and 50). In this 
example, the default values are used.

5. Click OK.
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Figure 5-11 shows the same application set in Figure 5-10, but the graph is 
color-coded to differentiate the applications by application score percentiles. In 
this example, the highest application score for any node is 4, therefore red 
nodes represent applications that have application scores in the 3.2–4 range, 
orange nodes represent applications that have application scores in the .8–3.2 
range, and light blue nodes represent applications that have application scores 
less than .8.

Figure 5-11. Hierarchical view of application set that is color-coded

Changing the Size of Nodes to Represent the Number of Supported Processes

To change the size of nodes to represent the number of processes supported by 
an application,

1. Click the Graph Options icon ( ).

2. Select Visual Options.

3. From the Size Nodes By drop-down list, select Business Environment: 

Supported Processes (Count).

4. Click OK.
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Figure 5-12 shows the application set in Figure 5-10, but the graph’s node size 
represents the number of processes that are supported by the application. The 
larger the node, the more processes that are supported

Figure 5-12. Hierarchical view of application 
set that is adjusted by size

Figure 5-13 shows the application set that has both the color-coding and sizing 
visual options applied where color represents the application score and node 
size represents the number of processes that are supported by the application. 

Figure 5-13. Hierarchical view of application set that is 
color-coded and adjusted by size
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Changing the Dynamic Graphing Layout of Applications and Processes

You can vary the graphs of applications and processes by changing the layout 
of the nodes. Choose from the following layouts:

 Circular. Shows interconnected rings and star topologies.

 Hierarchical. Default. Shows a top-to-bottom directed graph.
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 Organic. Shows symmetrical or balanced distribution.

 Orthogonal. Minimizes the number of overlapping and bends in 
connectors.

To change the layout of the graph, 

1. Click the Graph Options icon ( ).

2. Select Layout Options.

3. Select one of the layouts.
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Saving Displayed Applications in an Application Set

Note the following behavior in dynamic graphing when you save the displayed 
applications as an application set:

 All applications displayed are considered part of an application set. If you 
open an application set and view its direct application dependencies, all 
applications displayed in the graph are considered part of the application 
set. If you then save your application set, all applications, including the 
direct dependent applications, are saved to the application set. 

For example, in Figure 5-4 on page 107, applications that are both blue 
(original applications in the application set) and teal green (applications 
that have a direct dependency on the original applications in the application 
set) are considered part of the application set and, when saved, are saved as 
part of the application set. When this saved application set is re-opened, all 
applications are represented by blue rounded rectangles.

 Using the Save As Application Set option to save an application set as an 
existing application set does not replace the existing application set. 
Instead, an application set with the same name is created, but this newly 
created application set is not active.

For example, if you have two existing application sets (AppSet1 and 
AppSet2), open AppSet1 in dynamic graphing, select Save As Application 

Set, type in AppSet2 as the Name, and click Submit. A Progress dialog 
opens and does not close unless you click Cancel.

When you view a list of your applications sets, you have two application 
sets named AppSet2. The status of the original application set is Active. 
The status of the newly created application set is Change Pending. You 
cannot activate the newly created application set unless its name is changed 
to a unique name (the name is case-sensitive).

To save the applications displayed in dynamic graphing in an application set:

1. Click the Save icon ( ). 

2. Select Save As Application Set.

3. Type a name and optional description and click OK.
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Saving an Image of a Dynamic Graph

You can save a dynamic graph as a JPEG (.jpg) or Portable Network Graphics 
(.png) file.

To save an image of the graph:

1. Click the Save icon ( ). 

2. Select Save Image SnapShot.

3. Select the directory in which you want to save the image, type a filename, 
and select a format of the file.

4. Click Save.

Request Browser

You can use the Request Browser to display and track entity information that is 
hierarchically grouped by the specified entity fields. This information includes 
the total number of entities in each hierarchical entity group. With the Request 
Browser, you can create hierarchical entity groups of up to five levels deep, 
and you can break down the totals into a selected set of subtotals. You can also 
save the hierarchical entity group and selected entity information, allowing you 
to track the information over a period of time. 

When you create an entity group with the Request Browser, you can use 
dynamic graphing to view the graphical relationships between applications or 
between processes. (For instructions, see Dynamic Graphing on page 100.)

Figure 5-14 shows a hierarchical grouping of applications, broken down by 
Location, Disposition, Application Health, and ITO Contact. The total number 
of applications in each group is broken into subtotals by selected Status values.

Only the portion of the graph that is visible in your Web browser is saved (along with 
the legend and graph title). You may need to adjust the size of your Web browser or 
minimize the size of the graph in order to save the complete graph.
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Figure 5-14. Example of hierarchical grouping of applications and application 
totals and subtotals in the Request Browser

For instructions for using the Request Browser to search entities (requests), see 
the HP Demand Management User’s Guide. While you follow the instructions 
in the HP Demand Management User’s Guide, refer to the following example 
for the options you need to select from the HP APM menus to get to the 
Browse Entities and Request Browser pages. 

Example: Using the Request Browser to Display Grouped Entities

The following example displays the Application Health by Customer Visibility 
of an organization’s applications and, specifically, allows the organization’s 
analyst to track the applications that are red for customer-facing applications in 
Beijing, Bangalore, and Los Angeles:

1. From the menu bar, select Open > Application Portfolio > Analyze > 

Groups > Group Entities.

The Browse Entities page opens.

2. In the Entities area, click Application. 

The Request Browser: APM - Application page opens.
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3. In the Request Browser Tree Configuration section towards the bottom of 
the page, do the following: 

a. From the Additional Column list, select or type Location.

The Column Values list is added to the Request Browser Tree 
Configuration section.

b. From the Column Values list, select Beijing, Bangalore, and  
Los Angeles and click OK.

4. In the Choose Fields to Group by in Request Browser Tree section, select 
Customer Visibility and Application Health from the Available Fields list. 
Click the right arrow to move them to the Selected Fields list.

5. In the Choose Columns for Request List section (above the Request 
Browser Tree Configuration section), select the fields of the application 
that are to be tracked from the Available Columns list: Title, Status, 

Business Owner, Active Users, Total Score, and Location. Click the right 
arrow to move them to the Selected Columns list. 

The order in which you list the fields in this section determines the results that are 
displayed.
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6. Click Browse. 

The Browse APM - Application Requests page opens.

7. In the list of entities, expand the 3 - Customer facing group to show the 
totals by Application Health.

There are five applications that are customer-facing and whose health is 
red. There is one application of this type in Bangalore and no applications 
of this type in Beijing and Los Angeles.

8. Click on the number 1 that represents the number of customer-facing 
applications located in Bangalore whose health is red.

The application that belongs to this group is displayed in the Request 
Browse Results section at the bottom of the page.
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9. To save the results as a Microsoft Excel file, click Export to Excel.

Saving an Entity Group

You can save an entity group to reuse later.

To save an entity group:

1. Create an entity group. For instructions, see Request Browser on page 122.

2. On the Browse <Entity_Type> Requests page, click Modify Preference Set.

The Request Browser: <Entity_Type> page opens.

3. Type a name for this entity group in the Save this Preference Set as field at 
the bottom of the page.

4. Click Save.

The window that opens displays the results of the save operation.

You can use dynamic graphing to view the graphical relationships between the 
applications or processes listed in the Request Browse Results section. For 
instructions, see Dynamic Graphing on page 100. 
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5. Click Return to Browse Requests.

The Request Browser: <Entity_Type> page opens.

To view this group at a later time, from the menu bar, select Open > 

Application  Portfolio > Analyze > Groups > Saved Group Criteria  > 

<Name_of_Saved_Group>. 
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A Entities
Entities Overview

This appendix provides descriptions and screenshots of the entities that  
HP Application Portfolio Management (HP APM) provides for the analyst. 

HP APM provides the following entities for analysts: 

 Application

 Application Set

 Location

 Process

 Server

 Survey Registration

 Transformation Proposal

 Workstream

For additional information about entities, see Chapter 2, Managing HP APM 
Entities, on page 21.

Most entities also have Notes, Status, and References sections. For descriptions 
of these sections, see the description of the request details page in the HP Demand 
Management User’s Guide.

The HP APM administrator might choose to remove or add entities to your 
organization’s implementation of HP APM. Any entities added by your HP APM 
administrator are not documented in this guide.
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Application

An application entity is a software application or program that implements a 
business process or function in your organization. An application entity can be 
made up of one or more distinct services.

When creating, searching for, or editing an application entity, enter or update 
information in the following sections:

 Identity. The fundamental information that identifies the application.

 Contacts. The key contacts and stakeholders of the application.

 Business Environment. The critical business properties of the application.

 Technical Environment. The technologies used in the construction of the 
application, connectivity to other systems, and planned disposition.

 Budget & Resources. The forecast and actual costs, financial benefits, and 
average headcount supporting the application.

 Service & Support. The supporting environment and quality issues.

 Usage & Scale. The usage-based size measurements.

 Rating. The subjective measurements that reflect the business view of the 
application. These measurements are relative to the overall enterprise 
application portfolio.

 Score. The computed scores and adjustment factor for the total score.
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Identity

In the Identity section, enter the fundamental information that identifies the 
application. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-1. Application Identity section

The Identity section is a subsection of the Header section.

Table A-1. Application Identity fields (page 1 of 4)

Field (*Required) Description

Title
Read-only. The Title is automatically set to the application 
Name.

Application No. Read-only. A unique numeric identifier of the application.
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Status

Read-only. The status of the application.

 New - The application is being defined but has not been 
submitted.

 In Review - The application details are currently under 
review as part of an assessment or data collection 
process.

 Need More Info - Additional information has been 
requested from the named respondent for the application.

 Active - The application is active and currently being 
managed by its owners.

 Snapshot - This is a static copy of the application 
information captured on a specific date.

 Retired - The application is no longer active. It has been 
decommissioned or has reached end-of-life and 
assessment is no longer needed.

 Cancelled - The application entity has been cancelled and 
its information is no longer valid.

*Name
A name given to the application that distinguishes it from 
other applications. The name must be unique in order to 
transition the application from In Review to Active status.

Version The version information associated with the application.

Acronym
The acronym assigned to the application. Typically, this is 
defined by the organization most involved with the 
application.

Alias An additional name assigned to the application.

Local ID
A unique identifier for the application from a client-operated 
inventory system, if applicable.

Table A-1. Application Identity fields (page 2 of 4)

Field (*Required) Description
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Class

The high-level purpose of the application.

 Infrastructure - An application that is used to support a 
system, such as a database, scheduler, or security 
monitor.

 Informational - An application that is used to store, 
communicate, or manipulate data, such as data storage or 
reporting.

 Transactional - An application that requires an act or 
process to be completed, such as order entry and 
payments.

Type

The high-level origin of the application.

 ASP - Application Service Provider. An application that is 
hosted and supported by an external organization and 
accessed over a network.

 Custom - An application that has been designed 
specifically for the organization.

 COTS - Commercial, Off-the-Shelf. An application that is 
developed by an ISV and customized for the organization.

 Composite - COTS and Custom. An application that 
consists of heterogeneous systems (COTS and/or 
custom) that are integrated together.

Importance

The importance of the application to the enterprise.

 Low - The application is rarely used and does not affect 
the performance and functioning of the organization.

 Normal - The application is used averagely and may or 
may not affect the performance and functioning of the 
organization.

 High - The application is widely used and may affect the 
performance and functioning of the organization.

 Critical - The application is required for the performance 
and functioning of the organization.

Purpose
The business or technical objective or function of the 
application.

Location The physical location of the production application.

Table A-1. Application Identity fields (page 3 of 4)

Field (*Required) Description
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Contacts

In the Contacts section, enter the key contacts and stakeholders of the 
application. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-2. Application Contacts section

Created By
Read-only. The full name of the user who created the 
application entity.

Created On
Read-only. The date on which the application entity was 
created.

Table A-1. Application Identity fields (page 4 of 4)

Field (*Required) Description

The Contacts section is a subsection of the Header section.

The application entity fields that users can view and edit are based on the roles to 
which the users are assigned in this section. For additional information about roles, 
see The Role of the HP APM Analyst on page 13. 
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Table A-2. Application Contacts fields (page 1 of 2)

Field Description

Business Owner

The full name of the primary person with business authority 
for the application. If the user does not already have this 
ability, the Business Owner can view and edit application 
information in all sections.

Technical Owner

The full name of the primary person with technical authority 
for the application. If the user does not already have this 
ability, the Technical Owner can view and edit application 
information in the Header, Business Environment, Technical 
Environment, Service & Support, Usage & Scale, Rating, and 
Score sections.

ITO Contact

The full name of the primary person to contact regarding the 
infrastructure supporting the application. No additional 
abilities are added for this role. (All users, regardless of 
whether they are assigned a role, can view application 
information in the Header, Business Environment, Technical 
Environment, and Usage & Scale sections.)

Budget Manager

The full name of the person who is authorized to record the 
forecasted and actual costs for the application. If the user 
does not already have this ability, the Budget Manager can 
view application information in the Header, Business 
Environment, Technical Environment, Budget & Resources, 
and Usage & Scale sections. The Budget Manager can also 
view and edit budget information that is accessed from the 
Financial Summary link in the Budget & Resources section.

Benefits Manager

The full name of the person who is authorized to record the 
financial benefits of the application. If the user does not 
already have this ability, the Benefits Manager can view 
application information in the Header, Business Environment, 
Technical Environment, Budget & Resources, and Usage & 
Scale sections. The Benefits Manager can also view and edit 
benefits information that is accessed from the Financial 
Summary link in the Budget & Resources section.
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Business Environment

In the Business Environment section, enter the critical business properties of 
the application. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-3. Application Business Environment section

Respondent

The full name of the user asked to supply additional 
information about this application. If the user does not 
already have this ability, the Respondent can view and edit 
application information in all sections. This field is required 
when more information is requested for an entity.

Respondent Note
Comments sent by email to the respondent when additional 
information about the application is requested.

SMEs

Zero, one, or more full names of the subject matter experts 
(SMEs)—or acknowledged specialists—for the application. If 
the user does not already have this ability, the SME can view 
application information in the Header, Business Environment, 
Technical Environment, Usage & Scale, Rating, and Score 
sections.

Table A-2. Application Contacts fields (page 2 of 2)

Field Description
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Table A-3. Application Business Environment fields (page 1 of 2)

Field Description

Supported 
Processes

Zero, one, or more business processes that are supported by 
the application.

Owning 
Organization

The name of the organization unit with business ownership 
of the application. Organization units are created in  
HP Project and Portfolio Management Center (PPM Center). 
(For instructions for creating organization units, see the  
HP Resource Management User’s Guide.) 

Regulatory 
Requirement

Zero, one, or more compliance requirements for the 
application.

 SOX - Sarbanes-Oxley Act. United States regulations for 
corporate financial accounting.

 FERC - Federal Energy Regulatory Commission. United 
States regulations for energy transmission.

 NERC - North American Electric Reliability Corporation. 
North American regulations for energy transmission.

 CPCU - Chartered Property Casualty Underwriter. 
Professional designation in the insurance industry.

 CAISO - California Independent System Operator. 
Regulations for California's power grid. 

 HIPAA - Health Insurance Portability and Accountability 
Act. Regulations for privacy of personal information.

 PCI - Payment Card Industry Data Security Standard. 
Standards for the payment card industry.
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Technical Environment

In the Technical Environment section, enter the technologies used in the 
construction of the application, connectivity to other systems, and planned 
disposition. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Security 
Classification

The highest security level designated for the components of 
this application. That is, if the components of this application 
have different security classifications, select the highest 
classification.

 Open - Contains information with no access constraints. 
Unusual in a business context unless providing support for 
open source development.

 Internal - Contains information for which access is 
restricted to users within an organization.

 Limited - Contains information for which access is 
restricted to a defined set of users.

 Confidential - Contains sensitive corporate information.

 SECRET - Contains information for which improper 
release may damage the organization.

 Top Secret - In a military or government context, contains 
information for which access is strictly controlled. 

 Above Top Secret - Contains extremely sensitive 
information.

Table A-3. Application Business Environment fields (page 2 of 2)

Field Description
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Figure A-4. Application Technical Environment section

Table A-4. Application Technical Environment fields (page 1 of 3)

Field Description

Architecture

The type of system on which the application is deployed.

 Mainframe

 Distributed

 Desktop

 Other

Downstream 
Applications

Zero, one, or more applications that depend on this 
application's output or updates.

Upstream 
Applications

Zero, one, or more applications that produce output or 
updates on which this application depends.

Servers
The names of the servers on which the application is 
deployed.

Databases The names of the databases that the application uses.

Programming 
Technologies

Zero, one, or more programming, scripting, or descriptive 
languages or technologies that are used to construct the 
application.
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Disposition

The next planned step in the lifecycle of the application.

 Invest - Keep and enhance.

 Sustain - Keep and maintain.

 Sunset - Keep but plan for replacement.

 Decommission - Retire.

Disposition Status

The progress of the selected disposition.

 Proposed - The disposition of the application needs 
review.

 Assigned - The disposition of the application has been 
assigned an owner.

 In-Progress - The disposition of the application is 
currently ongoing.

 Complete - The disposition of the application has been 
concluded.

Disposition 
Complete Date

The date on which the disposition of the application is 
planned to be completed.

Sizing Method

Methodology used to compute the size of the application.

 IFPUG Counting - International Function Point Users 
Group function point counting.

 Backfired - Function point counting based on lines of 
code.

 Use Case Point Counting - Function point counting 
based on use cases.

 Logical LOC Counting - Lines of code.

 Custom Method - Other method to compute the size of 
the application.

Table A-4. Application Technical Environment fields (page 2 of 3)

Field Description
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Budget & Resources

In the Budget & Resources section, enter the forecast and actual costs, 
financial benefits, and average headcount supporting the application. 

Users assigned one or more of the following roles can view the data in this 
section: Business Owner, Budget Manager, Benefits Manager, or Respondent 
(when more information is requested). Users assigned one or more of the 
following roles can edit the data in this section: Business Owner or Respondent 
(when more information is requested).

Figure A-5. Application Budget & Resources section

Size The measurement based on the sizing method.

Unit of 
Measurement

The unit of measurement for the sizing method.

 Number of Pages

 Kilo Lines of Code

 Unadjusted Function Points

 ABAP Feature Points

 Siebel Function Points

 Adjusted Use Case Point

 Number of Test Cases

# of Annual 
Changes

The number of change requests submitted per year.

Table A-4. Application Technical Environment fields (page 3 of 3)

Field Description
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Table A-5. Application Budget & Resources fields

Field Description

Financial Summary

A link to the financial summary of the application. The 
financial summary captures monthly forecast and actual 
costs and benefits.

Only application entities and transformation proposals have 
a financial summary. Each application entity has its own 
financial summary; each transformation proposal has its 
own financial summary. A financial summary cannot exist 
independently (it must have a parent entity).

For more information about financial summaries, see the  
HP Financial Management User’s Guide.

Nominal Return 
(ROI)

The difference between total planned benefits (revenue) and 
total planned costs.

Nominal Return = Total Planned Benefits – Total Planned 
Costs

Total Cost of 
Ownership

The total cost to own and operate the application, including 
direct and indirect costs.

Direct Annual 
Revenue

The amount of annual revenue the application contributes to 
the enterprise.

Indirect Annual 
Revenue

The amount of annual revenue that can be attributed to the 
application through a sharing function.

Resource Count (#)
The average number of resources supporting the application 
at any one time.
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Service & Support

In the Service & Support section, enter the supporting environment and quality 
issues. 

Users assigned one or more of the following roles can view and edit the data in 
this section: Business Owner, Technical Owner, or Respondent (when more 
information is requested). 

Figure A-6. Application Service & Support section

Table A-6. Application Service & Support fields (page 1 of 2)

Field Description

Application Health

A color-coded indicator of the application's health.

 Red - Risks identified that may have adverse impact

 Yellow - Issues identified, but being managed

 Green - No issues exist

Vendor Name The vendor of the application.

Product Name The product name of the application.

Under 
Maintenance?

Indicates if the application has a current maintenance 
contract.

Placed in Service 
Date

The deployment date of the application to production.

Expected End of 
Life Date

The expected retirement date of the application. Typically this 
does not apply to a specific version of the application but to 
the application itself.
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Usage & Scale

In the Usage & Scale section, enter the usage-based size measurements. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-7. Application Usage & Scale section

Support Type

The type of support contract.

 In-House - Maintenance is provided by the organization.

 Vendor - Maintenance is provided by the vendor of the 
application.

 3rd Party - Maintenance is provided by another source 
that is not in-house nor the vendor (for example, a 
contractor).

 None - No maintenance is provide.

# of Annual 
Incidents

The number of incidents for the application tracked in a year.

Disaster Recovery 
Plan in Place?

Indicates if the application has a disaster recovery plan.

Service Level 
Agreement

The service level specified in the application's service 
contract. For example, guaranteed uptime, performance 
periods (24 hours for five days a week), or percentage of 
dropped calls.

Table A-6. Application Service & Support fields (page 2 of 2)

Field Description
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Table A-7. Application Usage & Scale fields

Field Description

End User Type

The class of the user that operates the application.

 Internal - Employees

 External - Clients

 All - Both employees and clients

User Location
The geographical or organizational distribution of users. For 
example, North America or Marketing.

Total Users The size of the user community of the application.

Active Users
The average number of active users during standard 
operation of the application.

Frequency of 
Execution

How often the application is run or is accessible.

 Online - Application is online 24x7, and may be accessed 
at anytime.

 Asynchronous - Application is run or accessed based on 
an asynchronous event or activity.

 On-Demand - Application is run and accessed only when 
needed.

 Nightly - Application is run on a nightly basis, generally as 
a batch process.

 Weekly - Application is run on a weekly basis. 

 Monthly - Application is run on a monthly basis.

 Quarterly - Application is run once a quarter.

 Yearly - Application is run once a year.
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Rating

In the Rating section, enter subjective measurements that reflect the business 
view of the application. These measurements are relative to the overall 
enterprise application portfolio. 

Users assigned one or more of the following roles can view the data in this 
section: Business Owner, Technical Owner, Respondent (when more 
information is requested), or SME. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-8. Application Rating section
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Table A-8. Application Rating fields (page 1 of 10)

Field Description

Relative Cost

The total cost of the application compared to other 
applications in the portfolio (including licenses, underlying 
hardware costs, minor enhancements, and support).

 0 - Least expensive

 1 - Inexpensive

 2 - Less than average

 3 - More than average

 4 - Expensive

 5 - Most expensive

Relative Size

The size of the application compared to the size of the typical 
application in the portfolio.

 0 - Extra small

 1 - Small

 2 - Smaller than average

 3 - Larger than average

 4 - Large

 5 - Extra large

Operational 
Stability

The reliability and dependability of the application during 
required operational hours at required locations.

 0 - Most unstable

 1 - Very unstable

 2 - Slightly unstable

 3 - Fairly stable

 4 - Very stable

 5 - Always stable
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Maintainability

The upkeep of the application compared to other applications 
in the portfolio.

 0 - Impossible to maintain

 1 - Very difficult

 2 - Some difficulty

 3 - Occasional difficulties

 4 - Easy to maintain

 5 - Simple to maintain

Complexity

The complicatedness and intricacy of the application 
compared to other applications in the portfolio. Complexity 
may be related to objective measurements such as the size 
of the application or the number of connections to other 
applications.

 0 - Extra simple

 1 - Simple

 2 - Simpler than average

 3 - More complex than average

 4 - Complex

 5 - Extra complex

Change Frequency

The number of times the system changes relative to the 
amount of change requests and incidents.

 0 - Very rarely

 1 - Infrequently

 2 - Less than average

 3 - More than average

 4 - Frequently

 5 - Excessively

Table A-8. Application Rating fields (page 2 of 10)

Field Description
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Functional 
Completeness

The satisfaction of business requirements.

 0 - Needs the most work

 1 - Needs some work

 2 - Needs a little work

 3 - Has many features

 4 - Has most needed features

 5 - Has all needed features

Flexibility

The ability to modify the application when requirements 
change (for example, changes to standards, compliance, or 
regulations).

 0 - Rigid

 1 - Great effort to adapt to changes

 2 - Significant effort to adapt to changes

 3 - Some effort to adapt to changes

 4 - Little effort to adapt to changes

 5 - Adapts to changes through configuration

Interface 
Complexity

The changes needed to integrate the application with other 
applications.

 0 - Self contained (standalone)

 1 - Few and simple

 2 - Some with average complexity

 3 - Some more complex

 4 - Many

 5 - Many or most complex

Documentation

The completeness of the user documentation.

 0 - None

 1 - Little

 2 - Some features

 3 - More features

 4 - Most features

 5 - Complete

Table A-8. Application Rating fields (page 3 of 10)

Field Description
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Scalability

The ability of the application to support fluctuations in 
demand.

 0 - Cannot scale to expected needs

 1 - Great effort to scale to expected needs

 2 - Some effort to scale to expected needs

 3 - Little effort to scale to expected needs

 4 - Scales to expected needs

 5 - Meets expected needs

Performance

The ability of the application to meet performance goals (for 
example, response time under maximum load or time to 
completion).

 0 - Never meets goals

 1 - Seldom meets

 2 - Meets less than average

 3 - Meets more than average

 4 - Usually meets

 5 - Always meets goals

Availability

User accessibility of the application during required 
operational hours.

 0 - Not available when needed

 1 - Not available when many need it

 2 - Not available when some need it

 3 - Available when some need it

 4 - Available when many need it

 5 - Available when needed

Table A-8. Application Rating fields (page 4 of 10)

Field Description
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Meets SLAs

The ability to meet service level agreements or implicit 
expectations and needs.

 0 - Never meets

 1 - Seldom meets

 2 - Meets less than average

 3 - Meets more than average

 4 - Usually meets

 5 - Always meets

Size of User Base

The number of users compared to the number of applications 
in the enterprise.

 0 - Extra small

 1 - Small

 2 - Smaller than average

 3 - Larger than average

 4 - Large

 5 - Extra large

Data Consistency

The alignment of the application's data model with enterprise 
and industry standards.

 0 - Uses custom data formats and definitions

 1 - Mostly custom

 2 - Some custom

 3 - Some standard

 4 - Mostly standard

 5 - Uses enterprise standard data formats and definitions

Table A-8. Application Rating fields (page 5 of 10)

Field Description
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Data Integrity

The validity and consistency of data contained in the 
application. For example, are all dates entered in a mm/dd/yy 
format and does each date include all attributes?

 0 - Data errors and inconsistencies permeate the system

 1 - Many data errors enter the system

 2 - More than average data errors

 3 - Few data errors enter the system

 4 - Seldom data errors enter the system

 5 - edits and validations ensure consistent data values 
throughout

Data Redundancy

The profusion of the same data in multiple data sources 
distributed across the enterprise.

 0 - Highly redundant with other data sources

 1 - Many redundant elements

 2 - Some redundancy

 3 - Few redundant elements

 4 - Minimal redundancy

 5 - No redundancy with other data sources

Vendor Financial 
Health

The financial soundness of the vendor.

 0 - Bankrupt

 1 - Questionable

 2 - Below average

 3 - Above average

 4 - Strong

 5 - Rock solid

Table A-8. Application Rating fields (page 6 of 10)

Field Description
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Vendor Competition

The maturity of the competitive landscape and the availability 
of alternate vendors.

 0 - No competitors

 1 - Emerging competitors

 2 - Some competition

 3 - Growing competition

 4 - Alternatives widely available

 5 - Commodity

Vendor Product 
Plans

The maturity of the application and if the enterprise affects 
the design process.

 0 - Off maintenance

 1 - Maintenance only

 2 - Occasionally updating

 3 - Actively updating

 4 - Plans aligned to needs

 5 - Design partner

Business Criticality

The importance of the application to the success and 
survivability of the business.

 0 - Least critical

 1 - Slightly critical

 2 - Less than average

 3 - More than average

 4 - Critical

 5 - Highly critical

Revenue Impact

The effect of the application, either directly or indirectly, on 
revenue.

 0 - None

 1 - Little

 2 - Some impact

 3 - More impact

 4 - Great impact

 5 - Highest impact

Table A-8. Application Rating fields (page 7 of 10)

Field Description
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Competitive 
Advantage

The gain this application provides compared to other 
vendor's similar applications.

 0 - None

 1 - Little

 2 - Some advantage

 3 - More advantage

 4 - Great advantage

 5 - Dominance

Customer Visibility

The accessibility of the application to the customer.

 0 - Internal facing

 1 - Some customer impact

 2 - Some customer interaction

 3 - Customer facing

 4 - Primary customer channel

 5 - Global customer dependence

Expense Reduction

The decrease in costs when the application is used.

 0 - No impact on expense

 1 - Little impact on expense

 2 - Some impact on expense

 3 - More impact on expense

 4 - Expense containment

 5 - Major expense reduction

Manual 
Workarounds 
Available

The availability of manual processes to accomplish the same 
business function.

 0 - No

 1 - Few features

 2 - Some features

 3 - Many features

 4 - Yes

 5 - Yes and tested

Table A-8. Application Rating fields (page 8 of 10)

Field Description
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Security Risk

The liability of the application in regards to access and 
security.

 0 - Conforms to security best practices

 1 - Implements standard security practices

 2 - Provides some degree of access and data security

 3 - Provides some degree of access or data security

 4 - Provides little security protections

 5 - No security protections

Architecture Risk

The liability of the application in regards to the architecture 
defined by the organization.

 0 - Conforms to architecture best practices

 1 - Adheres to enterprise standard practices

 2 - Partially adheres to enterprise standard practices

 3 - Minimally adheres to enterprise standard practices

 4 - Does not adhere to enterprise standard practices

 5 - No architecture standards defined

Technology Risk

The liability of the application based on the technology it 
utilizes.

 0 - Runs on modern, proven, standard technology

 1 - Runs on standard technology

 2 - Runs primarily on modern, proven technology

 3 - Utilizes some non-standard technology

 4 - Utilizes some obsolete, non-standard technology

 5 - Runs entirely on obsolete technology

Table A-8. Application Rating fields (page 9 of 10)

Field Description
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Skills Risk

The liability of the application in regards to the availability of 
users with the ability to run the application.

 0 - Skills exist in-house

 1 - Skills are readily available in the market

 2 - Skills are specialized but available in-house

 3 - Specialized skills are somewhat available in the market

 4 - Specialized skills are in limited supply

 5 - Highly specialized skills are scarcely available in the 
market

Compliance Risk

The liability of the application based on regulatory 
requirements and compliance validation.

 0 - No requirements or independently audited compliance 
with all requirements

 1 - Conforms to all compliance requirements

 2 - Non-compliance identified and correction plans in place 

 3 - Non-compliance identified but no correction plans in 
place 

 4 - Unknown compliance requirements

 5 -Non-compliance identified that cannot be corrected

Business Continuity 
Risk

The liability of the application based on data backups and the 
availability of a business continuity plan (BCP). The liability 
may be affected by the criticality of the application to the 
enterprise.

 0 - BCP defined, tested, and operational

 1 - BCP defined

 2 - Data securely backed up and manual workarounds in 
place

 3 - Data backed up regularly

 4 - Data backed up irregularly

 5 - No BCP or manual workarounds defined

Table A-8. Application Rating fields (page 10 of 10)

Field Description
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Score

In the Score section, view the computed scores and enter an adjustment factor 
for the total score. 

Users assigned one or more of the following roles can view the data in this 
section: Business Owner, Technical Owner, Respondent (when more 
information is requested), or SME. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-9. Application Score section

Table A-9. Application Score fields (page 1 of 3)

Field Description

Application Score

Read-only. The rating of the application, from zero to five 
(zero being the worst and five being the best). 

By default, the application score is calculated from 
non-empty individual ratings defined in the Application Rating 
Section. The formula for the application score may be 
customized.

Application Score = [(5 – Relative Cost) + (5 – Relative Size) 
+ Operational Stability + Maintainability + (5 – Change 
Frequency) + Functional Completeness + Flexibility +  
(5 – Interface Complexity) + Documentation + Performance + 
Availability + Meets SLAs + Size of User Base] / (number of 
non-empty ratings)
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Data Score

Read-only. The rating of the data provided by the application, 
from zero to five (zero being the worst and five being the 
best).

By default, the data score is the average of non-empty 
individual ratings in the Data Rating Section. The formula for 
the data score may be customized.

Data Score = (Data Consistency + Data Integrity + Data 
Redundancy) / (number of non-empty ratings)

Vendor Score

Read-only. The rating of the vendor of the application, from 
zero to five (zero being the worst and five being the best).

By default, the vendor score is the average of non-empty 
individual ratings in the Vendor Rating Section. The formula 
for vendor score may be customized.

Vendor Score = (Vendor Financial Health + Vendor 
Competition + Vendor Product Plans) / (number of non-empty 
ratings)

Value Rating

Read-only. The qualitative measure of the business value of 
the application, from zero to five (zero being the worst and 
five being the best).

By default, the value rating is the average of non-empty 
individual ratings in the Value Rating Section. The formula for 
value rating may be customized.

Value Rating = (Business Criticality + Revenue Impact + 
Competitive Advantage + Customer Visibility + Expense 
Reduction + Manual Workarounds Available) / (number of 
non-empty ratings)

Risk Rating

Read-only. The qualitative measure of the technical debt of 
the application, from zero to five (zero being the worst and 
five being the best). The risk rating is calculated from values 
defined in the Risk Rating Section of the Rating section.

By default, the risk rating is the average of non-empty 
individual ratings in the Risk Rating Section. The formula for 
risk rating may be customized.

Risk Rating = (Security Risk + Architecture Risk + 
Technology Risk + Skills Risk + Compliance Risk + Business 
Continuity Risk) / (number of non-empty ratings)

Table A-9. Application Score fields (page 2 of 3)

Field Description
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Application Set 

An application set entity is a user-defined grouping of applications.

When creating, searching for, or editing an application set, enter or update 
information in the following sections:

 Summary. The fundamental information about the application set.

 Scope. The applications included in the application set.

Summary

In the Summary section, enter the fundamental information about the 
application set.

Figure A-10. Application set Summary section

Score Adjustment 
(%)

Percentage adjustment (positive or negative) made to the 
total score.

Total Score

Read-only. The sum of all ratings and scores with the Score 
Adjustment applied.

Total Score = [Application Score + Data Score + Vendor 
Score + Value Rating + (5 – Risk Rating)] * [1 + (Score 
Adjustment  / 100)]

Table A-9. Application Score fields (page 3 of 3)

Field Description
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Table A-10. Application set Summary fields

Field (*Required) Description

Set No. Read-only. A unique numeric identifier of the application set.

Status

Read-only. The status of the application set.

 New - The application set is being defined but has not 
been submitted.

 Active - The application set is active.

 Change Pending - The application set is being modified.

 Cancelled - The application set has been cancelled and 
its information is no longer valid.

*Set Name
A descriptive, distinct, and unambiguous name for the 
application set.

Description
Information that describes the need and function of the 
application set.

Created By
Read-only. The full name of the user who created the 
application set.

Created On
Read-only. The date on which the application set was 
created.
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Scope

In the Scope section, enter the applications that are part of the application set.

Figure A-11. Application set Scope section

Location

A location entity is a distinct and unambiguous location of an application, 
server, or a grouping of locations.

When creating, searching for, or editing a location, enter or update information 
in the following sections:

 Summary. The fundamental information about the location.

 Address. Information about the address and other geographical attributes.

Table A-11. Application set Scope fields

Field (*Required) Description

Seq The sequence number of the application.

*Name
The name of the application in the application set.This field is 
required when you add a row to the table.
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Summary

In the Summary section, enter the fundamental information about the location.

Figure A-12. Location Summary section

Table A-12. Location Summary fields

Field (*Required) Description

Location No. Read-only. A unique numeric identifier of the location.

Status

Read-only. The status of the location.

 New - The location is being defined but has not been 
submitted.

 Active - The location is active and currently being 
managed by its owner.

 Change Pending - The location is being modified.

 Cancelled - The location has been cancelled and its 
information is no longer valid.

*Location Name A distinct and unambiguous name for the location.

Description
Information that describes the important attributes of the 
location from a business or IT point of view.

Parent Location
The Location Name of the location of which this location, 
hierarchically, is a child.

Owner
The full name of the person in the organization responsible 
for ensuring that this location is up-to-date. The owner is 
allowed to edit information about this location.

Created By
Read-only. The full name of the user who created the 
location entity.

Created On
Read-only. The date on which the location entity was 
created.
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Address

In the Address section, enter information about the location address and other 
geographical attributes.

Figure A-13. Location Address section

Table A-13. Location Address fields

Field Description

Address Street number and street name of the location.

City City name of the location.

State/Province State name (U.S.) or province name (Canada).

Postal Code Postal code, postcode, ZIP code, or PIN code of the location.

Country Country name of the location.

Region

Geographic area of the location.

 Americas

 EMEA (Europe, Middle East, Africa)

 Asia Pacific

Longitude Longitudinal geographic coordinate of the location.

Latitude Latitudinal geographic coordinate of the location.
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Process

A process entity is a standard set of actions or operations that moves the 
organization towards achieving a business objective.

When creating, searching for, or editing a process, enter or update information 
in the following sections:

 Summary. The fundamental information about the process.

 Compliance. The information about compliance requirements and if they 
are met.

Summary

In the Summary section, enter the fundamental information about the process.

Figure A-14. Process Summary section

Table A-14. Process Summary fields (page 1 of 2)

Field (*Required) Description

Process No. Read-only. A unique numeric identifier of the process.

Status

Read-only. The status of the process.

 New - The process is being defined but has not been 
submitted.

 Active - The process is active and currently being 
managed by its owner.

 Change Pending - The process is being modified.

 Cancelled - The process has been cancelled and its 
information is no longer valid.
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*Process Name
A distinct and unambiguous name for the process that 
corresponds to standard industry usage.

Description
Information that describes the need and function of the 
process.

Parent Process
The Process Name of the process of which this process, 
hierarchically, is a child.

*Process Type

A definition of where the process is completed. Each process 
must be associated with a process type on creation. 

 Direct - A process completed explicitly by the 
organization.

 Indirect - A process completed by a client or third party.

Owner
The full name of the person in the organization responsible 
for ensuring that this process is carried out. The owner is 
allowed to edit information about this process.

Created By
Read-only. The full name of the user who created the 
process entity.

Created On
Read-only. The date on which the process entity was 
created.

Table A-14. Process Summary fields (page 2 of 2)

Field (*Required) Description
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Compliance

In the Compliance section, enter information about compliance requirements 
and if they are met.

Figure A-15. Process Compliance section

Table A-15. Process Compliance fields

Field Description

Compliance 
Requirements

Zero, one, or more compliance requirements for the process.

 SOX - Sarbanes-Oxley Act. United States regulations for 
corporate financial accounting.

 FERC - Federal Energy Regulatory Commission. United 
States regulations for energy transmission.

 NERC - North American Electric Reliability Corporation. 
North American regulations for energy transmission.

 CPCU - Chartered Property Casualty Underwriter. 
Professional designation in the insurance industry.

 CAISO - California Independent System Operator. 
Regulations for California's power grid. 

 HIPAA - Health Insurance Portability and Accountability 
Act. Regulations for privacy of personal information.

 PCI - Payment Card Industry Data Security Standard. 
Standards for the payment card industry.

Compliant
Indicates if the process conforms with the selected 
Compliance Requirements.
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Server

A server entity is a physical or virtual machine.

When creating, searching for, or editing a server, enter or update information 
in the following section:

 Summary. The fundamental information about the server.

Summary

In the Summary section, enter the fundamental information about the server.

Figure A-16. Server Summary section

Table A-16. Server Summary fields (page 1 of 2)

Field (*Required) Description

Server No. Read-only. A unique numeric identifier of the server.

Status

Read-only. The status of the server.

 New - The server is being defined but has not been 
submitted.

 Active - The server is active.

 Change Pending - The server is being modified.

 Cancelled - The server has been cancelled and its 
information is no longer valid.

*Server Name A distinct and unambiguous name for the server.

Description
Information that describes the important attributes of the 
server, from a business or IT point of view.
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Survey Registration

A survey registration entity is a query to collect data about an application to 
help with its analysis.

When creating, searching for, or editing a survey, enter or update information 
in the following sections:

 Summary. The fundamental information about the survey.

 Details. The information about the type of survey and the expected 
completion date.

IP Address Internet Protocol address of the server.

Type

Function of the server.

 Development

 Testing

 Production

OS The operating system on which the server is running.

Running Software
List of major software packages or applications running on 
the server. The list is comma-delimited. Do not include 
operating system utilities.

Location Physical location of the server.

Created By
Read-only. The full name of the user who created the server 
entity.

Created On Read-only. The date on which the server entity was created.

Table A-16. Server Summary fields (page 2 of 2)

Field (*Required) Description
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Summary

In the Summary section, enter the fundamental information about the survey.

Figure A-17. Survey registration Summary section

Table A-17. Survey registration Summary fields

Field (*Required) Description

Request No. Read-only. A unique numeric identifier of the survey.

Status

Read-only. The status of the survey.

 New - The survey is being defined but has not been 
submitted.

 In Design - The survey is being scoped and has not been 
sent.

 Active - Surveys have been sent to the target audience for 
responses.

 Closed - The survey is not active and is no longer 
accepting responses.

 Cancelled - The survey has been cancelled and its 
information is no longer valid.

*Survey Name
A distinct, unambiguous, and descriptive name for the 
survey.

Created By
Read-only. The full name of the user who created the survey 
registration entity.

Created On
Read-only. The date on which the survey registration entity 
was created.
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Details

In the Details section, enter information about the type of survey, the expected 
completion date, the applications it includes, and the respondents needed for 
the applications. 

Figure A-18. Survey registration Details section

Table A-18. Survey registration Details fields (page 1 of 2)

Field (*Required) Description

*Survey Template

The type of survey to send.

 Business Survey. Business-related ratings for the 
application, data, vendor, value, and risk.

 General Survey (Full). Application-related ratings for the 
application, data, vendor, value, and risk.

 Technical Survey. Technical-related ratings for the 
application, data, vendor, and risk.

View Preview A link to view the survey.

Target Completion 
Date

The date on which the survey closes. By default, every three 
days an email is sent to remind the survey respondent to 
complete the survey until this date is met.
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Transformation Proposal

A transformation proposal entity is a consolidation of information used to 
make a decision about a proposed project. Transformation proposals may be 
imported as proposals into PPM Center for additional analysis.

When creating, searching for, or editing a transformation proposal, enter or 
update information in the following sections:

 Summary. The fundamental information about the transformation proposal.

 Proposal Details. The information about the basic effort implication for the 
transformation proposal.

 Business Case Details. The information used to understand the 
transformation proposal and its expectations.

 Value & Risk Assessment. The information about the initial evaluation of 
risks and rewards.

*List of Applications 
& Respondents

A table containing the list of applications and respondents for 
the survey. After the survey registration entity is created, the 
fields in this table must be completed before the survey can 
be submitted. This table is named List of Surveys after the 
survey registration is submitted. For descriptions of the icons 
in this table, see Table 4-1 on page 87. 

List of Surveys

Read-only. A table containing the list of surveys that were 
sent. Includes the survey number, and name of the 
application, and the respondent for each survey sent. This 
table is named List of Applications & Respondents before the 
survey registration is submitted.

Table A-18. Survey registration Details fields (page 2 of 2)

Field (*Required) Description
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Summary

In the Summary section, enter the fundamental information about the 
transformation proposal.

Figure A-19. Transformation proposal Summary section

Table A-19. Transformation proposal Summary fields (page 1 of 2)

Field (*Required) Description

Title
Read-only. The description assigned to the transformation 
proposal when the transformation proposal is created.

Proposal No.
Read-only. A unique numeric identifier of the transformation 
proposal.

Status

Read-only. The status of the transformation proposal.

 New - The transformation proposal is being defined but 
has not been submitted.

 In Review - The transformation proposal is currently under 
review.

 Approved - The transformation proposal has been 
approved for execution.

 Rejected - The transformation proposal has been 
rejected.

 Cancelled - The transformation proposal entity has been 
cancelled and its information is no longer valid.
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Proposal Details

In the Proposal Details section, enter information about the basic effort 
implication for the transformation proposal.

Figure A-20. Transformation proposal Proposal Details section

*Proposal Name

A name given to the transformation proposal that 
distinguishes it from other transformation proposals. 
Although the name is not validated for uniqueness during 
initial creation, it must be unique in order to transition the 
transformation proposal from In Review to Active status.

Owner
The full name of the user who is proposing the transformation 
proposal. The owner is allowed to edit information about this 
transformation proposal.

Description
Information that describes the business value and 
applications affected by the transformation proposal.

Proposal 
Dependencies

Existing transformation proposals that must be completed 
successfully before this transformation proposal can be 
executed.

Created By
Read-only. The full name of the user who created the 
transformation proposal entity.

Created On
Read-only. The date on which the transformation proposal 
entity was created.

Table A-19. Transformation proposal Summary fields (page 2 of 2)

Field (*Required) Description
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Table A-20. Transformation proposal Proposal Details fields

Field Description

Project Class

The fundamental type of the project, used to determine 
business rules or policies that help manage the project.

 Innovation

 Growth

 Efficiency

 Core (Keep the Lights On)

Asset Class

The type of asset that is affected by the transformation 
proposal.

 Infrastructure - Investments that provide a shared and 
standardized base of capability for the enterprise.

 Informational - Systems that provide information for 
managing an organization.

 Transactional - Transformation proposals that process 
and automate the basic transactions of an organization.

Business Objective
The result that the enterprise intends to achieve by 
completing the transformation proposal. 

Executive Sponsor
The full name of the executive sponsor of the transformation 
proposal.

IT Sponsor
The full name of the IT leader of the group that is responsible 
for executing the transformation proposal.

Expected Start 
Period

The month and year in which the project is expected to start.

Expected Finish 
Period

The month and year in which the project is expected to finish.

Associated 
Applications

The applications impacted by the transformation proposal.

Vendors Involved
The vendors of the associated applications who may be 
involved with the transformation proposal.
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Business Case Details

In the Business Case Details section, enter information used to understand the 
transformation proposal and its expectations.

Figure A-21. Transformation proposal Business Case Details section

Table A-21. Transformation proposal Business Case Details fields (page 1 of 2)

Field Description

Business Case Doc
An attachment that explains the business case of the 
transformation proposal.

Requirements Doc
An attachment that explains the requirements of the 
transformation proposal.

Budget Manager
The full name of the person who is authorized to record the 
forecasted and actual costs for the application.

Benefits Manager
The full name of the person who is authorized to record the 
financial benefits of the application.
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Value & Risk Assessment

In the Value & Risk Assessment section, enter information about the initial 
evaluation of risks and rewards. 

Figure A-22. Transformation proposal Value & Risk Assessment section

Financial Summary

A link to the financial summary of the transformation 
proposal. The financial summary captures monthly forecast 
and actual costs and benefits.

Only application entities and transformation proposals have a 
financial summary. Each application entity has its own 
financial summary; each transformation proposal has its own 
financial summary. A financial summary cannot exist 
independently (it must have a parent entity).

For more information about financial summaries, see the  
HP Financial Management User’s Guide.

Nominal Return

The difference between total planned benefits (revenue) and 
total planned costs.

Nominal Return = Total Planned Benefits – Total Planned 
Costs

Table A-21. Transformation proposal Business Case Details fields (page 2 of 2)

Field Description
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In the Description column of Table A-22, the numbers in parentheses are the 
values that are assigned to the list items when they are selected.

Table A-22. Transformation proposal Value & Risk 
Assessment fields (page 1 of 4)

Field Description

Internal Rate of 
Return

The profitability of the transformation proposal.

 Zero or less (0)

 1 - 5.99% (10)

 6 - 9.99% (20)

 10 - 14.99% (30)

 15% and above (40)

Strategic Match

How the transformation proposal affects the business 
objectives.

 No impacted business goals. (0)

 No impacted goal. Increases operational efficiency. (5)

 No direct impact of goal, but prerequisite. (10)

 Direct impact on a portion of a goal. (15)

 Direct achievement of a goal. (20)

 Direct achievement of multiple goals. (25)

Competitive 
Advantage

The impact the transformation proposal has on competitive 
positioning.

 No client or market impact. (0)

 Improves operating efficiencies that affect competitive 
position. (5)

 Improves operating efficiencies in strategic area. (10)

 Provides some degree of outside access. (15)

 Provides moderate degree of outside access. (20)

 Provides high level of outside access. (25)
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Competitive 
Response

The urgency of the transformation proposal relative to 
competitive positioning.

 Can be postponed for 12 months with no effect to 
competitive positioning. (0)

 Can be postponed for 12 months with minimal effect to 
competitive positioning. (2)

 Can be postponed for 12 months with significant effect to 
competitive positioning. (4)

 Postponement will result in loss of competitive positioning. 
(6)

 Postponement will result in complete loss of competitive 
positioning. (10)

Productivity

The expected increase or decrease of productivity when the 
transformation proposal is completed.

 Decreased productivity (0)

 Less than 10% increase (2)

 11 - 30% increase (4)

 30 - 50% increase (6)

 51% or more increase (10)

Value Rating

Read-only. The qualitative measure of the business value of 
the transformation proposal.

By default, the value rating is the sum of non-empty individual 
ratings listed above the Value Rating field. The formula for 
value rating may be customized.

Value Rating = Internal Rate of Return + Strategic Match + 
Competitive Advantage + Competitive Response + 
Productivity

Table A-22. Transformation proposal Value & Risk 
Assessment fields (page 2 of 4)

Field Description
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Organization Risk

The liability of the transformation proposal based on its 
impact to the organization.

 No risk (0)

 Low risk (1)

 Medium low risk (2)

 Medium risk (3)

 High risk (4)

 Extreme risk (5)

Technical Risk

The liability of the transformation proposal based on the 
technology it utilizes and the skills required to use the 
technology.

 No uncertainty (0)

 Very low uncertainty (3)

 Low uncertainty (6)

 Medium uncertainty (9)

 High uncertainty (12)

 Unknown (15)

Architecture Risk

The liability of the transformation proposal in regards to the 
architecture defined by the organization.

 Utilizes standard architecture (0)

 Minor change to standard architecture (2)

 Medium change to standard architecture (4)

 Major change to standard architecture (6)

 No leverage of standard architecture (10)

Table A-22. Transformation proposal Value & Risk 
Assessment fields (page 3 of 4)

Field Description
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Definition Risk

How well the requirements are defined for the transformation 
proposal.

 Requirements are firm. No changes. (0)

 Requirements are moderately firm. Low probability of 
changes. (2)

 Requirements are moderately firm. Medium probability of 
changes. (4)

 Requirements are moderately firm. High probability of 
changes. (6)

 Requirements are not firm (8)

Infrastructure Risk

The liability of the transformation proposal in regards to the 
infrastructure of the organization.

 Uses existing systems and services (0)

 Small changes to existing infrastructure (1)

 Small changes and additions are expected (2)

 Moderate changes are expected (3)

 Moderate changes to multiple systems are expected (4)

 Substantial change to infrastructure are expected (5)

Risk Rating

Read-only. The qualitative measure of the risk of the 
transformation proposal to successfully complete. The risk 
rating is calculated from values defined in the Risk Rating 
Section of the Rating section.

By default, the risk rating is the sum of non-empty individual 
ratings for all risks in the Value & Risk Assessment section. 
The formula for risk rating may be customized.

Risk Rating = Organization Risk + Technical Risk + 
Architecture Risk + Definition Risk + Infrastructure Risk

Score Adjustment Adjustment (positive or negative) made to the total score.

Total Score
Read-only. The difference between the Value Rating and 
Risk Rating with the Score Adjustment applied.

Total Score = Value Rating – Risk Rating + Score Adjustment

Table A-22. Transformation proposal Value & Risk 
Assessment fields (page 4 of 4)

Field Description
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Workstream

A workstream entity is a collection of resources working towards a common 
goal on a portion of the application or process portfolio.

When creating, searching for, or editing a workstream, enter or update 
information in the following sections:

 Summary. The fundamental information about the workstream.

 Schedule. The planned and actual start dates, finish dates, duration, and 
effort.

 Staffing. The users assigned to the workstream.

 Scope. The processes and applications impacted by the workstream.

Summary

In the Summary section, enter the fundamental information about the 
workstream.

Figure A-23. Workstream Summary section
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Table A-23. Workstream Summary fields (page 1 of 2)

Field (*Required) Description

Workstream No. Read-only. A unique numeric identifier of the workstream.

Status

Read-only. The status of the workstream.

 New - The workstream is being defined but has not been 
submitted.

 Active - The workstream is active and currently being 
managed by its owner.

 In Review - The workstream is currently under review.

 Closed - The workstream is completed.

 Cancelled - The workstream has been cancelled and its 
information is no longer valid.

*Name
A distinct and unambiguous name for the workstream that 
reflects its intention.

Priority

The importance of the workstream to the enterprise relative 
to other workstreams.

 Low - The workstream does not affect the performance 
and functioning of the enterprise and is of less importance 
compared to other workstreams within the enterprise.

 Normal - The workstream may or may not affect the 
performance and functioning of the enterprise and is of 
average importance compared to other workstreams 
within the enterprise.

 High - The workstream may affect the performance and 
functioning of the enterprise and is of more importance 
compared to other workstreams within the enterprise.

 Critical - The workstream is required for the performance 
and functioning of the enterprise.

Description
Information that describes the scope, effort, and timeline of 
the workstream.

Owner
The full name of the person who is responsible for executing 
the workstream. The owner is allowed to edit information 
about this workstream.
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Schedule

In the Schedule section, enter the planned and actual start dates, finish dates, 
duration, and effort.

Figure A-24. Workstream Schedule section

Reviewer
The full name of the person who is responsible for reviewing 
the workstream and verifying that the deliverables are met.

Created By
Read-only. The full name of the user who created the 
workstream entity.

Created On
Read-only. The date on which the workstream entity was 
created.

Table A-23. Workstream Summary fields (page 2 of 2)

Field (*Required) Description

Table A-24. Workstream Schedule fields (page 1 of 2)

Field Description

Scheduled Start 
Date

The day on which the workstream is planned to start.

Actual Start Date The day on which the workstream actually started.

Scheduled Finish 
Date

The day on which the workstream is planned to finish.

Actual Finish Date The day on which the workstream actually finished.

Scheduled Duration
The planned number of work days needed to complete the 
workstream.
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Staffing

In the Staffing section, enter the users assigned to the workstream.

Figure A-25. Workstream Staffing section

Scope

In the Scope section, enter the processes and applications impacted by the 
workstream.

Figure A-26. Workstream Scope section

Actual Duration
The actual number of work days needed to complete the 
workstream.

Scheduled Effort
The planned number of working hours needed to complete 
the workstream.

Actual Effort
The actual number of working hours needed to complete the 
workstream.

Table A-24. Workstream Schedule fields (page 2 of 2)

Field Description

Table A-25. Workstream Staffing fields

Field Description

Resource(s) List of users, by full name, assigned to the workstream.
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Table A-26. Workstream Scope fields

Field Description

Process(es) Zero, one, or more processes impacted by the workstream.

Application(s) Zero, one, or more applications impacted by the workstream.

Application Set The set of applications impacted by the workstream.
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B PPM Dashboard Pages and Portlets
Overview of PPM Dashboard Pages and Portlets

HP Application Portfolio Management (HP APM) provides several shared 
PPM Dashboard pages and portlets for the HP APM analyst. It also 
provides portlets that an HP APM analyst can add to private PPM Dashboard 
pages and configure. 

 Shared PPM Dashboard Pages and Portlets. PPM Dashboard pages and 
portlets provided for the analyst. You cannot edit shared PPM Dashboard 
pages. You can configure shared portlets only if you first copy them to a 
private PPM Dashboard page.

 Configurable Portlets. Portlets you can add to private PPM Dashboard 
pages and personalize.

The PPM Dashboard pages and portlets available to you might be different 
from the PPM Dashboard pages and portlets described in this appendix. This 
could be because of your configuration or the roles that you are assigned. 
Additionally, it could be because the HP APM administrator chose to remove 
or add PPM Dashboard pages and portlets to your organization’s 
implementation of HP APM. Any PPM Dashboard pages and portlets added 
by your HP APM administrator are not documented in this guide. 

Because HP APM is a part of HP Project and Portfolio Management Center  
(PPM Center), PPM Dashboard pages and portlets unrelated to HP APM might 
also be available to you. This guide addresses only the HP APM pages and portlets.
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This appendix provides descriptions and screenshots of the shared  
PPM Dashboard pages and portlets they contain. It also provides descriptions 
and screenshots of the portlets you can add to your private PPM Dashboard 
pages. 

For descriptions of additional PPM Dashboard pages and portlets that might 
be available to you, see the  HP Application Portfolio Management User’s 
Guide for descriptions of the PPM Dashboard pages and portlets provided for 
HP APM users.

For more information about PPM Dashboard pages and portlets, see  
PPM Dashboard and PPM Dashboard Pages on page 98 and Portlets and 
Portlet Definitions on page 99. For information about creating and maintaining 
portlet definitions and PPM Dashboard pages, see the Creating Portlets and 
Modules guide. For information about personalizing portlets, see the Getting 
Started guide.

Shared PPM Dashboard Pages and Portlets

The shared PPM Dashboard pages provided for the HP APM analyst are 
preconfigured pages that contain entity-related portlets. The portlets on the 
shared PPM Dashboard pages are predefined versions of the portlets that are 
available for you to add to a personalized PPM Dashboard page. You cannot 
edit the shared PPM Dashboard pages. You can configure shared portlets only 
when you have first copied them to a private PPM Dashboard page.

The following shared PPM Dashboard pages are typically provided for  
HP APM analysts:

 Front Page

 Portfolio View Page

 Applications Page

The portlets on the shared PPM Dashboard pages are also known as HP-supplied 
portlets. 
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The shared PPM Dashboard pages and portlets are described in the following 
sections. For more information about shared portlets, see the online help. For 
information about how to use the PPM Dashboard pages, see PPM Dashboard 
and PPM Dashboard Pages on page 98.

Front Page

The Front Page PPM Dashboard page displays portlets that contain 
information that you might want to track regularly. These portlets include 
information about the applications in the portfolio, workstreams you manage, 
transformation proposals you have defined, surveys you are conducting, and 
applications that are not mapped to processes.

Figure B-1. Example Front Page portlets 
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Table B-1. Front Page portlets

Portlet Name Description

 Applications

This portlet displays a list of all applications in your 
organization's portfolio. Use this portlet to track basic 
information about an application. The following columns 
are displayed: Name, Business Owner, Disposition, 
Disposition Status, Total Score, Last Update Date, and 
Status.

By default, applications are listed alphabetically by 
name.

Applications Not 
Mapped to Process

This portlet displays a list of all applications in your 
organization's portfolio that are not assigned to a 
business process. Use this portlet to view all 
applications that do not contribute to any business 
process. The following columns are displayed: Name, 
Business Owner, Disposition, Total Score, and Status.

By default, applications are listed alphabetically by 
name.

My Workstreams

This portlet displays a list of all workstreams you own, 
review, or have created. Use this portlet to view the 
workstreams that you manage. The following columns 
are displayed: Name, Owner, Reviewer, and Status.

By default, workstreams are listed alphabetically by 
name.

My Transformation 
Proposals

This portlets displays all active and approved 
transformation proposals that you own. Use this portlet 
to view your transformation proposals that can be 
developed as projects. The following columns are 
displayed: Name, Owner, Total Score, and Status.

By default, transformation proposals are listed 
alphabetically by name.

My Survey Requests

This portlet displays all active survey requests you have 
made. Use this portlet to keep track of the surveys you 
are conducting. The following columns are displayed: 
Name, End Date, and Status.

By default, survey requests are listed alphabetically by 
name.
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Portfolio View Page

The Portfolio View PPM Dashboard page displays portlets with application 
portfolio information that you might want to track regularly. This includes an 
assessment of an application’s value, transformation proposal ratings, the 
number of applications in the portfolio, and an application’s total cost of 
ownership.
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Figure B-2. Example Portfolio View page
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Applications Page

The Applications PPM Dashboard page displays portlets with application 
information that the you might want to track regularly. This includes an 
application’s health by owner, the quantity of applications that support a 
process, a list of all applications in the portfolio.

Table B-2. Portfolio View portlets

Portlet Name Description

Application Value 
Assessment

This portlet displays an application's quality, health, 
value rating, and total cost of ownership. This portlet can 
be displayed as a bubble chart (default) or list. Use the 
information to determine if an application needs to be 
assessed for, for example, modernization.

Application 
Transformation 
Proposal Ratings

This portlet displays the total score, value rating, and 
risk rating by transformation proposal. This portlet can 
be displayed as a clustered bar chart (default), stacked 
bar chart, or list. Use this portlet to view how 
transformation proposals are ranked based on their total 
score.

In the clustered bar chart and stacked bar chart, by 
default, applications are listed numerically (highest to 
lowest) by total score.

Application Portfolio 
Size over Time

This portlet displays the quantity of applications in the 
portfolio over a period of time. This can portlet be 
displayed as a line chart (default), XY chart, radar chart, 
or list. Use this portlet to track how many applications 
are in the portfolio over a specified period of time.

By default, Period Type is set to Quarter.

Total Cost of Ownership 
(TCO) Summary

This portlet displays the total cost of ownership by 
application in the portfolio. This portlet can be displayed 
as a bar chart (default), pie chart, or list. Use this portlet 
to determine the total cost to own and operate an 
application.

In the bar chart and pie chart, by default, applications 
are listed numerically (highest to lowest) by cost.
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Figure B-3. Example Applications page
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Table B-3. Applications portlets

Portlet Name Description

 Application Health 
Breakdown by Owner

This portlet displays the quantity of applications by 
health for each business owner. This portlet can be 
displayed as a stacked bar chart (default), clustered bar 
chart, or list. Use this portlet to track how many 
applications are owned by each business owner and the 
health of each application.

From this portlet, you may drill down to display, for the 
selected application, the application's health, name, 
business owner, technical owner, disposition, disposition 
status, total score, and status.

Application to Process 
Coverage Summary

This portlet displays the quantity of applications that 
support a business process and the health of the 
applications. This can be displayed as a list. Use this 
portlet to determine how many applications support a 
business process and the health of each application.

Application List

This portlet displays a list of all applications in your 
organization's portfolio. Use this portlet to view basic 
information about an application. The following columns 
are displayed: Name, Business Owner, Technical 
Owner, Disposition, Disposition Status, Total Score, and 
Status.

By default, applications are listed alphabetically by 
name.
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Configurable Portlets

You can use and personalize the configurable portlets to organize and present 
information about your application portfolio. In many of these portlets, you 
can drill down on displayed data to view more detail. When you add these 
portlets to your private PPM Dashboard pages, you can configure and 
personalize them:

 Application Health Breakdown. Use to track applications by business 
owner and health.

 Application Portfolio Size. Use to track how many applications are in the 
portfolio over a specified period of time.

 Application to Process Coverage. Use to determine how many applications 
support a business process and the health of the applications.

 Application Value Assessment. Use to determine how or if an application 
needs to be assessed.

 List of Applications (Analyst). Use to view basic information about an 
application.

 My Applications. Use to track and assess data meaningful to you.

 My Survey Requests. Use to track surveys you are conducting.

 My Transformation Proposals. Use to view your transformation proposals.

 My Workstreams. Use to view workstreams that you manage.

 Rating of Transformation Proposals. View how transformation proposals 
are ranked based on their total score.

 TCO Summary. Use to determine the total cost to own and operate an 
application.

Find these portlets in the Application Portfolio category when you add portlets to a 
private PPM Dashboard page.
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The configurable portlets are described in the following sections. 

For more information about portlets, seePortlets and Portlet Definitions 
on page 99 and the online help.

Application Health Breakdown

The Application Health Breakdown portlet displays the number of applications 
by health for each business owner. This portlet can be displayed as a stacked 
bar chart (default), clustered bar chart, or list. Use this portlet to track how 
many applications are owned by each business owner and the health of each 
application.

From this portlet, you can drill down by clicking a colored bar in the stacked 
bar or clustered bar chart or the name of the business owner in the List view to 
display the health of the associated application (or applications), its name, 
business owner, technical owner, disposition, disposition status, total score, 
and status. 

Figure B-4. Example Application Health Breakdown portlet
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Edit the preferences to filter the results that are displayed in the portlet.

Application Portfolio Size

The Application Portfolio Size portlet displays the number of applications in 
the portfolio over a period of time. This portlet can be displayed as a line chart 
(default), XY chart, radar chart, or list. Use this portlet to track how many 
applications were in the portfolio over a specified period of time. 

You must specify the start and end period before data is displayed in this 
portlet.

By default, Period Type is set to Quarter. 

Figure B-5. Example Application Portfolio Size portlet

Edit the preferences to filter the results that are displayed in the portlet.

Table B-4. Application Health Breakdown portlet preferences

Field Description

Application Set

Select an application set to display in the portlet. The 
portlet displays the quantity and health of applications 
from the application set for each business owner who 
owns an application in the application set. By default, the 
quantity and health of all applications for all business 
owners are displayed.

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.
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Application to Process Coverage

The Application to Process Coverage portlet displays the number of 
applications that support a business process and the health of the applications. 
This portlet is displayed as a list. Use this portlet to determine how many 
applications support a business process and the health of the applications.

Table B-5. Application Portfolio Size portlet preferences

Field (*Required) Description

Application Set

Select an application set to display in the portlet. The 
portlet displays the quantity of applications from the 
application set for the specified time period. By default, 
all applications in the application portfolio are counted.

*Period Type

Default: Quarter

The time period by which the quantity of applications is 
displayed.

 Month

 Quarter

 Half Year

 Year

*Period Start
Select the starting time period from which you want to 
display the quantity of applications.

*Period Finish
Select the ending time period to which you want to 
display the quantity of applications.

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet. 
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Figure B-6. Example Application to Process Coverage portlet

Edit the preferences and display columns to filter the results that are displayed 
in the portlet.

Table B-6. Application to Process Coverage portlet filters (page 1 of 2)

Field (*Required) Description

Applications

Specify zero, one, or more applications to display the 
business processes supported by application health. If 
no applications are specified, all applications for which 
data is available are counted.

Application Set

Select an application set to display in the portlet. The 
portlet displays the business processes supported by 
application health. By default, all applications in the 
application portfolio are displayed.

Business Processes

Specify zero or one business process to display the 
quantity of applications that support it by application 
health. If no business processes are specified, all 
business processes for which data is available are 
displayed.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.
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Application Value Assessment

The Application Value Assessment portlet displays an application's quality, 
health, value rating, and total cost of ownership. This portlet can be displayed 
as a bubble chart (default) or list. Use the information in this portlet to 
determine how or if an application needs to be assessed. For example, an 
application that scores low on quality but high on value rating might need to be 
assessed for improvement opportunities.

*Rows Displayed

Default: 10

Specify the number of applications displayed in the 
normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of applications displayed in a 
maximized portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-6. Application to Process Coverage portlet filters (page 2 of 2)

Field (*Required) Description
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Figure B-7. Example Application Value Assessment portlet

Edit the preferences to filter the results that are displayed in the portlet.

Table B-7. Application Value Assessment portlet preferences (page 1 of 2)

Field Description

Application

Select zero, one, or more applications to display the 
quality, health, value rating, and total cost of ownership. 
If no applications are specified, all applications for which 
data is available are displayed.

Application Set

Select an application set to display in the portlet. The 
portlet displays the quality, health, value rating, and total 
cost of ownership of applications from the application 
set. By default, the quality, health, value rating, and total 
cost of ownership of all applications for all business 
owners are displayed.

Contact

Select a person who is the primary contact regarding the 
infrastructure supporting the application. Only 
applications that have this person listed as its contact 
are displayed.

Business Owner
Select a person who has the primary business authority 
for the application. Only applications that have this 
person listed as its business owner are displayed.

Status
Select a status of the applications to display. Only 
applications that have this status are displayed.
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List of Applications (Analyst)

The List of Applications (Analyst) portlet displays a list of all applications in 
your organization's portfolio. By default, this portlet displays an application's 
name, business owner, technical owner, disposition, disposition status, total 
score, and status. Use this portlet to view basic information about an 
application. Create a customized version of the portlet to track and assess 
data meaningful to you. 

By default, applications are listed alphabetically by name.

Health

Select zero, one, or more color-coded indicators of the 
application’s health to display. Only applications that 
have this health are displayed. If no health is specified, 
all applications for which data is available are displayed.

Process

Select a business process supported by the application. 
Only applications that support this business process are 
displayed. If no business process is specified, all 
applications for which data is available are displayed.

Is Orphan?

Select applications that do or do not support a business 
process.

 No - Select applications that support a business 
process

 Yes - Select applications that do not support a 
business process

 Blank - Select all applications

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.

Table B-7. Application Value Assessment portlet preferences (page 2 of 2)

Field Description
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Figure B-8. Example List of Applications (Analyst) portlet

Edit the preferences and display columns to filter the results that are displayed 
in the portlet.

Table B-8. List of Applications (Analyst) portlet filters (page 1 of 3)

Field (*Required) Description

Application

Select zero, one, or more applications to display the 
quality, health, value rating, and total cost of ownership. 
If no applications are specified, all applications for which 
data is available are displayed.

Application Set

Select an application set to display in the portlet. The 
portlet displays the quality, health, value rating, and total 
cost of ownership of applications from the application 
set. By default, the quality, health, value rating, and total 
cost of ownership of all applications for all business 
owners are displayed.

Contact

Select a person who is the primary contact regarding the 
infrastructure supporting the application. Only 
applications that have this person listed as its contact 
are displayed.

Business Owner
Select a person who has the primary business authority 
for the application. Only applications that have this 
person listed as its business owner are displayed.
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Health

Select zero, one, or more color-coded indicators of the 
application’s health to display. Only applications that 
have this health are displayed. If no health is specified, 
all applications for which data is available are displayed.

Status
Select a status of the applications to display. Only 
applications that have this status are displayed.

Process

Select a business process supported by the application. 
Only applications that support this business process are 
displayed. If no business process is specified, all 
applications for which data is available are displayed.

Is Orphan?

Select applications that do or do not support a business 
process.

 No - Select applications that support a business 
process

 Yes - Select applications that do not support a 
business process

 Blank - Select all applications

Delegate
Select a person who is asked to supply additional 
information about the application. Only applications that 
have this person listed as its delegate are displayed.

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed

Default: 10

Specify the number of applications displayed in the 
normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of applications displayed in a 
maximized portlet.

Type any integer greater than zero.

Table B-8. List of Applications (Analyst) portlet filters (page 2 of 3)

Field (*Required) Description
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My Applications

The My Applications portlet displays a list of applications that you own. Use 
this portlet to track basic information about the applications you own. Create a 
customized version of the portlet to track and assess data meaningful to you.

By default, applications are listed alphabetically by name. 

Figure B-9. Example My Applications portlet

Edit the preferences and display columns to filter the results that are displayed 
in the portlet.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-8. List of Applications (Analyst) portlet filters (page 3 of 3)

Field (*Required) Description
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Table B-9. My Applications portlet filters (page 1 of 2)

Field (*Required) Description

Application(s)
Select zero, one, or more applications that you own to 
display. If no applications are specified, all applications 
you own are displayed.

Health

Select zero, one, or more color-coded indicators of the 
application’s health to display. Only applications that 
have this health are displayed. If no health is specified, 
all applications for which data is available are displayed.

Status
Select a status of the applications to display. Only 
applications that have this status are displayed.

Supported Process

Select a business process supported by the application. 
Only applications that support this business process are 
displayed. If no business process is specified, all 
applications for which data is available are displayed.

Is Orphan?

Select applications that do or do not support a business 
process.

 No - Select applications that support a business 
process

 Yes - Select applications that do not support a 
business process

 Blank - Select all applications

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed

Default: 5

Specify the number of applications displayed in the 
normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of applications displayed in a 
maximized portlet.

Type any integer greater than zero.
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My Survey Requests

The My Survey Requests portlet displays all active survey requests you have 
created. Use this portlet to keep track of the surveys you are conducting.

By default, survey requests are listed alphabetically by name.

Figure B-10. Example My Survey Requests portlet

Edit the preferences and display columns to filter the results that are displayed 
in the portlet.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-9. My Applications portlet filters (page 2 of 2)

Field (*Required) Description

Table B-10. My Survey Requests portlet filters (page 1 of 2)

Field (*Required) Description

Include Closed?

Include or do not include surveys that are not active.

 Yes - Include surveys that are not active

 No - Include active surveys only

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.
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My Transformation Proposals

The My Transformation Proposals portlet displays all active and approved 
transformation proposals that you own. Use this portlet to view your 
transformation proposals that can be developed as projects.

By default, transformation proposals are listed alphabetically by name. 

Figure B-11. Example My Transformations Proposals portlet

Edit the preferences and display columns to filter the results that are displayed 
in the portlet.

*Rows Displayed

Default: 5

Specify the number of surveys displayed in the normal 
portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of surveys displayed in a maximized 
portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-10. My Survey Requests portlet filters (page 2 of 2)

Field (*Required) Description
PPM Dashboard Pages and Portlets 209



Table B-11. My Transformation Proposals portlet filters

Field (*Required) Description

Include Closed?

Include or do not include transformation proposals that 
are completed.

 Yes - Include transformation proposals that are 
closed 

 No - Do not include transformation proposals that are 
closed

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed

Default: 5

Specify the number of transformation proposals 
displayed in the normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of transformation proposals 
displayed in a maximized portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.
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My Workstreams

The My Workstreams portlet displays a list of all workstreams you own, 
review, or have created. Use this portlet to view the workstreams that you 
manage.

By default, workstreams are listed numerically (lowest to highest) by ID.

Figure B-12. Example My Workstreams portlet

Edit the preferences and display columns to filter the results that are displayed 
in the portlet.

Table B-12. My Workstreams portlet filters (page 1 of 2)

Field (*Required) Description

Include Closed?

Include or do not include workstreams that are 
completed.

 Yes - Include workstreams that are closed

 No - Do not include workstreams that are closed

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed

Default: 5

Specify the number of workstreams displayed in the 
normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of workstreams displayed in a 
maximized portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.
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Rating of Transformation Proposals 

The Rating of Transformation Proposals portlet displays the total score, value 
rating, and risk rating by transformation proposal. This portlet can be displayed 
as a clustered bar chart (default), stacked bar chart, or list. Use this portlet to 
view how transformation proposals are ranked based on their total score.

In the clustered bar chart and stacked bar chart, by default, applications are 
listed numerically (highest to lowest) by total score.

Figure B-13. Example Rating of Transformation Proposals portlet

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-12. My Workstreams portlet filters (page 2 of 2)

Field (*Required) Description
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(

Edit the preferences to filter the results that are displayed in the portlet.

Table B-13. Rating of Transformation Proposals 
portlet rating types

Rating Type Description 

Total Score

The difference between the Value Rating and Risk 
Rating with the Score Adjustment applied. 

Total Score = Value Rating – Risk Rating + Score 
Adjustment 

Value Rating

The business value of the transformation proposal. 

By default, the value rating is the sum of non-empty 
individual ratings listed above the Value Rating field 
Value & Risk Assessment section of the transformation 
proposal. 

Value Rating = Internal Rate of Return + Strategic Match 
+ Competitive Advantage + Competitive Response + 
Productivity 

Risk Rating

The risk of the transformation proposal to successfully 
complete. The risk rating is calculated from values 
defined in the Value & Risk Assessment section of the 
transformation proposal. 

By default, the risk rating is the sum of non-empty 
individual ratings for all risks in the Value & Risk 
Assessment section of the transformation proposal.

Risk Rating = Organization Risk + Technical Risk + 
Architecture Risk + Definition Risk + Infrastructure Risk
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TCO Summary

The TCO Summary portlet displays the total cost of ownership by application 
in the portfolio. This portlet can be displayed as a bar chart (default), pie chart, 
or list. Use this portlet to determine the total cost to own and operate an 
application. 

In the bar chart and pie chart, by default, applications are listed numerically 
(highest to lowest) by cost.

Table B-14. Rating of Transformation Proposals portlet preferences

Field Description

Transformation 
Proposals

Select zero, one, or more transformation proposals to 
display the total score, value rating, and risk rating. If no 
transformation proposals are specified, all 
transformation proposals for which data is available are 
displayed.

Business Objective

Select a business objective. Only transformation 
proposals that support this business objective are 
displayed. If no business objective is specified, all 
transformation proposals for which data is available are 
displayed.

Owner

Select a person who has proposed a transformation 
proposal. Only transformation proposals that have been 
proposed by this person are displayed. If no owner is 
specified, all transformation proposals for which data is 
available are displayed.

Executive Sponsor

Select a person who is an executive sponsor. Only 
transformation proposals that have this person listed as 
its executive sponsor are displayed. If no executive 
sponsor is specified, all transformation proposals for 
which data is available are displayed.
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Figure B-14. Example TCO Summary portlet

Edit the preferences to filter the results that are displayed in the portlet.
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Table B-15. TCO Summary portlet preferences

Field Description

Application Set

Select an application set to display in the portlet. The 
portlet displays the cost of ownership by applications in 
the application set. By default, the cost of ownership of 
all applications are displayed.

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.
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C Reports
Reports Overview

HP Application Portfolio Management (HP APM) provides several predefined 
reports that allow you to view the current status of your application portfolio 
data in a Web browser: 

 Entity Coverage Summary Report. Shows a summary of attributes and 
completeness of data entry for an entity.

 Entity Detail Report. Shows selected information about one or more 
entities. Use the filters to display only the entities and fields you want to 
view in the report. By default, the report includes non-empty header and 
detail information, notes, status, and references for each entity.

 Survey Results Report. Shows survey results from survey requests.

This appendix provides descriptions of the fields in each of the HP APM 
reports. 

For instructions for running and managing reports, see the Reports Guide and 
Reference. 

View the HP APM reports from the Open > Application Portfolio > Reports menu.
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Entity Coverage Summary Report

The Entity Coverage Summary report provides a summary of attributes and 
completeness of data entry provided for an entity.

Report Parameters

Use the filter fields in the Report Parameters section to define the results of 
your report. You can choose to display a report for a selected entity type or for 
an application set. The threshold filters color-code how often a field is 
completed by the data coverage percentage (for example, for applications, the 
Version field may be completed 80% of the time). Use the color coding to 
visually distinguish the acceptable, borderline, and unacceptable completeness 
of data coverage.

Table C-1. Entity Coverage Summary report filter fields (page 1 of 2)

Filter Field 
(*Required) Description

*Entity Type

Select the type of entity for which to generate a report. If you want to 
limit the report to applications in a specific application set, select 
Application and enter the name of the application set in the 
Application Set field.

Application 
Set

Enter the name of the application set for which to generate a report. 
This field is available only when you select Application as the Entity 
Type.
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Analyzing the Entity Coverage Summary Report

The Entity Coverage Summary report provides a snapshot of the completeness 
of information provided for an entity. It shows the fields in the selected entity 
type, the number of times the fields were completed (Count), the percentage of 
times the field was filled in, and, when field data is measurable, the lowest 
value, highest value, and the average value for the field.

Use the Entity Coverage Summary report to:

 Determine if enough data is provided for the entity. At the bottom of the 
report, the grand total summarizes the total number of fields and the 
percentage of fields that were filled in.

 Determine the information that is provided most often for the entity. Where 
information is lacking, you could send an email to the entity owner asking 
the owner to provide more data.

 Determine threshold values for fields where statistical information is 
available.

*High 
Threshold

Default: 80%. Denotes the fields that have the most complete data 
coverage. That is, the percentage of data entered for this field is at or 
above the threshold. In addition to displaying the percentage 
completed, the cell is color-coded in green.

*Medium 
Threshold

Default: 50%. Denotes the fields that have fairly complete data 
coverage. That is, the percentage of data entered for this field is at or 
above the threshold but below the high threshold. In addition to 
displaying the percentage completed, the cell is color-coded in 
yellow.

*Low 
Threshold

Default: 0%. Denotes the fields that have the least complete data 
coverage. That is, the percentage of data entered for this field is at or 
above the threshold but below the medium threshold. In addition to 
displaying the percentage completed, the cell is color-coded in red.

Table C-1. Entity Coverage Summary report filter fields (page 2 of 2)

Filter Field 
(*Required) Description
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Entity Detail Report

The Entity Detail report provides selected information about one or more 
entities. Use the filters to display only the entities and fields you want to view 
in the report. By default, the report includes non-empty header and detail 
information, notes, status, and references for each entity.

Report Parameters

Use the filter fields in the Report Parameters section to define the results of 
your report.

Table C-2. Entity Detail report filter fields (page 1 of 4)

Filter Field 
(*Required) Description

*Entity Request Type
Select the type of entity for which you want to run the report. 
The entity type determines the selectable values in certain 
filter fields.

*Include Closed 
Requests

Select Yes to include entities whose status is Closed. 
Select No to exclude entities whose status is Closed. Only 
survey and workstream entities can have the status of 
Closed.

Entity Numbers

Select zero, one, or more entity numbers for which you want 
to create a report. All entities with the selected number(s) 
are included in the report. Leave this field blank if you want 
to display all entities of the selected type.

Status

Select zero, one, or more statuses for which you want to 
create a report. All entities of the selected status(es) are 
included in the report. Leave this field blank if you do not 
want to filter by status. Status selections are determined by 
the entity type you selected in the Entity Request Type field.

Owner

Select zero, one, or more owners for which you want to 
create a report. All entities owned by the named persons 
are included in the report. Leave this field blank if you do not 
want to filter by entity owner.
220 Appendix C



Created By

Select zero, one, or more creators for which you want to 
create a report. All entities created by the named persons 
are included in the report. Leave this field blank if you do not 
want to filter by an entity’s creator.

Creation Date From

Select a date after which the creation of the entity falls. All 
entities created after the selected date are included in the 
report. Leave this field blank if you do not want to filter by 
creation date.

Creation Date To

Select a date before which the creation of the entity falls. All 
entities created before the selected date are included in the 
report. Leave this field blank if you do not want to filter by 
creation date.

Last Update Date 
From

Select a date after which the last modification of the entity 
falls. All entities modified after the selected date are 
included in the report. Leave this field blank if you do not 
want to filter by modification date.

Last Update Date To

Select a date before which the last modification of the entity 
falls. All entities modified before the selected date are 
included in the report. Leave this field blank if you do not 
want to filter by modification date.

Description Contains

Enter alphanumeric words or phrases that are part of the 
entity’s description. All entities that include the word or 
phrase in the description are included in the report. Leave 
this field blank if you do not want to filter by description.

Field Prompt 1–4

Select an attribute of the entity type on which to filter. The 
value of the attribute is determined by the Field Value field. 
Leave this field blank if you do not want to filter by a specific 
entity attribute. Field attribute selections are determined by 
the entity type you selected in the Entity Request Type field. 
Up to four field prompts may be specified.

Field Value 1–4

Enter a value for the attribute of the entity type on which to 
filter. The attribute is determined by the Field Prompt field. 
Leave this field blank if you do not want to filter by a specific 
entity attribute. 

Table C-2. Entity Detail report filter fields (page 2 of 4)

Filter Field 
(*Required) Description
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Report Title Enter a name for this report.

*Order By
Order of the results within the report. Results are ordered by 
request number (entity number). This field cannot be 
modified. 

*Show Header Fields
Select Yes to include all information in an entity’s Header 
section in the report. Select No to exclude information from 
an entity’s Header section from the report. 

*Show Detail Fields
Select Yes to include all information from an entity’s Details 
section in the report. Select No to exclude information from 
an entity’s Details section from the report.

*Hide Prompts for 
Empty Fields

Select Yes to exclude attribute fields with no values from 
the report. Select No to include attribute fields with no 
values in the report.

*Show Contents of 
Table Fields

Select Yes to include all information from an entity’s table 
fields in the report. Select No to exclude information from an 
entity’s table fields from the report.

*Show Field Audit 
History

Select Yes to include all information from an entity’s audit 
history in the report. Select No to exclude information from 
an entity’s audit history from the report.

*Show Notes
Select Yes to include all information from an entity’s Notes 
section in the report. Select No to exclude information from 
an entity’s Notes section from the report.

Table C-2. Entity Detail report filter fields (page 3 of 4)

Filter Field 
(*Required) Description
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Analyzing the Entity Detail Report

The Entity Detail report provides a snapshot of selected information for the 
selected entity type. It shows selected sections of information and selected 
fields (up to four) for a filtered set of the selected entity type.

Use the Entity Detail report to:

 Track information between the same type of entities. For example, you 
could create a report for an application set that displays the owners of each 
application.

 Compare information between entities of the same type.

 Create a list of entities with similar attributes.

 Keep a log of selected information.

*Filter Notes

Select the types of notes to include in the report, if notes are 
included in the report.

 Show all notes - Include all notes entered by 
administrators, analysts, and users.

 Show only user notes - Include notes only entered by 
users.

*Show Status
Select Yes to include all information from an entity’s Status 
section in the report. Select No to exclude information from 
an entity’s Status section from the report.

*Show References

Select Yes to include all information from an entity’s 
References section in the report. Select No to exclude 
information from an entity’s Reference section from the 
report.

Table C-2. Entity Detail report filter fields (page 4 of 4)

Filter Field 
(*Required) Description
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Survey Results Report

The Survey Results report shows the results from a specified survey request.

Report Parameters

Use the filter fields in the Report Parameters section to define the results of the 
report. The threshold filters color-code the number of responses by the 
response rate percentage. Use the color coding to visually distinguish the 
acceptable, borderline, and unacceptable quantity of responses.

Table C-3. Survey Results report filter fields

Filter Field 
(*Required) Description

*Survey Request Select the survey for which to generate the report.

Applications
Select one or more applications that are part of the selected 
survey on which to report. If you want to view a report for all 
applications in the survey, leave this field blank.

High Threshold

Default: 80%. Denotes the fields that have the most complete 
data coverage. That is, the percentage of data entered for this 
field is at or above the threshold. In addition to displaying the 
percentage completed, the cell is color-coded in green.

Medium Threshold

Default: 50%. Denotes the fields that have fairly complete data 
coverage. That is, the percentage of data entered for this field 
is at or above the threshold but below the high threshold. In 
addition to displaying the percentage completed, the cell is 
color-coded in yellow.

Low Threshold

Default: 0%. Denotes the fields that have the least complete 
data coverage. That is, the percentage of data entered for this 
field is at or above the threshold but below the medium 
threshold. In addition to displaying the percentage completed, 
the cell is color-coded in red.

Show Blanks in 
Distribution?

Distribution shows the number of responses in a given rating 
category. If Yes is selected, the distribution includes the 
number of non-responses. If No is selected, only the 
distribution of actual responses is shown.
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Analyzing the Survey Results Report

When you send out a survey, you ask the respondents to rate specific areas of 
one or more applications. The Survey Results report is a snapshot of the 
current responses to the survey.

The Survey Results report shows the areas that were rated, the number of 
responses for the areas, the percentage of responses for the areas, and the 
distribution of the responses among the ratings. If you selected Yes for the 
Show Blanks in Distribution? field, the number of non-responses are included 
in the distribution.

Use the Survey Results report to:

 Determine the overall response rate to the survey. At the bottom of the 
report is a summary of the total number of responses and percentage of 
completed responses. If you have enough responses, you may choose to 
close the survey.

 Determine if you are satisfied with the number of responses you have 
received for any given area by looking at the number of responses, number 
of non-responses, and the response rate percentage. If the number of 
responses is low for a specific area, you may choose to send an email to the 
respondents asking them for more information in the specific area.

 Analyze the current ratings for a given area. You can see what areas of the 
application your respondents liked or disliked the most. You can determine 
the strengths and weaknesses of the application based on the responses.
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Index
Symbols
# of Annual Changes field, 141

# of Annual Incidents field, 144

A
Acronym field, 132

Active Users field, 145

Activities group, described, 17

Actual Duration field, 184

Actual Effort field, 184

Actual Finish Date field, 183

Actual Start Date field, 183

Additional Columns Displayed in Maximized 
View field
Application to Process Coverage portlet, 

201
List of Applications (Analyst) portlet, 206
My Applications portlet, 208
My Survey Requests portlet, 209
My Transformation Proposals portlet, 210
My Workstreams portlet, 212

Address field, 163

Address section in location entity, 163

administering entities, 24

administrator role, described, 12

Alias field, 132

analyst role, described, 13

analyzing
Entity Coverage Summary report, 219
Entity Detail report, 223
Survey Results report, 225

application analysis, overview, 97

application entity
See also applications.
# of Annual Changes, 141
# of Annual Incidents, 144
Acronym, 132
Active Users, 145
Alias, 132
Application Health, 143
Application No., 131
Application Score, 157
Architecture, 139
Architecture Risk, 155
Availability, 150
Benefits Manager, 135
Budget & Resources section, 141
Budget Manager, 135
Business Continuity Risk, 156
Business Criticality, 153
Business Environment section, 136
Business Owner, 135
Change Frequency, 148
Class, 133
Competitive Advantage, 154
Complexity, 148
Compliance Risk, 156
Contact, 135
Contacts section, 134
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Created By, 134
Created On, 134
Customer Visibility, 154
Data Consistency, 151
Data Integrity, 152
Data Redundancy, 152
Data Score, 158
Databases, 139
described, 130
Direct Annual Revenue, 142
Disaster Recovery Plan in Place, 144
Disposition, 140
Disposition Complete Date, 140
Disposition Status, 140
Documentation, 149
Downstream Applications, 139
End User Type, 145
Expected End of Life Date, 143
Expense Reduction, 154
Financial Summary, 142
Flexibility, 149
Frequency of Execution, 145
Functional Completeness, 149
Health, 143
identifying need for information, 93
Identity section, 131
Importance, 133
Indirect Annual Revenue, 142
Interface Complexity, 149
ITO Contact, 135
Local ID, 132
Location, 133, 145
Maintainability, 148
Manual Workarounds Available, 154
Meets SLAs, 151
Name, 132
Nominal Return, 142
opening, 90
Operational Stability, 147
Owning Organization, 137
Performance, 150
Placed in Service Date, 143
Product Name, 143
Programming Technologies, 139
Purpose, 133

Rating section, 146
Regulatory Requirement, 137
Relative Cost, 147
Relative Size, 147
requesting additional information, 96
requesting more information, 93
Resource Count, 142
Respondent, 136
Respondent Note, 136
Revenue Impact, 153
Risk Rating, 158
ROI, 142
Scalability, 150
Score Adjustment, 159
Score section, 157
Security Classification, 138
Security Risk, 155
Servers, 139
Service & Support section, 143
Service Level Agreement, 144
shortcut to create, 14
Size, 141
Size of User Base, 151
Sizing Method, 140
Skills Risk, 156
SMEs, 136
Status, 132
Support Type, 144
Supported Processes, 137
Technical Environment section, 138
Technical Owner, 135
Technology Risk, 155
Title, 131
Total Cost of Ownership, 142
Total Score, 159
Total Users, 145
Type, 133
Under Maintenance, 143
Unit of Measurement, 141
Upstream Applications, 139
Usage & Scale section, 144
User Location, 145
Value Rating, 158
Vendor Competition, 153
Vendor Financial Health, 152
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Vendor Name, 143
Vendor Product Plans, 153
Vendor Score, 158
Version, 132

Application field
Application Value Assessment portlet, 202
List of Applications (Analyst) portlet, 204

Application Health Breakdown by Owner 
portlet, 195

Application Health Breakdown portlet
Application Set field, 198
described, 197

Application Health Breakdown portlet, Display 
preferences summary on portlet field, 198

Application Health field, 143

Application List portlet, 195

Application No. field, 131

application portfolio
business objective, 22
entities, 21
guidelines for building, 15
organization unit, 22

Application Portfolio Size over Time portlet, 
193

Application Portfolio Size portlet
Application Set field, 199
described, 198
Display preferences summary on portlet 

field, 199
Period Finish field, 199
Period Start field, 199
Period Type field, 199

Application Score field, 157

application set entity
Created By, 160
Created On, 160
creating, 93
described, 159
Description, 160
Scope section, 161
Set Name, 160, 161

Set No., 160
Status, 160
Summary section, 159

Application Set field
Application Health Breakdown portlet, 198
Application Portfolio Size portlet, 199
Application to Process Coverage portlet, 

200
Application Value Assessment portlet, 202
Entity Coverage Summary report, 218
List of Applications (Analyst) portlet, 204
TCO Summary portlet, 216
Workstream entity, 185

application sets
color-coded hierarchical view in dynamic 

graphing, 117
creating with dynamic graphing, 106
hierarchical view by size in dynamic 

graphing, 118
hierarchical view in dynamic graphing, 

114, 116
opening in dynamic graphing, 103
overview, 98
saving in dynamic graphing, 121
viewing application relationships, 102

Application to Process Coverage portlet
Additional Columns Displayed in 

Maximized View field, 201
Application Set field, 200
Applications field, 200
Ascending/Descending field, 200
Available Columns field, 201
Business Processes field, 200
described, 199
Displayed Columns field, 201
Rows Displayed field, 201
Rows Displayed in Maximized View field, 

201
Sort By field, 200

Application to Process Coverage Summary 
portlet, 195

Application Transformation Proposal Ratings 
portlet, 193
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Application Value Assessment portlet
Application field, 202
Application Set field, 202
Business Owner field, 202
Contact field, 202
described, 193, 201
Display preferences summary on portlet 

field, 203
Health field, 203
Is Orphan field, 203
Process field, 203
Status field, 202

Application(s) field
My Applications portlet, 207
workstream entity, 185

applications
See also application entity.
dependent on processes, 108
dependent processes, 104
downstream, 104
filtering in dynamic graphing, 111
number of processes supported, 104
number supporting processes, 108
upstream, 104
viewing dependencies, 104
viewing in dynamic graphing, 110
viewing process-supported, 109
viewing relationships, 102

Applications Dashboard page, 193

Applications field
Application to Process Coverage portlet, 

200
Survey Results report, 224

Applications Not Mapped to Process portlet, 
190

Applications portlet, 190

Architecture field, 139

Architecture Risk field, 155, 179

Ascending/Descending field
Application to Process Coverage portlet, 

200
List of Applications (Analyst) portlet, 205

My Applications portlet, 207
My Survey Requests portlet, 208
My Transformation Proposals portlet, 210
My Workstreams portlet, 211

Asset Class field, 174

Associated Applications field, 174

Availability field, 150

Available Columns field
Application to Process Coverage portlet, 

201
List of Applications (Analyst) portlet, 206
My Applications portlet, 208
My Survey Requests portlet, 209
My Transformation Proposals portlet, 210
My Workstreams portlet, 211

B
Benefits Manager field, 135, 175

Browse Entities page, accessing, 123

Budget & Resources section, application entity, 
141

Budget Manager field, 135, 175

Business Case Details section, transformation 
proposal entity, 175

Business Case Doc attachment, transformation 
proposal entity, 175

Business Continuity Risk, 156

Business Criticality field, 153

Business Environment section, application 
entity, 136

Business Objective field
Rating of Transformation Proposals portlet, 

214
transformation proposal entity, 174

business objectives
as part of application portfolio, 15
described, 22
requirement for creating, 16
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Business Owner field
application entity, 135
Application Value Assessment portlet, 202
List of Applications (Analyst) portlet, 204

Business Processes field, Application to 
Process Coverage portlet, 200

business survey, 86

C
cache, clearing for Data Migrator reinstallation, 

83

cancelling
download in Data Migrator, 64
import in Data Migrator, 64
updates in Data Migrator, 64

Change Frequency field, 148

City field, 163

Class field, 133

color percentiles in dynamic graphing, 115

color-coding in dynamic graphing
by application score values, 116
described, 115

command, mage, 83

Competitive Advantage field, 154, 177

Competitive Response field, 178

Complexity field, 148

Compliance Requirements field, 166

Compliance Risk field, 156

Compliance section, process entity, 166

Compliant field, 166

components, described, 14

concurrency in editing entities, 26

conducting surveys, 85

configurable portlets
described, 99
listed, 196

connecting Data Migrator to PPM Server, 32

Contact field
application entity, 135
Application Value Assessment portlet, 202
List of Applications (Analyst) portlet, 204

Contacts section, application entity, 134

Country field, 163

Create New Entity page, 18

Create New Request page, 18

Created By field, 134, 160, 162, 165, 168, 169, 
173, 183, 221

Created By field, providing data, 65

Created On field, 134, 160, 162, 165, 168, 169, 
173, 183

Created On field, providing data, 65

creating entities
application set, 93
by migrating data, 65
cancelling in Data Migrator download, 64
survey registration, 86
with HP APM, 24

creating surveys, 86

Creation Date From field, 221

Creation Date To field, 221

custom spreadsheets, creating for Data 
Migrator, 40

Customer Visibility field, 154

D
Dashboard pages

analyst, 188
Applications, 193
described, 98
Front Page, 189
HP-supplied, 98
overview, 187
Portfolio View, 191
private, 98
shared, 98, 188

Dashboard, described, 98
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data collection, overview, 85

Data Consistency field, 151

Data Integrity field, 152

Data Migrator
accessing entity options, 41
accessing validation options, 69
cancelling downloads, 64
cancelling imports, 64
cancelling updates, 64
configuring connection to PPM Server, 32
creating custom spreadsheets, 40
creating entities by migrating data, 65
creating entities, instructions, 44
creating entities, overview, 44
creating import spreadsheet, overview, 34
creating spreadsheet template, 37
creating spreadsheets from template, 35
creating spreadsheets manually, 40
deleting imported data, 44
dependencies, import order, 44
Detail Log icons, described, 66
Detail Log, fixing errors, 67
Detail Log, viewing, 66
downloading entity data, instructions, 58
downloading entity data, overview, 44
downloading validation values, 

instructions, 71
downloading validation values, 

overview, 68
error messages, saving to spreadsheet, 66
identifier requirement, 39, 40
import spreadsheet, creating, 34
importing entities, 44
importing entity updates, 52
importing validation values, 68, 73
installing, 31
mapping tools, 78
mapping, exporting, 79
mapping, importing, 79
mapping, viewing, 78
Migrate Records option, 65
migrating entity data, 65
opening, for entity tasks, 41
opening, for validation tasks, 69

overview, 29
prerequisites, 30
providing data for Created By field, 65
providing data for Created On field, 65
reinstalling, clearing cache, 83
reinstalling, instructions, 82
reinstalling, overview, 82
REQ.REQUEST_ID token column, 39
request number mapping, 47
request number requirement, 39, 40
requirement for identifier, 39, 40
requirement for request numbers, 40
requirements for prerequisites, 30
requirements for request numbers, 39
spreadsheet creation guidelines, 40
starting for validation tasks, 69
starting, for entity tasks, 41
template, described, 35
template, preparing for import, 39
tokens, described, 40
troubleshooting errors, 66
uninstalling, 82
updating entity data, 52
updating entity data, overview, 44
updating validation values, 68, 73
validation values, downloading, 68, 71
validation values, updating, 68, 73

Data Migrator wizard
opening for entity tasks, 41
opening for validation tasks, 69

Data Redundancy field, 152

Data Score field, 158

Databases field, 139

Definition Risk field, 180

Delegate field, List of Applications (Analyst) 
portlet, 205

Description Contains field, 221

Description field, 160, 162, 165, 167, 173

Detail Log
fixing errors, 67
icons, described, 66
viewing, 66
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Details section, survey registration entity, 170

Details table, dynamic graphing, 110

Direct Annual Revenue field, 142

Disaster Recovery Plan in Place field, 144

display options, dynamic graphing, 115

Display preferences summary on portlet field
Application Portfolio Size portlet, 199
Application Value Assessment portlet, 203
List of Applications (Analyst) portlet, 205
My Applications portlet, 207
TCO Summary portlet, 216

Display references summary on portlet field
Application Health Breakdown portlet, 198

Displayed Columns field
Application to Process Coverage 

portlet, 201
List of Applications (Analyst) portlet, 206
My Applications portlet, 208
My Survey Requests portlet, 209
My Transformation Proposals portlet, 210
My Workstreams portlet, 212

Disposition Complete Date field, 140

Disposition field, 140

Disposition Status field, 140

documentation
guidelines for using, 17
related PPM Center, 19

Documentation field, 149

downloading
entity data, 58
spreadsheet for Data Migrator, 34
validation values, 68, 71

downloads, cancelling in Data Migrator, 64

downstream application, described, 139

Downstream Applications field, 139

dynamic graphing
about, 100
application dependencies, 104

application sets, color-coded hierarchical 
view, 117

application sets, creating, 106
application sets, hierarchical view, 114, 

116
application sets, hierarchical view, adjusted 

by size, 118
application-supported process quantity, 

104
changing layout, 120
circular layout, 119
color percentiles, 115
color-coding, 115, 116
creating application sets, 106
Details table, 110
display options, 115
downstream applications, 104
filtering applications, 111
filtering processes, 111
filtering with operators, 112
filtering with wildcards, 112
hierarchical layout, 119
installing, 100
layout options, 119
Microsoft Silverlight add-on 

installation, 100
opening, 101
opening application sets, 103
opening processes, 107
operators for filtering, 112
organic layout, 120
orthogonal layout, 120
process relationships, 107
process-supported application 

quantity, 108
process-supported applications, 109
rounded rectangles, blue, 103
rounded rectangles, green, 108
rounded rectangles, size of green, 108
rounded rectangles, sizes, 104
rounded rectangles, teal green, 106
saving application sets, 121
saving images, 122
Silverlight Plug-In installation, 100
sizing, 116, 117
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transforming a graph, 109
upstream applications, 104
viewing application details, 110
viewing application relationships, 102
viewing applications supporting 

processes, 109
viewing process details, 110
viewing process relationships, 107
visual options, 115
wildcards for filtering, 112
zooming in and out of graphs, 102

E
editing

entities, 26
entities concurrently, 26
multiple requests using quick edits, 26

edits, performed by two users 
simultaneously, 26

End User Type field, 145

entities
administering, 24
application set, described, 159
application, described, 130
concurrency, 26
creating by migrating data, 65
creating in HP APM, 24
creating with Data Migrator, 44
described, 17
downloading with Data Migrator, 58
editing, 26
editing simultaneously, 26
edits performed by two users 

simultaneously, 26
grouping, 122
groups, described, 17
importing with Data Migrator, 44
listed by name, 21
location, described, 161
managing, 24
monitoring, 26
opening, 25, 90
overview, 21, 129

process, described, 164
relationships with each other, 23
searching, 25
server, described, 167
shortcut to search, 15
simultaneous editing, 26
survey registration, described, 168
transformation proposal, described, 171
updating, 26
updating with Data Migrator, 52
workstream, described, 181

Entities group, described, 17

Entity Coverage Summary report
analyzing, 219
Application Set field, 218
described, 218
Entity Type field, 218
High Threshold field, 219
Low Threshold field, 219
Medium Threshold field, 219

entity data
downloading with Data Migrator, 58
importing with Data Migrator, 44
updating with Data Migrator, 52

Entity Detail report
analyzing, 223
Created By field, 221
Creation Date From field, 221
Creation Date To field, 221
described, 220
Description Contains field, 221
Entity Numbers field, 220
Entity Request Type field, 220
Field Prompt field, 221
Field Value field, 221
Filter Notes field, 223
Hide Prompts for Empty Fields field, 222
Include Closed Requests field, 220
Last Update Date From field, 221
Last Update Date To field, 221
Order By field, 222
Owner field, 220
Report Title field, 222
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Show Contents of Table Fields field, 222
Show Detail Fields field, 222
Show Field Audit History field, 222
Show Header Fields field, 222
Show Notes field, 222
Show References field, 223
Show Status field, 223
Status field, 220

entity groups
creating with Request Browser, 122
described, 122
example of displaying with Request 

Browser, 123
saving, 126
viewing saved, 127

Entity Numbers field, 220

entity relationships, 23

Entity Request Type field, 220

Entity Type field, 218

errors
fixing from Detail Log, 67
troubleshooting in Data Migrator, 66

Executive Sponsor field
Rating of Transformation Proposals 

portlet, 214
transformation proposal entity, 174

Expected End of Life Date field, 143

Expected Finish Period field, 174

Expected Start Period field, 174

Expense Reduction field, 154

F
Field Prompt field, 221

Field Value field, 221

fields
# of Annual Changes, 141
# of Annual Incidents, 144
Acronym, 132
Active Users, 145
Actual Duration, 184

Actual Effort, 184
Actual Finish Date, 183
Actual Start Date, 183
Additional Columns Displayed in 

Maximized View, 201, 206, 208, 209, 
210, 212

Address, 163
Alias, 132
Application, 202, 204
Application Health, 143
Application No., 131
Application Score, 157
Application Set, 185, 198, 199, 200, 202, 

204, 216, 218
Application(s), 185, 207
Applications, 200, 224
Architecture, 139
Architecture Risk, 155, 179
Ascending/Descending, 200, 205, 207, 

208, 210, 211
Asset Class, 174
Associated Applications, 174
Availability, 150
Available Columns, 201, 206, 208, 209, 

210, 211
Benefits Manager, 135, 175
Budget Manager, 135, 175
Business Continuity Risk, 156
Business Criticality, 153
Business Objective, 174, 214
Business Owner, 135, 202, 204
Business Processes, 200
Change Frequency, 148
City, 163
Class, 133
Competitive Advantage, 154, 177
Competitive Response, 178
Complexity, 148
Compliance Requirements, 166
Compliance Risk, 156
Compliant, 166
Contact, 135, 202, 204
Country, 163
Created By, 134, 160, 162, 165, 168, 169, 

173, 183, 221
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Created On, 134, 160, 162, 165, 168, 169, 
173, 183

Creating Date From, 221
Creation Date To, 221
Customer Visibility, 154
Data Consistency, 151
Data Integrity, 152
Data Redundancy, 152
Data Score, 158
Databases, 139
Definition Risk, 180
Delegate, 205
Description, 160, 162, 165, 167, 173, 182
Description Contains, 221
Direct Annual Revenue, 142
Disaster Recovery Plan in Place, 144
Display preferences summary on portlet, 

199, 203, 205, 207, 216
Display preferences summary, on 

portlet, 198
Displayed Columns, 201, 206, 208, 209, 

210, 212
Disposition, 140
Disposition Complete Date, 140
Disposition Status, 140
Documentation, 149
Downstream Applications, 139
End User Type, 145
Entity Numbers, 220
Entity Request Type, 220
Entity Type, 218
Executive Sponsor, 174, 214
Expected End of Life Date, 143
Expected Finish Period, 174
Expected Start Period, 174
Expense Reduction, 154
Field Prompt, 221
Field Value, 221
Filter Notes, 223
Flexibility, 149
Frequency of Execution, 145
Functional Completeness, 149
Health, 143, 203, 205, 207
hide Prompts for Empty Fields, 222
High Threshold, 219, 224

Importance, 133
Include Closed, 208, 210, 211
Include Closed Requests, 220
Indirect Annual Revenue, 142
Infrastructure Risk, 180
Interface Complexity, 149
Internal Rate of Return, 177
IP Address, 168
Is Orphan, 203, 205, 207
IT Sponsor, 174
ITO Contact, 135
Last Update Date From, 221
Last Update Date To, 221
Latitude, 163
Local ID, 132
Location, 133, 145, 168
Location Name, 162
Location No., 162
Longitude, 163
Low Threshold, 219, 224
Maintainability, 148
Manual Workarounds Available, 154
Medium Threshold, 219, 224
Meets SLAs, 151
Name, 132, 162, 165, 167, 169, 182
Nominal Return, 142, 176
Operational Stability, 147
Order By, 222
Organization Risk, 179
OS, 168
Owner, 162, 165, 173, 182, 214, 220
Owning Organization, 137
Parent Location, 162
Parent Process, 165
Performance, 150
Period Finish, 199
Period Start, 199
Period Type, 199
Placed in Service Date, 143
Postal Code, 163
Priority, 182
Process, 203, 205
Process Name, 165
Process No., 164
Process Type, 165
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Process(es), 185
Product Name, 143
Productivity, 178
Programming Technologies, 139
Project Class, 174
Proposal Dependencies, 173
Proposal Name, 173
Proposal No., 172
Purpose, 133
Region, 163
Regulatory Requirement, 137
Relative Cost, 147
Relative Size, 147
Report Title, 222
Request No., 169
Resource Count, 142
Resource(s), 184
Respondent, 136
Respondent Note, 136
Revenue Impact, 153
Reviewer, 183
Risk Rating, 158, 180
ROI, 142
Rows Displayed, 201, 205, 207, 209, 210, 

211
Rows Displayed in Maximized View, 201, 

205, 207, 209, 210, 211
Running Software, 168
Scalability, 150
Scheduled Duration, 183
Scheduled Effort, 184
Scheduled Finish Date, 183
Scheduled Start Date, 183
Score Adjustment, 159, 180
Security Classification, 138
Security Risk, 155
Server Name, 167
Server No., 167
Servers, 139
Service Level Agreement, 144
Set Name, 160, 161
Set No., 160
Show Blanks in Distribution, 224
Show Contents of Table Fields, 222
Show Detail Fields, 222

Show Field Audit History, 222
Show Header Fields, 222
Show Notes, 222
Show References, 223
Show Status, 223
Size, 141
Size of User Base, 151
Sizing Method, 140
Skills Risk, 156
SMEs, 136
Sort By, 200, 205, 207, 208, 210, 211
State/Province, 163
Status, 132, 160, 162, 164, 167, 169, 172, 

182, 202, 205, 207, 220
Strategic Match, 177
Support Type, 144
Supported Process, 207
Supported Processes, 137
Survey Name, 169
Survey Request, 224
Survey Template, 170
Target Completion Date, 170
Technical Owner, 135
Technical Risk, 179
Technology Risk, 155
Title, 131, 172
Total Cost of Ownership, 142
Total Score, 159, 180
Total Users, 145
Transformation Proposals, 214
Type, 133, 168
Under Maintenance, 143
Unit of Measurement, 141
Upstream Applications, 139
User Location, 145
Value Rating, 158, 178
Vendor Competition, 153
Vendor Financial Health, 152
Vendor Name, 143
Vendor Product Plans, 153
Vendor Score, 158
Vendors Involved, 174
Version, 132
Workstream No., 182
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Filter Notes field, 223

filtering
applications in dynamic graphing, 111
processes in dynamic graphing, 111

Financial Summary link
application entity, 142
transformation proposal entity, 176

Flexibility field, 149

Frequency of Execution field, 145

Front Page Dashboard page, 189

G
general survey, 86

Group Entities option, 122

grouping entities with Request Browser, 122

Grouping group, described, 17

groups, entity, 122

H
Health field

application entity, 143
Application Value Assessment portlet, 203
List of Applications (Analyst) portlet, 205
My Applications portlet, 207

help, accessing, 19

Hide Prompts for Empty Fields field, 222

High Threshold field, 219, 224

HP APM
components for analysts, described, 14
described, 11
features for analysts, described, 14
users, described, 12

HP-supplied Dashboard pages, described, 98

HP-supplied portlets, described, 188

I
identifier, requirement in Data Migrator, 39, 40

Identity section, application entity, 131

import spreadsheet
guidelines for creating, 40
overview, 34

Importance field, 133

Include Closed field
My Survey Requests portlet, 208
My Transformation Proposals portlet, 210
My Workstreams portlet, 211

Include Closed Requests field, 220

Indirect Annual Revenue field, 142

Infrastructure Risk field, 180

installing
Data Migrator, 31
dynamic graphing, 100
Microsoft Silverlight add-on, 100
Silverlight Plug-In, 100

Interface Complexity field, 149

Internal Rate of Return field, 177

IP Address field, 168

Is Orphan field
Application Value Assessment portlet, 203
List of Applications (Analyst) portlet, 205
My Applications portlet, 207

IT Sponsor field, 174

ITO Contact field, 135

L
Last Update Date From field, 221

Last Update Date To field, 221

Latitude field, 163

layout options, dynamic graphing, 119
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List of Applications & Respondents table
described, 171
icons described, 87
table component, 36

List of Applications (Analyst) portlet
Additional Columns Displayed in 

Maximized View field, 206
Application field, 204
Application Set field, 204
Ascending/Descending field, 205
Available Columns field, 206
Business Owner field, 204
Contact field, 204
Delegate field, 205
described, 203
Display preferences summary on portlet 

field, 205
Displayed Columns field, 206
Health field, 205
Is Orphan field, 205
Process field, 205
Rows Displayed field, 205
Rows Displayed in Maximized View field, 

205
Sort By field, 205
Status field, 205

List of Surveys table, 171

Local ID field, 132

location entity
Address, 163
Address section, 163
City, 163
Country, 163
Created By, 162
Created On, 162
described, 161
Description, 162
Latitude, 163
Location Name, 162
Location No., 162
Longitude, 163
Name, 162
Owner, 162

Parent Location, 162
Postal Code, 163
Region, 163
State/Province, 163
Status, 162
Summary section, 162

Location field, 133, 145, 168

Location Name field, 162

Location No. field, 162

Longitude field, 163

Low Threshold field, 219, 224

M
mage command, 83

Maintainability field, 148

managing entities, 24

Manual Workarounds Available field, 154

mapping of spreadsheets
exporting, 79
importing, 79
viewing, 78
with Data Migrator tools, 78

mapping tools, Data Migrator, 78

Medium Threshold field, 219, 224

Meets SLAs field, 151

menu bar
options for analysts, 14
shortcuts to create entities, 14
submenu differences in PPM Center, 18

Microsoft Silverlight add-on, installing, 100

Migrate Records option, 65

migrating entity data, 65

monitoring entities, 26

My Applications portlet
Additional Columns Displayed in 

Maximized View field, 208
Application(s) field, 207
Ascending/Descending field, 207
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Available Columns field, 208
described, 206
Display preferences summary on portlet 

field, 207
Displayed Columns field, 208
Health field, 207
Is Orphan field, 207
Rows Displayed field, 207
Rows Displayed in Maximized View 

field, 207
Sort By field, 207
Status field, 207
Supported Process field, 207

My Survey Requests portlet
Additional Columns Displayed in 

Maximized View field, 209
Ascending/Descending field, 208
Available Columns field, 209
described (configurable portlet), 208
described (shared portlet), 190
Displayed Columns field, 209
Include Closed field, 208
Rows Displayed field, 209
Rows Displayed in Maximized View 

field, 209
Sort By field, 208

My Transformation Proposals portlet
Additional Columns Displayed in 

Maximized View field, 210
Ascending/Descending field, 210
Available Columns field, 210
described (configurable portlet), 209
described (shared portlet), 190
Displayed Columns field, 210
Include Closed field, 210
Rows Displayed field, 210
Rows Displayed in Maximized View 

field, 210
Sort By field, 210

My Workstreams portlet
Additional Columns Displayed in 

Maximized View field, 212
Ascending/Descending field, 211
Available Columns field, 211

described (configurable portlet), 211
described (shared portlet), 190
Displayed Columns field, 212
Include Closed field, 211
Rows Displayed field, 211
Rows Displayed in Maximized View 

field, 211
Sort By field, 211

N
Name field, 132, 162, 165, 167, 169, 182

Nominal Return field, 142, 176

Notes section, 129

O
online help, accessing, 19

opening
application sets in dynamic graphing, 103
dynamic graphing, 101
entities, 25, 90
processes in dynamic graphing, 107
survey registration entities, 90

Operational Stability field, 147

operators for dynamic graphing, 112

Order By field, 222

Organization Risk field, 179

organization units
creating, 137
described, 22
requirement for creating, 16

OS field, 168

Owner field, 162, 165, 173, 182, 214, 220

Owning Organization field, application 
entity, 137

P
Parent Location field, 162

Parent Process field, 165
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Performance field, 150

Period Finish field, 199

Period Start field, 199

Period Type field, 199

Placed in Service Date field, 143

Portfolio View Dashboard page, 191

portlets
Application Health Breakdown, 197
Application Health Breakdown by Owner, 

195
Application List, 195
Application Portfolio Size, 198
Application Portfolio Size over Time, 193
Application to Process Coverage, 199
Application to Process Coverage 

Summary, 195
Application Transformation Proposal 

Ratings, 193
Application Value Assessment, 193, 201
Applications, 190
Applications Not Mapped to Process, 190
configurable, 99
configurable, listed, 196
List of Applications (Analyst), 203
My Applications, 206
My Survey Requests, 190, 208
My Transformation Proposals, 190, 209
My Workstreams, 190, 211
overview, 187
Rating of Transformation Proposals, 212
shared, 99, 188
TCO Summary, 214
Total Cost of Ownership (TCO) 

Summary, 193
user-personalized, 196

Postal Code field, 163

PPM Center documentation, guidelines for 
using, 17

PPM Center requests, described, 18

PPM Dashboard. See Dashboard

PPM Data Migrator for Microsoft Excel. See 
Data Migrator.

PPM Server
configuring Data Migrator connection, 32
connecting to for entity options, 41
connecting to for validation options, 69

prerequisites, Data Migrator, 30

Priority field, 182

private Dashboard pages, described, 98

process
dependent applications, 108
dependent on applications, 104

process entity
Compliance Requirements, 166
Compliance section, 166
Compliant, 166
Created By, 165
Created On, 165
described, 164
Description, 165
Name, 165
Owner, 165
Parent Process, 165
Process Name, 165
Process No., 164
Process Type, 165
Status, 164
Summary section, 164

Process field
Application Value Assessment portlet, 203
List of Applications (Analyst) portlet, 205

Process Name field, 165

Process No. field, 164

Process Type field, 165

Process(es) field, 185

processes
filtering in dynamic graphing, 111
number of applications supported, 108
number supporting applications, 104
opening in dynamic graphing, 107
viewing in dynamic graphing, 110
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viewing relationships, 107
viewing supporting applications, 109

Product Name field, 143

Productivity field, 178

Programming Technologies field, 139

Project Class field, 174

Proposal Dependencies field, 173

Proposal Details section, transformation 
proposal entity, 173

Proposal Name field, 173

Proposal No. field, 172

Purpose field, 133

Q
quick edits described, 26

R
Rating of Transformation Proposals portlet

Business Objective field, 214
described, 212
Executive Sponsor field, 214
Owner field, 214
Risk Rating rating type, 213
Total Score rating type, 213
Transformation Proposals field, 214
Value Rating rating type, 213

Rating section, application entity, 146

ratings data, entering from surveys, 91

References section, 129

Region field, 163

Regulatory Requirement field, 137

reinstalling Data Migrator
clearing cache, 83
instructions, 82
overview, 82

Relative Cost field, 147

Relative Size field, 147

Report Title field, 222

reports
Entity Coverage Summary report, 

viewing, 94
Entity Coverage Summary, described, 218
Entity Detail, described, 220
overview, 100, 217
Survey Results, viewing, 89
Survey Results, described, 224
viewing, 100, 217

REQ.REQUEST_ID token, 39

Request Browser
accessing from Application Portfolio 

menu, 123
creating entity groups, 122
displaying grouped entities, 123
grouping entities, 122
using, 122

Request No. field, 169

request number
Data Migrator requirement, 39, 40
mapping in Data Migrator, 47

requests, described, 18

Requirements Doc attachment, transformation 
proposal entity, 175

Resource Count field, 142

Resource(s) field, 184

Respondent field, 136

Respondent Note field, 136

Revenue Impact field, 153

Reviewer field, 183

Risk Rating field, 158, 180

Risk Rating rating type, 213

ROI field, 142

role of analyst, described, 13
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Rows Displayed field
Application to Process Coverage 

portlet, 201
List of Applications (Analyst) portlet, 205
My Applications portlet, 207
My Survey Requests portlet, 209
My Transformation Proposals portlet, 210
My Workstreams portlet, 211

Rows Displayed in Maximized View field
Application to Process Coverage 

portlet, 201
List of Applications (Analyst) portlet, 205
My Applications portlet, 207
My Survey Requests portlet, 209
My Transformation Proposals portlet, 210
My Workstreams portlet, 211

Running Software field, 168

S
saving

application sets in dynamic graphing, 121
entity groups, 126
images in dynamic graphing, 122

Scalability field, 150

Schedule section, workstream entity, 183

Scheduled Duration field, 183

Scheduled Effort field, 184

Scheduled Finish Date field, 183

Scheduled Start Date field, 183

Scope section
application set entity, 161
workstream entity, 184

Score Adjustment field, 159, 180

Score section, application entity, 157

searching entities
described, 25
shortcut, 15

Security Classification field, 138

Security Risk field, 155

server entity
Created By, 168
Created On, 168
described, 167
Description, 167
IP Address, 168
Location, 168
Name, 167
OS, 168
Running Software, 168
Server Name, 167
Server No., 167
Status, 167
Summary section, 167
Type, 168

Server Name field, 167

Server No. field, 167

Servers field, 139

Service & Support section, application 
entity, 143

Service Level Agreement field, 144

Set Name field, 160, 161

Set No. field, 160

shared Dashboard pages
See also Dashboard pages.
described, 98, 188

shared portlets, described, 99, 188

shortcuts to create entities, 14

Show Blanks in Distribution field, 224

Show Contents of Table Fields field, 222

Show Detail Fields field, 222

Show Field Audit History field, 222

Show Header Fields field, 222

Show Notes field, 222

Show References field, 223

Show Status field, 223

Silverlight Plug-In, installing, 100

Size field, 141
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Size of User Base field, 151

Sizing Method field, 140

sizing nodes, dynamic graphing, 116, 117

Skills Risk field, 156

SMEs field, 136

Sort By field
Application to Process Coverage 

portlet, 200
List of Applications (Analyst) portlet, 205
My Applications portlet, 207
My Survey Requests portlet, 208
My Transformation Proposals portlet, 210
My Workstreams portlet, 211

spreadsheets
creating custom, 40
creating for Data Migrator import, 

overview, 34
creating from template, 35
creating manually, 40
creating template for Data Migrator, 37
Data Migrator template illustrated, 35
default Data Migrator, described, 35
Detail Log errors, 66
downloading for Data Migrator, 34
guidelines for import, 40
mapping with Data Migrator tools, 78
mapping, exporting, 79
mapping, importing, 79
mapping, viewing, 78
preparing template for import, 39

Staffing section, workstream entity, 184

starting
Data Migrator for entity tasks, 41
Data Migrator for validation tasks, 69
dynamic graphing, 101

State/Province field, 163

Status field
application entity, 132
application set entity, 160
Application Value Assessment portlet, 202
Entity Detail report, 220

List of Applications (Analyst) portlet, 205
location entity, 162
My Applications portlet, 207
process entity, 164
server entity, 167
survey registration entity, 169
transformation proposal entity, 172
workstream entity, 182

Status section, 129

Strategic Match field, 177

Summary section
application set entity, 159
location entity, 162
process entity, 164
server entity, 167
survey registration entity, 169
transformation proposal entity, 172
workstream entity, 181

Support Type field, 144

Supported Process field, My Applications 
portlet, 207

Supported Processes field, 137

Survey Name field, 169

survey registration entity
collecting comments and notes, 90
Created By, 169
Created On, 169
creating entities, 86
creating surveys, 86
described, 168
Details section, 170
entering comments and notes, 90
entering ratings data, 91
List of Applications & Respondents, 171
List of Surveys, 171
Name, 169
opening, 90
Request No., 169
shortcut to create, 14
Status, 169
Summary section, 169
Survey Name, 169
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Survey Template, 170
Target Completion Date, 170
View Preview, 170

Survey Request field, 224

Survey Results report
analyzing, 225
Applications field, 224
described, 224
High Threshold field, 224
Low Threshold field, 224
Medium Threshold field, 224
Show Blanks in Distribution field, 224
Survey Request field, 224
viewing, 89

Survey Template field, 170

survey types, described, 86

surveys
conducting, 85
creating, 86
entering response data in entity, 90
generating, 86
inviting respondents to participate, 88
monitoring results, 88
report, 224
requesting additional information, 96

T
Target Completion Date field, 170

TCO Summary portlet
Application Set field, 216
described, 214
Display preferences summary on portlet 

field, 216

Technical Environment section, application 
entity, 138

Technical Owner field, 135

Technical Risk field, 179

technical survey, 86

Technology Risk field, 155

templates
creating for Data Migrator, 37
creating spreadsheets for Data Migrator, 35
default Data Migrator, 35
preparing for Data Migrator import, 39

Title field, 131, 172

tokens, described, 40

Total Cost of Ownership (TCO) Summary 
portlet, 193

Total Cost of Ownership field, 142

Total Score field, 159, 180

Total Score rating type, 213

Total Users field, 145

transformation proposal entity
Architecture Risk, 179
Asset Class, 174
Associated Applications, 174
Benefits Manager, 175
Budget Manager, 175
Business Case Details section, 175
Business Case Doc, 175
Business Objective, 174
Competitive Advantage, 177
Competitive Response, 178
Created By, 173
Created On, 173
Definition Risk, 180
described, 171
Description, 173
Executive Sponsor, 174
Expected Finish Period, 174
Expected Start Period, 174
Financial Summary, 176
Infrastructure Risk, 180
Internal Rate of Return, 177
IT Sponsor, 174
Nominal Return, 176
Organization Risk, 179
Owner, 173
Productivity, 178
Project Class, 174
Proposal Dependencies, 173
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Proposal Details section, 173
Proposal Name, 173
Proposal No., 172
Requirements Doc, 175
Risk Rating, 180
Score Adjustment, 180
shortcut to create, 15
Status, 172
Strategic Match, 177
Summary section, 172
Technical Risk, 179
Title, 172
Total Score, 180
Value & Risk Assessment section, 176
Value Rating, 178
Vendors Involved, 174

Transformation Proposals field, Rating of 
Transformation Proposals portlet, 214

transforming a graph in dynamic graphing, 109

troubleshooting Data Migrator errors, 66

Type field, 133, 168

U
Under Maintenance field, 143

uninstalling Data Migrator, 82

Unit of Measurement field, 141

updates, cancelling in Data Migrator, 64

updating
entity data, 44, 52
validation values, 68, 73

updating entities, 26

upstream application, described, 139

Upstream Applications field, 139

Usage & Scale section, application entity, 144

User Location field, 145

user role, described, 12

V
validation values

described, 68
downloading, 68, 71
updating, 68, 73

validations, adding to HP APM, 74

Value & Risk Assessment section, 
transformation proposal entity, 176

Value Rating field, 158, 178

Value Rating rating type, 213

Vendor Competition field, 153

Vendor Financial Health field, 152

Vendor Name field, 143

Vendor Product Plans field, 153

Vendor Score field, 158

Vendors Involved field, 174

Version field, 132

View Preview link, 170

viewing
application dependencies, 104
application relationships, 102
applications in dynamic graphing, 110
applications that support processes, 109
Entity Coverage Summary report, 94
process relationships, 107
processes in dynamic graphing, 110
reports, 217
saved entity groups, 127
Survey Results report, 89

W
wildcards for dynamic graphing, 112

workstream entity
Actual Duration, 184
Actual Effort, 184
Actual Finish Date, 183
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Actual Start Date, 183
Application Set, 185
Application(s), 185
Created By, 183
Created On, 183
described, 181
Description field, 182
Name, 182
Owner, 182
Priority, 182
Process(es), 185
Resource(s), 184
Reviewer, 183
Schedule section, 183
Scheduled Duration, 183
Scheduled Effort, 184
Scheduled Finish Date, 183
Scheduled Start Date, 183
Scope section, 184
Staffing section, 184
Status, 182
Summary section, 181
Workstream No., 182

Workstream No. field, 182
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